Composer HE 3.3.1
User Guide
Contents

Introduction .......................................................................................................................... 8
Scope .................................................................................................................................. 8
Related documents and resources ......................................................................................... 8
Composer HE overview ........................................................................................................ 8
Setting up the Control4 system—overview ....................................................................... 9
Composer HE system requirements ..................................................................................... 10
Computer software and hardware ....................................................................................... 10
Home computer network .................................................................................................... 10
Control4 home automation network .................................................................................. 11
Installing the hardware and software ................................................................................. 12
Installing and connecting the hardware ............................................................................. 12
Installing Composer HE software ....................................................................................... 13
Exploring Composer HE features ........................................................................................ 15
First page ............................................................................................................................ 15
Composer HE startup options ............................................................................................ 15
Start Composer HE ............................................................................................................. 15
Exit Composer HE .............................................................................................................. 17
Composer HE views ........................................................................................................... 17
Available views .................................................................................................................. 17
Monitoring view .................................................................................................................. 19
Monitoring pane .................................................................................................................. 20
Project tree search and filter ............................................................................................... 22
Device Control window ....................................................................................................... 23
Properties pane ................................................................................................................... 23
Room Properties ................................................................................................................ 31
Device Properties ............................................................................................................... 33
List View pane .................................................................................................................... 33
Information tab .................................................................................................................... 34
Media view .......................................................................................................................... 36
Possible buttons .................................................................................................................. 37
Right-click options ............................................................................................................. 38
Agents view ........................................................................................................................ 39
Programming view ............................................................................................................. 40
Composer HE menu options ............................................................................................... 42
File menu ............................................................................................................................. 42
Media menu ........................................................................................................... 44
Tools menu ............................................................................................................ 45
System Diagnostics .......................................................................................... 46
Account Services ............................................................................................... 49
Help menu ........................................................................................................... 50
Basic Composer HE tasks .................................................................................. 50
Accessing the List view from the project tree ................................................... 50
Removing items from the project tree ............................................................... 51
Clearing a project ............................................................................................... 51
Exiting Composer HE .......................................................................................... 51
Getting project configuration information from a controller ......................... 52
Loading a project’s configuration from a computer to a controller .................. 52
Backing up a Composer HE project ...................................................................... 53
Backing up and loading from a virtual to a local or remote Director ............... 54
Backing up a project’s configuration and media ................................................. 54

Composer HE Version Independence ................................................................. 55
Connecting Composer HE to a Virtual, Local, or Remote System ................... 57
  Virtual System .................................................................................................... 57
  Local System ..................................................................................................... 57
  Remote System .................................................................................................. 57

Composer HE makes new decisions when connecting ....................................... 58
  Connecting to a Virtual System with versioned APIs ..................................... 58
  Connecting to a Local or Remote System with versioned APIs ..................... 58

Connecting to a Director ..................................................................................... 61
Connecting Composer Pro to a Virtual, Local, or Remote System ................... 62
  Virtual System .................................................................................................... 62
  Local System ..................................................................................................... 62
  Remote System .................................................................................................. 62
  Connecting to a Director on a local network .................................................... 63
  Setting up Remote Access .................................................................................. 63
  Connecting to a Director using Remote Access ................................................ 64
    Requirements ..................................................................................................... 64
    Connecting using Remote Access .................................................................... 65
  Ensuring that Director and Composer are compatible ....................................... 66
  System Compatibility Check ............................................................................. 67

Registering the Control4 system ......................................................................... 68
  Register the system at customer.control4.com ................................................ 68
  Register the controller from Composer HE ....................................................... 68
  Setting up a 4Sight subscription ......................................................................... 71
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Where to go from here</td>
<td>73</td>
</tr>
<tr>
<td>Basics</td>
<td>74</td>
</tr>
<tr>
<td>Monitoring the system</td>
<td>75</td>
</tr>
<tr>
<td>Check the Device Status in List View</td>
<td>75</td>
</tr>
<tr>
<td>Change Project Properties</td>
<td>76</td>
</tr>
<tr>
<td>Configuring device properties</td>
<td>78</td>
</tr>
<tr>
<td>Help for device properties</td>
<td>79</td>
</tr>
<tr>
<td>Examples</td>
<td>80</td>
</tr>
<tr>
<td>Example: Use the Access agent</td>
<td>81</td>
</tr>
<tr>
<td>Example: Use the Advanced Lighting agent</td>
<td>85</td>
</tr>
<tr>
<td>Setting up media</td>
<td>91</td>
</tr>
<tr>
<td>Media types</td>
<td>92</td>
</tr>
<tr>
<td>Overview of media management</td>
<td>94</td>
</tr>
<tr>
<td>Media Manager</td>
<td>94</td>
</tr>
<tr>
<td>New scans</td>
<td>94</td>
</tr>
<tr>
<td>Scans where content is in the media database</td>
<td>94</td>
</tr>
<tr>
<td>Other Media Manager considerations</td>
<td>94</td>
</tr>
<tr>
<td>Media storage</td>
<td>95</td>
</tr>
<tr>
<td>Media lookup service</td>
<td>95</td>
</tr>
<tr>
<td>Setting up media auto-scan</td>
<td>96</td>
</tr>
<tr>
<td>Disc changer</td>
<td>97</td>
</tr>
<tr>
<td>Scanning media in a disc changer</td>
<td>98</td>
</tr>
<tr>
<td>Automatically scan media</td>
<td>99</td>
</tr>
<tr>
<td>Searching media in a disc changer</td>
<td>99</td>
</tr>
<tr>
<td>Edit CD or DVD information</td>
<td>100</td>
</tr>
<tr>
<td>Adding a DVD or CD</td>
<td>101</td>
</tr>
<tr>
<td>Setting up videos for a media player</td>
<td>104</td>
</tr>
<tr>
<td>Setting up media for radio stations</td>
<td>105</td>
</tr>
<tr>
<td>Setting up media for television stations</td>
<td>107</td>
</tr>
<tr>
<td>Setting up Internet radio stations</td>
<td>109</td>
</tr>
<tr>
<td>Importing a DVD list from a file</td>
<td>111</td>
</tr>
<tr>
<td>Using external storage devices</td>
<td>112</td>
</tr>
<tr>
<td>Attach and scan external storage devices</td>
<td>112</td>
</tr>
<tr>
<td>Access and scan network storage devices</td>
<td>112</td>
</tr>
<tr>
<td>Creating a playlist</td>
<td>115</td>
</tr>
<tr>
<td>Testing the media connection</td>
<td>117</td>
</tr>
<tr>
<td>Editing media information</td>
<td>118</td>
</tr>
<tr>
<td>Editing CD information</td>
<td>118</td>
</tr>
</tbody>
</table>
Introduction

This document gives you comprehensive information, tips, best practices, and examples about how to use Composer Home Edition (HE) for Control4 Operating System (OS) Release 3.3.1 (OS 3.3.1). Use Composer Home Edition (Composer HE) Monitoring, Media, Agents, and Programming views to modify your system.

The purpose of this document is to give you instructions and examples about how to use the Composer HE application to monitor your system, set up your media, program the system, use agents, and other useful Composer HE tasks.

Scope

This Control4 Composer HE User Guide, which was formerly separated into two parts, is now compiled into a single manual. The User Guide covers these topics:

- What's new in this release
- Configuring properties
- Customizing the Navigators
- Setting up the media
- Programming the system

For information about what's new in this release, see What's new in this release.

Related documents and resources

<table>
<thead>
<tr>
<th>Document Title</th>
<th>Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>Control4 System User Guide</td>
<td>Web: ctrl4.co/usrguide</td>
</tr>
<tr>
<td>Control4 Composer Home Edition User Guide</td>
<td>Web: ctrl4.co/he-ug</td>
</tr>
</tbody>
</table>

Composer HE overview

This document is for homeowners who want to learn how to use Composer HE in the Control4 Smart Home OS 3.3.1 (OS 3.3.1) or later.

The Control4 system is a combination of Control4 and third-party controllable devices, for example, HDTVs, DVDs, CD players, speakers, home theaters, lights (and so on) that communicate with one another via TCP/IP, infrared (IR), serial, contact, or relay connections.

Composer Home Edition (Composer HE) is the software application for homeowners to modify, properties, programming and media in their Control4 system. The software runs on either a Windows 7, 8, 10, or Windows Vista computer, and provides a powerful graphical interface for object-based programming. When connected to a Control4 controller, the project's information is then communicated to Director on the controller. Director, in turn, uses the configuration information and device drivers to communicate to the devices in the home automation system.
Setting up the Control4 system—overview

Setting up a fully functional Control4 system includes the following major procedures.

For best results, Control4 recommends that you follow the procedures in this order:

1. **Install and connect the hardware**—When deploying a Control4 system, install and connect the essential devices:
   - A Control4 controller (for example, an EA-3)
   - A Windows-based computer to set up and configure the home automation system using Composer HE
   - The device to be controlled (for example, touch screen, DVD player, speakers, lights, Dock for iPod, etc.)
   - A controller and PC connection to the home network

2. **Purchase the required licenses**—To use Composer HE for your company or your employees, you’ll need to purchase and assign licenses. See the document Managing Dealer Accounts on My.Control4.Com for details.

3. **Install the Composer HE software**—Use the Composer HE installation software to install Composer on a PC and activate it using your my.control4.com dealer user account.

4. **Connect to a Director**—Each time you start Composer on your PC, you either connect to Director running on a local or remote controller (live connection) or a virtual Director running on your PC (virtual connection). Director is the software on a controller that stores the Control4 system configuration and manages the control of each subsystem and device in the Control4 system.
   - Live connection: To make changes to a Control4 system in real time, connect to the Director through either Local System (over the home network) or Remote System (over the Internet).

   Note: Remote Access must be configured locally before using a remote connection to the controller. See “Setting up Remote Access.”

   - Virtual connection: Alternatively, to create or edit the system configuration offline and save the project file, connect to Director through Virtual System. The saved .c4p project file can be loaded later into a controller through a local connection to ensure that Director has the updated system configuration.

5. **Plan and design the system**. [This step must be done by a Control4 Dealer using Composer Pro] To design a system in Composer Pro, you first create a project in the form of a project tree that represents the hierarchy of locations for the devices to be automated in the home-automation system (site > building > floors > rooms > devices) and the devices that reside in each room.
   - **Create a plan.** Creating a plan before you start your project in Composer Pro will help make your system design go much more smoothly.
   - **Design the system using System Design view:** Use the System Design view where you can view the project tree as you build the design.
6. **Make and test the connections.** [This step must be done by a Control4 Dealer using Composer Pro] In the Composer Pro project, you must define all of the physical connections of the devices to the system: control (IR and serial) and AV (audio, video). You must also define other connections: room control and network connections. You can use Composer Connections view to complete the connections.

7. **Register the system.** Control4 recommends that you register each system you install at customer.control4.com to maintain the system software through software updates and critical system patches.

Important: Only registered systems can use all of the media services available. System registration is one of the essential steps that lets you access the system remotely (remote access) for repairs, updates, and additions.

**Composer HE system requirements**

*Computer software and hardware*

- Microsoft.NET 4 (the Composer install is launched automatically from the Control4 website).
- Microsoft operating systems supported (Windows 10, 8, 7, or Vista). Mac support when used with a Windows virtual machine such as Parallels or VMWare Fusion for Mac.
- 500 MHz or higher processor
- 256 MB RAM
- 90 MB available hard disk space
- Video card and monitor supporting a resolution of 1024x768 or higher
- Keyboard
- Mouse
- 1 to 2 Ethernet (CAT5 or CAT6) cables

*Home computer network*

- Wireless access point (WAP) or wireless router that supports 802.11 b/g/n (optional)
- TCP/IP-based (Ethernet) home network. This usually includes a network gateway, router or switch.
- 1–2 Ethernet (CAT5 or CAT6) cables
- A broadband Internet connection. During initial setup, a broadband Internet connection is required to update the Control4 system and retrieve the media’s cover art. Also, a broadband Internet connection is required to support remote access to the system.
**Control4 home automation network**

- A Control4 controller (for example, an EA-3).
- Control4 Composer Home Edition (Composer HE) software, version 3.0.0.
- Note: A Control4 controller is set by default as a DHCP client. If the home network has a DHCP server in place (for example, a router that provides DHCP services), then the controller automatically receives a valid IP address.

Note: Control4 recommends that you update to the latest software release.

- A wireless access point (WAP) that supports 802.11b/g/n (required to use a Control4 wireless touch screen).

- A valid electronic license to run Composer HE. Control4 now requires activation using a my.control4.com account with a license to run Composer HE. Re-activation is required every 30 days. See [Managing Dealer Accounts on My.Control4.com](#) on the Control4 dealer website or Knowledgebase to learn how to add and manage licenses from my.control4.com.
Installing the hardware and software

This section provides guidelines to install the devices and Composer HE.

Installing and connecting the hardware

Before you can set up a Control4 home automation system in Composer HE, all of the devices to be used in the system need to be installed and connected to the home network. Additional devices can be added and identified to the Composer HE project if you install or replace devices in the future.

Follow these guidelines to get started:

1. Create a system specification, and refer to it so you can answer these questions.

   1. What does the home have?
      - Any there any outer buildings, for example a detached garage, that will be automated? All buildings to be automated must be included in the project.
      - How many floors are there in each building? For example, the house has three floors and a basement; the garage has one floor.
      - What rooms are on each floor? For example, the third floor of the house has one Master Bedroom and two other bedrooms. The third floor also has one Master Bath and one Main Bath.

   2. Which Control4 devices are or will be installed in each room (include manufacturers and model numbers)?

   3. Which third-party devices are or will be installed in each room (include manufacturers and model numbers)?

   4. If any of these devices has a choice of power sources, indicate how the device will be powered: AC, DC, or batteries.

   5. If any of these devices has communication options, indicate how each device will communicate with the controller (how the device will be controlled): Ethernet, Power Over Ethernet (POE), Wi-Fi, Zigbee® Pro, IR, serial, contact, or relay.

2. Install and connect the Control4 devices as described in the installation or setup guide that ships with each device.

   Tip: See also “Related documents and resources” in this guide for document locations.

3. Install and connect all third-party devices, for example, audio-video devices, door contacts, and security panels, as described in the installation guide that ships with each device.

4. Connect the Control4 controller and your PC to the home network. Initial setup of the controller requires a hard-wired (Ethernet) connection to the network, and an Ethernet connection is always recommended. A simple Control4 system and home network are shown below.
Use the RJ-45 jack labeled ‘Ethernet’ on the back of the controller to connect it to the home network. If successful, the amber LED turns on and the green LED blinks. Read the controller’s installation guide to learn how the LEDs work.

Use either a wireless access point (WAP) or Ethernet cable to connect the PC to the home network.

5. Confirm that the Control4 devices are getting network addresses from the gateway, router, or switch. See the Composer HE User Guide for details.

Installing Composer HE software

Follow these steps to install your Control4 Composer HE software for the first time. If you are upgrading from a version earlier than OS 2.9.1, you must first upgrade to OS 2.9.1 to continue. Please refer to the specific version of this document for further information.

Note: An Internet connection is required to perform this installation.

To install the Composer HE software:

1. Obtain the Composer HE Installation software (available as web download from customer.control4.com).

   Note: Windows 7 or later and an Internet connection are required to perform this installation.

2. Start the Composer HE installation, and follow the on-screen instructions.

3. During the installation process, click Continue Anyway to allow the installation to proceed.
4. The next screen asks for your Control4 account login and password. This assumes that you already have an account on customer.control4.com. If you don't have an account, click Register.
Exploring Composer HE features

The Control4 Composer HE interface (views) and wizards are designed to help you simplify the process of designing the system, identifying and configuring the devices, making the connections, and then customizing the system through programming. How you set up the devices in Composer HE determines how they function in the system.

First page

When you start Composer HE and connect to a Director, a similar screen like the following Monitoring view appears:

The Composer HE interface contains menus, panes, a project tree, tabs, and objects. These components are explained in this document.

Composer HE startup options

Start Composer HE

You can start the Control4 Composer HE application two ways:
• Double-click the **Composer** icon on your desktop (easiest way).

![Composer Icon](image)

• Click Start > Control4 > Composer Home Edition 3.2.4.

Tip: For your convenience, in Composer 2.5 and later the Start menu also displays your projects, logs, and drivers.

When you start Composer HE, the Composer startup screen displays:

![Composer Startup Screen](image)

This screen presents the following Director-connection options. Click one of the options to access the Composer HE project and project tree (Monitoring view).

- **Local System**—Click this option if you have a direct connection to the home network (inside the firewall). This option gives you all the capabilities of the application: set up and design a project, connect the devices to the network, configure the media, and program the system.

- **Remote System**—Click this option to work from a remote location by establishing an Internet connection to the home network (outside the firewall). You can perform the same tasks as if you were connected using the *Local System* option.

This Directors dialog appears when you click **Local System**. In this case, you select the network address associated with the controller, and then
click **Connect**.

- **Connect**—Lets you connect to the Director that resides on the controller attached to the local network.
- **Cancel**—Cancels and closes the **Directors** dialog box.
- **Add...**—Lets you add the Director's address of the controller to which you are trying to connect.
- **Remove**—Lets you remove the selected Director from the list.
- **Refresh**—Lets you update the Directors list to display recently-added Directors.

**Exit Composer HE**

You can exit Composer two ways:

- Startup window (where you start Director): click **Exit Composer**.
- File menu (in the Composer project): select **Exit**.

As you exit, Composer HE prompts you to back up your project and media information to your local computer. This is not required except when using a Virtual System connection, but Control4 highly recommends that you back up your project every time you close Composer HE.

**Composer HE views**

**Available views**

The Control4 Composer HE application has five main views (buttons are located in the bottom left pane). When you select a view (see the figures below) the appearance, functionality, and configuration change for that view.

Also note the status bar at the bottom of the screen, which indicates the Director's network IP address and Director status.
Tip: Collapse the views by clicking the dotted bar just above the views so you have more room to view the project tree.

Main menu:

Composer view buttons:

- **Monitoring**—View devices and define device properties.
- **Media**—Add and scan stored or broadcast media.
- **Agents**—Set up an agent for use in the system and in programming. Agent types: Lighting Scenes, Wakeup, Scheduler, Variables, etc.
• **Programming**—Program events and actions to automate the system. Using predefined events and user-defined agents.

**Monitoring view**

Use the Control4 Composer HE Monitoring view (the default view when you start Composer HE) to define the Control4 system project for a customer.

This view lets you view devices and define properties:

- The location of the devices in the project (building).
- The device you want to include in the project (device objects).
- The location of each device by room (room).

**To access the Monitoring view:**

1. Start Composer.

Take note of the three large panes in the screen below (Monitoring, Properties, and Items):

   ![Monitoring view screenshot](image)

- **Monitoring (left pane)**—Contains the project tree where you view locations and device drivers.
- **Properties (right pane)**—Contains the Properties of the object you select from the project tree when you want to check or modify a device, project, and room. Refer to the sections below to view more information about the Properties pane.
- **“Project Properties”**
• “Room Properties”
• “Device Properties”

Monitoring pane
The Monitoring pane in the Monitoring view displays the project tree. You can view the project’s floors, rooms, and devices.

**To access the Monitoring pane:**

1. Start **Composer**.

Note: The example project tree below shows the project name (Main), site (Home), building (House), floors (Main), rooms (Family, etc.), and the devices already added to the project.
Right-click on a device, room, or other item in the project tree to bring up additional options for that item.
Project tree search and filter

To make it easier to find and manage devices in large projects, the project tree has search and filter controls.

- **Search**—Type the device name to search for here. Click the Find Next button to jump to the next device of that name. Click the down arrow on the right side of the search box to select from previously used search terms.

- **Filters**—Use filters to hide or show only certain types of items in the project tree. Click the Filters button, then set filters by Device Type or Category. The Device Type list contains only device types already included in your project. Setting a filter under Device Type will clear any filters already set in Category, and vice versa. To clear all filters, click Clear All Filters.
Device Control window

The Device Control window in Monitoring lets you test and control a physical device in Composer HE to make sure it works in the system.

Example: To use the Device Control for a dimmer, you click a button in the Device Control window to turn the dimmer on or off and change the light level. If the physical light changes also, you know the dimmer driver is added and the basic connections are made correctly.

To access the Device Control window:


    Double-click the device in the project tree to access the Device Control window (see below) for that device.

    ![Device Control window](image)

    This window lets you change the configuration parameters (temporarily) and control a device. Later, you can set the parameters permanently in the Properties pane or Programming view.

    Example: You can adjust and test the ramp rate of a dimmer to determine the desired ramp rate to set during programming.

Properties pane

In the Monitoring view, click the project name in the project tree to view the Properties pane (center pane).
The project Properties appear when you first start Composer HE, or any time you select the project name (or root node) in the project tree. Different properties appear depending on the item you select.
This option lets you enter project-specific information; for example, the project name, location, and ZIP Code. Composer Pro automatically enters the latitude/longitude and date/time information after you provide the location and ZIP Code.
Properties Pane

Project Settings tab

Category

Boxes or Buttons

**Project Name**—Lets you enter/edit the name of the project.

**Location**—Lets you look up a location’s latitude and longitude based on city, state, country, etc.

**Latitude/Longitude**—Lets the system calculate from the entered ZIP Code, the local latitude and longitude coordinate information. Knowing location information lets the system calculate local sunrise and sunset times. This is useful for programming lights to turn on at dusk and off at dawn. Using a ZIP Code to find the coordinates only provides a close estimate of latitude and longitude. If you want to enter exact coordinates, the fields can be edited. Also used for outside temperature on the touch screens.

**Country**—Lets you select the country in which the project is located.

**Lookup Button**—Lets you enter/edit the ZIP Code which identifies to the system the local cable, satellite, and broadcast channel programming. It also automatically provides latitude and longitude coordinate location.

**Date and Time**—Lets you set a date, time, and time zone for the Control4 system. By changing the time here and refreshing Navigators (File > Refresh Navigators), you reset the time on the entire system. However, Control4 systems with access to the Internet automatically synchronize the system clock.

**Timezone**—Lets you set the appropriate time zone by clicking **Edit**. Changing the time zone causes the controller to reboot.

**Display time using a 24-hour clock**—If checked, lets you use the 24-hour clock (0 to 2400 hours) rather than 12 am to 12 pm.
**Properties Pane**

using Network Time Protocol (NTP).

**Project Settings Control**—Lets you set a device in Composer that does not allow the setting to be overridden at the device.

**Push Settings From Project**—Check the box for devices to receive settings from the Composer project only. New settings in the Composer project override any settings at the device.

**System Security**—If set, all Navigators (Release 2.0 or later) must connect through a secure connection.

**Properties Pane: Information tab**

**Localization**—Lets you set the locale and character set for countries outside the United States.

**Locale**—Use the down arrow to change the locale.

**Scale**—Lets you select the temperature type.

**Fahrenheit or Celsius.**

Information tab

**Category**

Boxes or Buttons

**System Owner**

Name, Address, Phone, and Email—Enter homeowner information into these fields.

**Dealer Information**

Name, Address, Phone, Email, Primary Contact, Lead Installer, Original Install Date, and Date of Last Update—Enter dealer information and project update dates into these fields.

**Project Notes**

Any notes the dealer wants to add can be stored here.
Lighting Defaults tab

Category

Lighting Defaults—Lets you set default LED colors for switches, dimmers, and keypads as well as certain default parameters for Centralized Lighting. You can still modify these settings for individual devices in the device properties. Also lets you set basic parameters for Centralized Lighting.

On Color/Off Color—Set the default On and Off color for each LED in the project.

Centralized Modules in Control4 Panel—Select this box to indicate that the Centralized Lighting modules will be installed in Control4 2-Slot or 5-Slot Panels. If the modules will be installed in off-the-shelf DIN Rail panels, leave this box unchecked.

Centralized Modules Use Arc Fault Breaker—Select this box if the majority of Centralized Lighting modules will be connected to an arc-fault breaker (AFCI).

Nominal Voltage—Select the default voltage that will be used by the Centralized lighting modules.

Lighting Defaults tab

Category

Boxes or Buttons

Subnets

By default, it is not possible to identify a device that resides on a different network (e.g., subnet) because Director actively excludes identification broadcasts received from devices on a different network.

You can expand the list of allowed networks by adding one, or more, CIDR network specifications to the following list.

For example:

192.168.2.0/24

For more examples see:

https://en.wikipedia.org/wiki/Classless_Inter-
**Lighting Defaults tab**

**Domain_Routing**

---

**Zigbee Configuration tab**

**Category**  
Boxes or Buttons

**Edit Zigbee Configuration**  
HE cannot be used to define, edit, and move Zigbee mesh configurations.

**Refresh**  
Click on this link to refresh the Zigbee status view below.

**Zigbee Network Status**  
Use this view to see the status of the Zigbee mesh (es) in your project.

- **Name**—Name of the device configured in the Zigbee mesh.
- **Controller Status**—The colored icon shows an at-a-glance status of the Zigbee network. Green for online, Yellow for offline, Red for error.
- **Zigbee Server**—The controller defined as the Zigbee Server will say “Enabled”.
- **Zigbee Status**—Shows the status of the Zigbee Server. “Running” means the Zigbee Server is configured and running.
- **Channel**—The current channel of the Zigbee mesh.
- **ZAP Status**—A controller configured as a ZAP will show as “Coordinator” or “Enabled”.

---

**Z-Wave Configuration tab**

**Category**  
Boxes or Buttons

**Advanced**  
HE cannot be used to Learn, Network Update, Reset Defaults, and Send Node Info. These buttons are disabled.
Room Properties

The room *Properties* (Monitoring > Room > Properties) appear when you select a room in the Monitoring project tree.

The *Properties* pane lets you view room-specific device and media information (for example, the iPod located in the Office is an available audio source in the Family room), and helps you troubleshoot any incorrect room connections.

The *Audio/Video Devices* tables you view the devices configured for each end point device and the devices that are available in the room.

Example: If you can’t play movies from a Disc Changer in a particular room, you can view the room’s Properties to see if the disc changer shows up in the List view. If it does not, you are probably missing AV bindings in the path to the device.
Properties Pane—Room Properties

Category

Audio Video Devices tab—Provides information that lets you view all audio and video devices and control connections in a selected room.

Box or Button

Audio Endpoint—The device that is configured to play audio in the room.

Tip: Which device needs to turn on and off to listen to any source of audio in the room?

Audio Volume—The device that is configured to control the audio volume in the room.

Tip: Which device do you need to send volume commands to in order to control the audio volume in the room?

Video Endpoint—The device in the room that is configured to display the video in the room.

Tip: Which video display device is in the room, or where does the video end up?

Navigator tab—Lets you hide and re-order device visibility for all Navigators (in Watch, Listen, etc.).

Modify—Lets you move the order of devices up or down, and hide or show them. Select the device in the Menu list.

Miscellaneous view—Lets you set the default audio and video volume for the room, for example, what the room will revert to after a power cycle. This is also where you set the IR Mask for the room.

Enable Default Volume—Select and use the up or down arrows to change the audio and video volume.

Mute When Paused—Select this option to send a mute command when media is the room is paused.
Device Properties

The device Properties (Monitoring > device > Properties) are visible when you select a device in the project tree. This option lets you modify the available (if any) user options for the selected device.

Properties Pane: Device Properties

Category

**Properties**—Lets you modify options (if available) that are common to all devices of that type.

**Advanced Properties**—Lets you modify advanced options (if available) on some devices.

List View pane

Use the Control4 He List View pane in Monitoring to view all of the devices in a room.

When you select a room or any device in a room in the project tree, and then click **List View**, all of the devices installed in that room display; for example, notice all of the devices installed in the Family room (shown below).
**Note:** The ListView shows all the devices in a given area and the current state of contact inputs or other devices. When selecting the site, building, floor, or room, all of the devices associated in that area are visible. If a single device is selected in the project tree, ListView shows all devices that are in the same room.

**To access the ListView pane:**

1. Start Composer.
2. In the project tree, click any object.
3. In the Properties pane, click the ListView tab.
4. You can double-click a device in the ListView pane to display its Device Control window.

**Information tab**

Use the Info pane in Monitoring to view information about the system owner and Control4 dealer.
To access the Info pane:

1. In Monitoring > Properties, click the Information tab.
2. View, add or change existing information about the system owner or dealer in each box.
3. Check and change the data periodically as needed.

The Information tab lists:

- **System Owner information**
  - Name
  - Address
  - Phone
  - Email address
- **Dealer information**
  - Name
  - Address
  - Phone
  - Email address
  - Primary Contact
  - Lead Installer
  - Original Install Date
  - Date of Last Update
- **Project Notes**—Use the Project Notes box to add any relevant details about a particular installation.
Media view

Use the Media view to select the stored or broadcast media on touch screens, Control4 apps, and on-screen Navigators. The Media view lets you add media selections to the Control4 system: stored music and media collections from a network-attached storage device (NAS) or other devices, for example, a Dock for iPod, DVD player or disc changer, broadcasts, channels, and stations.

To view and select the media from the Navigators, you first need to add and scan the media to the Control4 controller (for example, an EA-3 controller). With MP3, WMA, FLAC, or AAC files that you add and scan, you can create playlists saved to the controller (if it has a hard drive) in the media database. See the Composer HE User Guide for details.

Other Media Managers: You can use other media managers, for example, iTunes, Windows Media Player, and Media Monkey to stream MP3s, WMAs, or MP4s. And your customers can use Composer Media Edition (Composer ME) or Composer Home Edition (Composer HE) to add media files to Control4.

To access the Media view:

1. Click Media at the bottom of the Monitoring pane.
2. In the Media pane, view the media devices. In the Media view, the left-side selections change the right-side views.

The system can access and use several types of media and supports various Media Scanning options:

- **Stored** media (e.g., DVDs) includes the possible media types that store media:
- **Controller**—Lets you store MP3s, WMAs, or MP4s in the digital audio database of the controller (if you have a controller with a hard drive).
- **CD**—Lets you store CD cover art, albums, artist ratings, and genre (Rock, Jazz, Country, etc.).
- **DVD Player or Disc Changer**—Lets you store DVD and CD (when DVD supports CD) selections by viewing cover art, title, info, results, media, and disc list.

- **MP3s on Digital Audio Player**—Lets you store MP3 — HDD music cover art, album, artist rating, and genre (Rock, Jazz, Country, etc.).

- **External or Network File Storage Devices**—Lets you store MP3, WMA, MP4, FLAC, or AAC formats on an external hard drive, USB drive, or server.

- **Screen Saver**—Lets you store the custom images to be used as screen savers on the Navigators.

- **Internet radio**—Lets you assign a particular Internet radio station with cover art.

- **Broadcast** media (for example, Cable/Satellite) includes the possible media types:
  - **Direct TV**—Lets you view DIRECTV channel options, including station ID, genre, rating and music channel.
  - **Dish Network**—Lets you view Dish Network channel options, including station ID, genre, rating, and music channel.
  - **Cable TV**—Lets you view Cable channel options, including station ID, genre, rating, and music channel.
  - **UHF/VHF**—Lets you view the UHF channel options, including station ID, genre, rating, and HDTV.
  - **AM/FM/XM**—Lets you scan AM, FM, and XM radio stations.

- **Playlists** includes the possible media types:
  - **MP3 on Digital Audio Player**—Lets you play and view MP3 or MP4 — HDD music cover art, album, artist rating, and genre (Rock, Jazz, Country, etc.).
  - **CD**—Lets you play and view CD cover art, albums, the artist ratings, and genre (Rock, Jazz, Country, etc.).
  - **Controller**—Lets you play MP3, WMA, MP4, FLAC, or AAC formats from the controller (if supported).
  - **External or Network File Storage Devices**—Lets you play MP3, WMA, MP4, FLAC, or AAC formats from an external hard drive, USB drive, or server.
  - **DVD Player or Disc Changer**—Lets you play DVD and CD (when DVD supports CD) selections and view cover art, title, info, results, media, and disc list.

**Possible buttons**

One or more of these buttons may appear in the center pane depending on which category you select:

- **Edit**—Lets you edit the information for an existing album or movie.
• **New**—A dialog box opens. You can add information for a new album or movie, etc.

• **Delete**—Lets you remove an existing item from the list.

• **Add**—Lets you add media to your system, for example, MP3, WMA, MP4, FLAC, or AAC files.

• **Scan**—Lets you scan the selected media type or storage location for music or media information

• **Configure**—Lets you select the storage device on which the media you’re configuring resides.

Right-click options

Right-click on a device in *Stored media* or *Broadcast media* to bring up various options:

• **Clear Media List**—Use *Clear Media List* with caution because it clears all media from the device—and for a controller, you will have to start over by adding each album again.

• **Export Media List and Export Playlists**—Lets you save an XML file of your lists; if you ever clear your project you won’t have to rebuild the lists.

• **Import Media List and Import Playlists**—Lets you recover your media lists after you’ve cleared your project.

• **Import DVD List from File**—Lets you import an Excel list of DVD titles for a Disc Changer.

• **New Playlist**—Lets you create a playlist which appears in the Playlists type.

• **Delete Playlist**—Lets you delete an existing playlist.

• **Rename Playlist**—Lets you rename an existing playlist.

Right-click on **Playlists** to display *New Playlist*.

Right-click on a **playlist name** to display these options:

• Export Playlists

• Import Playlists

• New Playlist

• Delete Playlist

• Rename Playlist

Right-click on the individual **songs** in the window below the albums to edit song information or delete individual songs.
Agents view
Use the Agents view to perform more complex programming by module.

Note: See Programming with agents for help configuring and using these agents.

To access the Agents view:
1. Click Agents at the bottom of the Monitoring pane.
2. In the Agents pane, view the list of agents and their variables.

Available agents include:

- Access
- Advanced Lighting Scenes
- Announcements
- Backup
- Communication
- Custom Buttons
- Email Notification
- Guest Services
- History
Example: The Scheduler agent lets you program using dates and times. See Using the Scheduler agent for examples.

Common buttons available on some agents in the Agents view:

- **Add**—Lets you add agents to your system.
- **Remove**—Lets you remove agents from your system.
- **New**—Lets you create a new instance for customizing the selected agent in the Agents pane. For each specific instance of the agent, you provide a unique name and customize it according to your needs.
- **Delete**—Lets you remove an existing instance of the selected agent in the Agents pane.
- **Save**—Lets you save the agent-specific information. Not all agents require a manual save option. In most cases, the agent information saves automatically.

**Programming view**

Use the Programming view to have the Control4 system control devices by identifying to the system any device behavior or configuration options that you want to occur automatically. The Programming view lets you create a program script using the drag-and-drop method.
Note: Programming is an advanced feature in Composer HE. Detailed information about programming is explained later in the Composer HE User Guide. This section discusses some basics.

All programming is based on events in the Control4 system. For example, a door that opens is an event. When an event occurs in the system, it can trigger other programmed actions to run.

Example: When the Bathroom door opens (event occurs), program the Bathroom light to turn on (action taken).

Another example is shown in the figure below. Note the text in the Script pane (center pane). The event is “When the Family > Left Dimmer top button is pushed,” and the action is “Open the Garage > Garage Door (Sensor).” The event came from the Events pane, and the action came from the Actions pane.

To access the Programming view:
1. Click Programming at the bottom of the Monitoring pane.
2. In the Programming pane, view the list of Device Events (see below) and events for the object selected.

   The Programming view consists of several panes:
   - **Programming:**
   - **Device Events (left pane)**—Displays all devices that have associated events in the project tree.
   - **<Device> or <Room> Events (left pane)**—Displays the available events for the currently selected device or room in the Device Events project tree. If there are no events for that device or room, none are displayed.
• **Script (center pane)**—Displays the script associated with the currently-selected event from the Device Events pane. You drag-and-drop an action from the *<Project Title> Actions* pane to arrange the order of actions and nest them in the *Script* pane.

• **Actions:**
  
  • **Device Actions (right pane)**—Displays all available device options with associated actions you can use to write your script.

  • **<Project Title> Actions (right pane)**—Displays the Command, Conditionals, and Loops tabs. You move commands, conditionals, and loops into the *Script* pane from this pane.

  **To add an action to the script:**
  
  1. Select the device in the *Device Action* project tree (right pane).
  2. Select the type of action you want in the *Actions* pane.
  3. Click the green arrow.
  4. Drag and drop the action to the *Script* pane.

  • **Commands tab**—Use this tab to select commands (delete, add, etc.) to use for your script.

  • **Conditionals tab**—Use this tab to select conditionals ('if' statements) to use for your script.

  • **Loops tab**—Use this tab to select loops ('while' statements, etc.) to use for your script.

  **Composer HE menu options**

  When you start Composer HE and connect to Director, the menu bar appears at the top of the Composer screen.

  ![Menu Bar]

  The menu bar provides the following menu items:

  • **File**—Lets you perform typical file management tasks, clear or load projects, connect or disconnect to the local Director, update both the Composer and Navigator software, and exit Composer.

  • **Media**—(only appears when the Media view is selected)—Lets you perform tasks regarding music and media lists.

  • **Tools**—Lets you view System Diagnostics and Account Services.

  • **Help**—Lets you view this document in help form plus version information.

  **File menu**

  Access the *File* menu from the menu bar on any Composer screen.
From the File menu, you can perform project file management tasks:

- Manage the project (load, back up, etc.).
- Manage cloud backups.
- Connect to Director.
- Refresh Composer HE.
- Refresh the Navigators: touch screens, Control4 apps, or on-screen Navigator.

The file management options apply to the files you back up on your computer called *project files* (project name plus a .c4p extension). Project files are saved by default to the My Documents directory under Control4/Projects.

When you set up a Control4 system, you create project configuration information. This information is created live on the controller hardware, or backed up to a project file on a computer that lets you save specific information about each system, including devices, connections, configuration, programming information, and media. The project configuration is automatically stored on the controller hardware to which you are connected from your computer.

Backing up the project lets you save a copy of the project on your computer which is always recommended whenever you make changes in Composer HE or update the system.

The following options are available:

- **Load Project**—Loads a selected project into the currently-connected controller. Composer HE prompts you for a backup before it clears the project configuration information, and replaces it with a selected project you can browse to and load.

- **Cloud Management**—Manage online backups saved from the registered system. You can load a cloud project to the controller, delete a cloud project, add a project to the cloud, show a history of cloud backups for this project, and save a cloud project to your local computer.
• **Backup to Cloud**—Creates a backup of the project and saves it to Control4 online services. Requires a valid 4Sight subscription.

• **Connect to Director**—Connects you to a Director residing on the controller. When you connect, project configuration information from the controller is presented to the screen in Composer HE.

• **Disconnect from Director**—Disconnects you from a Director. Composer prompts you to back up your project before disconnecting you from the currently-connected Director. This option is available when connected to a Director.

• **Back up**—Backs up the current project to your computer. The first time you back up your project, Composer prompts you for a filename. It also prompts you to back up any media information. If you select this option, the current project becomes an option in the File > Load Project list.

• **Back up As**—Backs up the current project, and prompts you to enter the name of the file. It also prompts you to back up any media information. If you select this option, the current project becomes an option in the File > Load Project list.

• **Refresh**—Refreshes the current Composer HE project.

• **Refresh Navigators**—Refreshes the Navigators connected to the system. Note: Control4 for PCs and tablets must be updated in that app. Control4 for iPhone, iPod touch, iPads, and Androids will update if online.

Media menu

Access the *Media* menu from the menu bar in the *Media* view.

Note: The Media menu becomes available when the Media tab is selected (on the left menu).
From the Media menu, you can create, delete, and rename playlists. You can also clear, export, and import media lists. A Media List is the list of media information associated with the selected device, for example, all DVDs with associated cover art, title, notes, etc., for each DVD in a disc changer.

The media has been scanned or manually added to the media database. After you add an item to the media database, the cover art and information about the media can be viewed and selected from any of the Navigators (touch screens, Control4 apps, and on-screen navigators, etc.).

The following options are available:

- **Clear Media List**—Clears the media list of the selected device from the media database.
- **Export Media List**—Exports a media list for the selected device from the controller to a PC.
- **Import Media List**—Imports a media list from the PC to the controller.
- **Export Playlists**—Exports a playlist from a controller to a PC.
- **Import Playlists**—Imports a playlist from the PC to a controller.
- **Import DVD List from File**—Imports an Excel list of DVD titles for a Disc Changer.
- **New Playlist**—Creates a new playlist from a controller to a PC.
- **Delete Playlist**—Removes a playlist.
- **Rename Playlist**—Renames a playlist.
- **Tag media files**—Used for OS 2.0 or later conversion of media files so all media players can see the same tags.

**Other options**

- **Sort**—Lets you sort and find drivers by column and by Device Type, Name, Manufacturer, Model, Creator, Created Date, and Modified Date. Click the top of each column to sort accordingly. Click on the column head to sort the column.

**Tools menu**

Access the Tools menu from the menu bar on any Composer HE screen.

From the Tools menu, you can access tools for checking the device connection status.

The following options are available:

- **System Diagnostics**—Assists you in gathering system information to help you determine if any issues encountered are configuration problems,
performance issues, or potential defects. The System Diagnostics tool is valuable also for logging information and sending email to Control4 Technical Support. See “System Diagnostics.”

• **Account Services**—Facilitates system registration which is required for software updates and to use the media services throughout the Control4 system. It is also required in conjunction with a customer account to enable Remote Access, which allows secure access to your system via the Internet. See “Account Services.”

System Diagnostics

From the Tools menu, click **System Diagnostics**. Use these screens to help you diagnose system problems and activity.

• **Controller Performance tab**—Lets you view controller performance information, including CPU and memory usage. Process data is listed in the bottom pane.
• **History button**—Lets you view the history of CPU and memory performance.

![Director Message History](image1)

• **Controller Networking tab**—Lets you view controller networking information, including network type, connection status, MAC address, IP address, Subnet mask, Gateway, DHCP status, and DNS server information.

![System Diagnostics](image2)

• **Test Internet Connection button**—Lets you test the current Internet connection. After viewing, click **Close** to exit the dialog box.
• **System Info tab**—Lets you view system information in a tree view. Click **Save To File** to save this information.
• **Logging tab**—Lets you log system problems.

![Logging tab](image)

This logging feature lets you:

• Change the logging level of any of the program loggers on the operating system. Select from **fatal**, **error**, **warning**, **info**, **debug**, **trace**, and **default**.

![Log Level](image)

• View the selected log in real time (“Tail”). To start the tail, select the log, then click **Start Tail**. To stop the tail, click **Stop Tail**.

• Open the current log file of the selected program logger. To open the log, select the logger, then click **Open Log**.

• View all the logs available on the device at that location.

• Click **Auto Scroll Output** to scroll through the log entries, or click **Clear Output** to clear all entries.

**Account Services**

From the **Tools** menu, select **Account Services** to set up a customer.control4.com account and register a controller, remove a controller from registration, or check
in for a service connection. To register the controller, see Registering the Control4 system.

You can also check the current account status and service level. Select the Status tab. You can view:

- Account Status
- Customer Account
- Customer Email
- Service Level
- VPN Status

Help menu

From the Help menu, you can:

- Access this Composer HE User Guide.
- Check the Composer HE and Director versions.

The following options are available:

- **Getting Started Guide**—Displays this Getting Started Guide.
- **User Guide**—Opens a link to the Composer HE User Guide.
- **Documentation Library**—Opens a link to the documentation for homeowners.
- **About Composer**—Displays the Composer and Director versions.

**Basic Composer HE tasks**

You can perform simple but important tasks in Control4 Composer HE (see below), or you can take a deeper dive into intermediate or more advanced tasks (the Composer HE User Guide will show you how).

Accessing the List view from the project tree

Use the List View tab to view the devices in your project (by room). Ensure that the devices are added and identified to the project.

**To view the list:**

1. Click Monitoring.
2. Select a room in the project tree.
3. Click the **List View** tab; the status of each device associated with that room displays in the **List View** pane.

![List View in Composer HE](image)

**Removing items from the project tree**

Use the project tree in **Monitoring** to remove devices, rooms, buildings, etc.

**To remove items from the project tree or other lists in a Composer project:**

1. **Right-click** the item to remove in the project tree, and then select **Delete**.
2. Click **Yes** to confirm.

**Clearing a project**

To erase all project configuration information, use the **Clear Project** menu option.

Note: Control4 recommends that you create a backup file of your project first before you use this function. To back up the project, go to the File menu, and then select **Back Up**. Give the project a filename; the file saves to the My Documents folder by default.

**To clear out a project:**

1. From the File menu, select **Clear Project** to erase the project configuration information.

**Exiting Composer HE**

Use the **Exit** command to close Composer HE.

**To exit Composer:**

1. From the File menu, select **Exit**.
2. Composer asks you if you want to back up your configuration information.

   Note: Control4 recommends that you always save a backup copy of your configuration.

**Getting project configuration information from a controller**

Use the Connect to Director link to view configuration information.

**To get existing project configuration data from a controller:**

1. Verify that your PC and the controller are connected to the same network.
2. From the Composer Startup screen, click **Local System** or from menu bar, click **File > Connect to Director** (see below). The project configuration appears unless it is a new project.

![Local System](image)

**Loading a project’s configuration from a computer to a controller**

Use **Connect to Director** to load configuration information.

**To load the project configuration from a computer to the controller hardware:**

1. Verify that your PC and the controller are connected to the same network.
2. From the startup screen, click Local System, or from menu bar, click File > Connect to Director (see below).

3. From the File menu, select **Load Project**.

4. Click **Yes** when prompted to back up the project. Browse and select the project file. **Example: SmithProject.c4p**

5. When you see the new project displayed in the *Monitoring view*, the project is loaded to the controller, and you are connected.

*Backing up a Composer HE project*

Use the *File* menu to back up your project. Control4 recommends that you do this whenever you change anything in a project or if you update the software.

The *File* menu in the Composer screens provides the following options for backups:
- **Back Up**—Backs up the current project to your PC. The first time you back up, it prompts you for a filename. It also prompts you to back up any media information. If you select this option, the current project becomes an option in the File > Load Project list.

- **Back Up As**—Backs up the current project, and prompts you to enter the name of the file. It also prompts you to back up any media information. If you select this option, the current project becomes an option in the File > Load Project list.

Any time you exit Composer by clicking **File > Exit**, Composer HE asks you if you want to back up your project. If you've made changes, it's a good idea to do so.

**Backing up and loading from a virtual to a local or remote Director**

Use the **Connect to Director** option to back up a Director.

**To back up and load configuration information from a virtual Director to a local Director:**

1. From the Composer **File** menu, select **Connect to Director**.

2. When prompted, click **Yes** or **No** if you want to back up the media information.

3. A **Directors** dialog box appears listing the available Director IP addresses. Select the address of the controller to which you are connecting.

4. Click **Connect**. You are now connected to a local Director.

**Backing up a project’s configuration and media**

Use Composer HE to back up project information. When connected to the controller, changes are immediate.

**To save a project configuration to your computer, and then use the Back Up and Back Up As options:**

1. From the File menu, select **Back Up**.

2. Type a filename to back up the project, or use the same name, if you prefer.

3. When prompted, click to select the options to back up media information and personal information, then click **Save**.
Composer HE Version Independence

With the release of Composer HE 3.1, Composer HE now connects to Director running on the primary controller through a set of versioned APIs. The change allows Composer HE to connect to any controller running OS 3 or newer. But most importantly, Composer HE can now be released independently from Control4 OS releases which clears the path to accelerated enhancements, features, and fixes to Composer software.

Prior to this release, Composer HE, Control4 OS updates, and Drivers and Agents were all released at the same time. When a revision to one of these components was published, they were all updated together. This was necessary because these components communicated with each another through conventional Application Programming Interfaces, or APIs. When any API was added, changed, removed, or in some cases just used differently, all other components had to be revised to match. Here’s a simplified view of the prior relationships among these components:

With the release of Composer HE 3.1, communication between Composer HE and Drivers and Agents were made part of a versioned API. Now, new features can be added to Composer software while still allowing Composer to communicate to Drivers and Agents through a versioned API.

Here’s what things look like now:

For systems running Control4 OS 3 or higher, versioned APIs between Composer HE and Drivers and Agents allow the two components to be version-mismatched. In other words, Composer HE is now version-independent of Drivers and Agents, which in turn makes it version-independent of Director.

Note: While Composer HE and Drivers and Agents communicate through a versioned API, the OS’s built-in Drivers and Agents communicate with Director through conventional APIs. This means that for the time being, Drivers and Agents must continue to be version-matched with Director. APIs for Control4 and 3rd-party drivers that are based on the Driver Wizard or the DriverWorks SDK are
independent of the OS version. Developers of drivers which use the DriverWorks SDK APIs may designate a minimum-OS version.
Connecting Composer HE to a Virtual, Local, or Remote System

Composer HE gives users three connection options at startup. The same three options are presented after disconnecting:

![](image)

Virtual System

Virtual System, also known as Virtual Director, is a software emulation of the software that runs on the primary Control4 controller (Director). Selecting Virtual System will connect Composer to a Virtual Director running on the same PC. There’s no need to be connected to the local network (LAN) or to the internet to establish this connection.

Local System

Selecting Local System allows Composer to connect to a Control4 controller running Director on the same LAN as the host PC. Neither the PC running Composer or the controller have to be connected to the internet to establish this connection.

Remote System

Selecting Remote System allows Composer to connect to a Control4 controller running Director—that is also registered to Control4 account—located on a different LAN than the host PC. The PC running Composer and the controller both need to be connected to the internet.
Composer HE makes new decisions when connecting

When connecting Composer HE to a Virtual, Local, or Remote System, Composer HE now connects through a set of versioned APIs, if applicable, and allows you to manage those APIs when you connect.

Connecting to a Virtual System with versioned APIs

Each release of Composer HE comes with the latest set of Drivers and Agents and Virtual Director. Connecting to Virtual System is straightforward for any version of Composer HE, and as long as the user has not uninstalled its Drivers and Agents, the matched set of components will always be available.

Connecting to a Local or Remote System with versioned APIs

When connecting to a Local System or Remote System, the user must select the controller on the LAN or WAN to connect to. The Connect to Project (formerly, the Directors) screen presents a list of controllers to choose from, along with their IP addresses and OS version numbers.

In prior releases, if the user selected a controller with an incompatible version, Composer would alert the user and then open the project in a read-only “compatibility mode.”

With Composer HE 3.1, the following changes have been made to the way the Connect To Project selection screen works:

1. If the major component of the OS version number (for example, the ‘3’ in version number ‘3.1.0’) of the controller matches that of Composer HE:
   - If the minor and revision components of the version number also match that of the Drivers and Agents installed on the PC, Composer HE will display “Ready to connect” in the Status column for the controller, and a single action button labeled “Connect”: 
If the minor and revision components of the version number DO NOT match that of the Drivers and Agents installed on the PC, Composer HE displays “Requires OS management package [version#]” in the Status column, and a single action button labeled “Install and Connect”. If the PC is connected to the internet, Composer HE will download and install the correct drivers before connecting to this instance of Director. If the PC is not connected to the internet, Composer HE will use the OS management package that matches itself and connect to the project in compatibility mode.

2. If the major component of the version number (for example, the ‘2’ in the OS version number ‘2.10.0’) of the controller DOES NOT MATCH that of Composer HE (for example, ‘3.1.0’), Composer HE displays “Ready to connect to view or update” in the Status column. Composer HE displays an action button labeled “Connect”, which when clicked, connects to the project in compatibility mode. In addition,
• If version 2.10.0 of Composer HE is already installed on the PC, Composer HE displays an additional action button, “Launch and Connect Composer 2.10.0”, which launches Composer 2.10.0 and connects to the project in full access mode.

![Connect to Project](image)

• If version 2.10.0 of Composer HE is NOT installed on the PC, Composer HE displays an additional action button, “Install and Connect Composer 2.10.0”, which downloads and installs Composer 2.10.0 before launching it and connecting to the project in full access mode.

![Connect to Project](image)
Connecting to a Director

Each Control4 controller (for example, an EA-3) ships with pre-installed Director software. The Director communicates with Control4 and third-party products to enable home automation so devices can communicate with each other and Director.
Connecting Composer Pro to a Virtual, Local, or Remote System

Composer Pro gives users three connection options at startup. The same three options are presented after disconnecting:

Virtual System

Virtual System, also known as Virtual Director, is a software emulation of the software that runs on the primary Control4 controller (Director). Selecting Virtual System will connect Composer to a Virtual Director running on the same PC. There’s no need to be connected to the local network (LAN) or to the internet to establish this connection.

Local System

Selecting Local System allows Composer to connect to a Control4 controller running Director on the same LAN as the host PC. Neither the PC running Composer or the controller have to be connected to the internet to establish this connection.

Remote System

Selecting Remote System allows Composer to connect to a Control4 controller running Director—that is also registered to Control4 account—located on a different LAN than the host PC. The PC running Composer and the controller both need to be connected to the internet.
Connecting to a Director on a local network

When you connect to a Local Director, you are making 'live' changes on the controller. Every time you connect to the Director on that controller, your project opens.

Tip: You also have the option to make a backup of the project on your computer by using the **Back Up As** or **Back Up** option from the File menu to save the project file. When you back up a project file, it is backed up by default to the My Documents directory on your computer.

**To connect to a Director locally:**

1. From the desktop, double-click the **Composer** icon.
2. At the Composer startup screen, click **Local System**. Local Director connects you to the home network while working in Composer Pro.
3. From the Director dialog box, select the Director’s network address for the controller you are setting up, and then click **Connect**.
4. Make a note of the network’s **IP address**. Composer Pro opens to the Composer Monitoring view.

Setting up Remote Access

Use a Control4 Navigator to enable or disable Remote Access. This feature lets you access your Control4 system for updates using the Internet from a remote
location. Note: You can also set up Remote Access when you create an account at customer.control4.com.

Prerequisites

- Register the system at customer.control4.com. This process can be completed by the installer or homeowner as long as the system a Navigator, touch screen or on-screen configured in the system.

**To set up Remote Access for OS 2.6 or later:**

1. At one of the touch screens or on-screen Navigators, select **Settings > Service Connection**.
2. Select **Yes** under Remote Service.

**Notes:**

After you enable remote access, if the user has a 4Sight subscription for this system, then the user can enter their email address and password and securely log in to their Control4 home network from any Internet connection in the world.

When the user logs in, the homeowner can use the Web Navigator to monitor and control their lights, change their temperature (warm or cool the home remotely), or check whether any doors or windows were left open. You or the user can refer to this Internet information in the Control4 System User Guide.

If this system and controller are registered on customer.control4.com, the system is accessible for remote access (without a 4Sight subscription) after a request by the Control4 Installer or Control4 Technical Support representative has been made to access the system. After OS 2.4.0, this check-in is no longer required to initiate a remote service connection.

### Connecting to a Director using Remote Access

If you connect to a Remote System, you are making “live” changes to a remote system controller, where changes are communicated over an Internet connection rather than a local network connection. This type of connection is not available, however, until the initial configuration and registration are completed.

**Note:** The customer may revoke access rights through my.control.com at any time, but this is not recommended as it interferes with routine Control4 updates.

**Requirements**

- The customer must be registered at customer.control4.com and remote access must be enabled. (See “Registering the Control4 system” or “Register the controller from a Navigator.”)
A PC with Composer initially installed must be in the same local network as the controller when remote access is set up.

Before you can use the Remote System option, you must configure the system to support remote access (see “Registering the Control4 system”).

Connecting using Remote Access

To connect to a Remote Director:

1. Using a PC with Composer HE installed, verify that the PC has an Internet connection.
2. From the desktop, start Composer.
3. At the Composer startup screen, click Remote System. Remote Director connects you to the home network while working in Composer from a remote location.
4. Enter your Email Address and Password in the Account Name dialog box. This should be the login information from your account on your dealer my.control4.com account.
5. When the Select Remote Account dialog box appears, select the account you want to access, and click Connect.

If the account name doesn't appear under Name, click Add to add the account name, and Username (Email address) and Password if they are different from your dealer account login credentials, and click OK in the dialog box that appears. This is the Account Name you created during registration at customer.control4.com. After you do this, select the account from the Select remote account dialog box, and click Connect.
The next screen shows that your account, the User Email Address, and the Password are being verified. This may take several minutes to complete as it is accesses a remote connection.

When authenticated and connected through the Remote Access service, a list of Directors available for connection appears.

6. Select the Director you want to connect to, and then click **Connect**.

When connected, Composer opens and the main Composer view connects to the controller remotely. Composer functions normally as if you were connected to Local Director, allowing you to configure, program, and troubleshoot the Control4 system.

**Ensuring that Director and Composer are compatible**

Verify that the Control4 controller software (Director) and the Composer software are on the same version before beginning to design a project, or any time you use Composer to ensure the best communication between the two.

**To check compatibility:**

1. In the Composer menu bar, click **Help > About Composer**.

2. From the dialog that appears, compare the Composer and Director version numbers. For the Control4 system to run properly, these numbers must match. If they don't match, update Composer and/or Director to get to the same version. See the Composer HE User Guide for information about updating your system, or see "Update Manager."

**Example:**

Composer version: 3.0.0.562742

Director version: 3.0.0.562742
Note that the two versions in the screen below are the same.

System Compatibility Check

When connecting to a system, Composer HE performs a capability check to ensure that the Composer version and OS version are compatible. Use the System Compatibility Check to review which version of Composer must be used to modify your system.

System Compatibility Check
Registering the Control4 system

Every system must be registered at customer.control4.com to maintain the system software through online downloads, and to use all of the media features in the system (for example, the Control4 online media database for scanning music). System registration is also one of the essential first steps in enabling remote access to the system.

After you complete the initial Control4 system setup (adding devices to a project, identifying them automatically for devices released with OS 2.3.0 or later, and making software connections for each device), you are ready to register the system and set up the media. “Setting Up the Media” is discussed in the Composer HE User Guide.

You can register the system either from Composer or by using a Navigator. See the sections below.

Register the system at customer.control4.com

Control4 recommends that you register each Control4 system you install at customer.control4.com to maintain the system software easily through online downloads. Only registered systems can use all of the media services available.

System registration, which includes setting up a customer.control4.com account, is required to use most of the media services that are available in the Control4 system, for example, scanning media into the system (so that you don’t need to manually add individual music files).

You can register the system now through Composer, or later through a Navigator if you customize the Navigator. You may have already registered the system in Composer to set up media. If not, you can register the system using any Internet connection and one of the Navigators that is connected and identified.

Register the controller from Composer HE

Composer HE lets you register the controller to a customer account without having to log in to the customer’s account. You can now create a new account and register the controller in one step, register to an existing account found under your dealer of record, or manually register the controller using the 10-digit code from the customer’s account page under Controller registration.

To set up a new customer.control4.com account and register this Control4 system:

1. In Composer HE, go to Tools > Account Services.
2. Click the Add New Account tab to create a customer.control4.com account and start the registration process for the user.
3. Complete the *Account Information* form for the user, and then record the Account Name and Email Address for the user’s future reference.

4. Click **Add Account** to create an account for this Control4 system and register the controller to the new account.

   **To register the system to an existing customer account:**

1. In Composer HE, go to **Tools > Account Services.**
2. Click **Select Account** and select the existing account you wish to register to in the list of *Customer Accounts*.

![Account Services](image)

Note: If the existing customer account does not show up in the Customer Accounts list, have the customer log in to their account and verify their dealer of record is pointing to your dealer account.

**To manually register the system to an existing customer account:**

1. In Composer HE, go to **Tools > Account Services**.
2. Click **Manual Registration**.

3. From the customer.control4.com account page, copy the 10-digit registration code found under My Devices > Controller Registration > Register New Controller. This code is time sensitive and must be used within **10 minutes**. It provides a temporary code used to exchange the security parameters and create a secure connection between customer.control4.com and the controller.

4. On the Account Services page, click the text box and paste the **10-digit registration code** in the box.

5. Click the **Register** button on the Account Services page in Composer (now enabled) to complete the registration. The Current Status changes to 'Registered.'

### Setting up a 4Sight subscription

Use the Internet to set up a 4Sight subscription. This feature enables a Control4 system user to log in to the Internet and manage their Control4 system on the web. Consumers will need 4Sight to use Anywhere Access also.

- **Note:** 4Sight subscriptions are sold separately.

### Prerequisites

1. Design and set up the project.

2. Register the Control4 controller and the system owner.

When a 4Sight subscription has been obtained for the Control4 system, this setup can be done by the homeowner or installer. The installer or a Control4 representative should be able to provide information about how the homeowner can set up a customer account. The Control4 System User Guide or Account Setup provides that information for the homeowner.
To set up a 4Sight subscription at customer.control4.com:

1. Obtain a 4Sight subscription code for the system (sold separately).
2. Log in to customer.control4.com using the homeowner/user email address and password.
3. From the My Account tab, select the Subscriptions view.
4. Enter the 4Sight subscription code provided by your Control4 representative, and then click Activate.

Tip: Scroll down and view Account Subscriptions to see which subscriptions you already have.
Where to go from here

This Control4 Composer HE Getting Started guide gave you:

• An overview of Composer: how to install and start it, how to access a Director, and includes a preview of the Composer interface (views, menus, properties, panes, etc.).
• An overview of how to start designing your project with suggested tools.
• An overview about connections and how to test devices.
• How to register the Control4 system.
• How to set up a 4Sight subscription.
• How to set up Remote Access.

More detailed and advanced sections (Composer Pro User Guide) are outside the scope of this document but you can find them on the Dealer Portal.

The advanced sections give you specific details about:

• Setting Up Media
• Creating Device Drivers
• Making Connections
• Verifying Connections
• Configuring Devices
• Configuring Properties
• Basic Programming
• Advanced Programming
• Customizing Navigators
• Installing Devices
• Troubleshooting the System

Other resources

Also check out the Control4 Forums or Knowledgebase.
Basics

Composer HE basics

Use this chapter to learn how to:

- Install and configure devices
- Configure Composer HE properties
Monitoring the system

The Composer HE Monitoring view is designed to help you view your system, rooms, and devices. To access the Monitoring view, start Composer HE. When you choose the Monitoring view (highlighted in the lower left pane), you have two tabs to choose from: List View and Properties.

Monitoring view:

Check the Device Status in List View

The default page in the Monitoring view is List View (first tab, top right) which lets you view all the devices in your Control4 system and their current state.

List View groups devices under the rooms to which they’re assigned. In the example above, all of the devices are located in the Living Room because the Living Room is selected in the project tree (Monitoring pane).

- **Monitor Status**—You can monitor the status of devices in the system. In List View, double-click on the device’s icon to bring up the device’s controls. Light levels are indicated with slider bars and buttons for on or off state. Each device has a different set of controls.

- **Device Controls**—You can access the device’s controls by double-clicking on any device icon in either the project tree or the List View tab.
Try this: Double-click on any device with an On/Off option to access the device's controls, for example, a switch. Turn the device on or off; some devices have a color change on the icon in the Device Control and in the List View. See also “Checking the Device Status.”

Change Project Properties

The main Composer HE view shows the Properties pane. Click the Properties tab to view the properties of the project, room, or device.
The Properties pane displays the following elements:

- **Project Properties**—This lets you change general information about the project according to the location of the Control4 system. In the project tree, click the **project name** (BN Office is the example above).

Use the project Properties pane to do the following:

- Change the name of the project
- Change/enter the ZIP Code of the location where the Control4 system resides
- Change the date and time
- Change the project settings
- Enable SSL and password for security purposes
- Change localization options

This lets you edit Room Properties in the following tabs:

- **Audio Video Devices**—Shows your available audio and video devices, where your audio and video end points are, and what is controlling the volume. If a device does not appear in this window and you think it should, check the connections. The connections may not be mapped properly.
- **Navigator**—Lets you hide/re-order the device’s visibility and display order in a room, including lighting scenes.
- **Miscellaneous**—Lets you enable the default audio or video volume for a room, and assign an IP mask to the room for programming a third-party remote.
Device Properties—Click on a device from the project tree to see its editable properties. For example, you can set the one-click ramp up and ramp down rates on a Wireless Dimmer. You can also edit the LED colors for all of your switches, keypads, and dimmers.

Control4 recommends that you look over the properties of each device to see how you can change them.

See also “Checking the Device Status” (next) or “Changing project properties” later in this document.

Configuring device properties

Use the Composer Properties pane to change device properties. The Properties pane lets you make configuration changes to a project, room, or device.

In the Control4 system, you have a choice of configuration options using these property types:

- **Project Properties**—Lets you set project-specific configuration options.
- **Room Properties**—Lets you set room-specific configuration options.
- **List View Properties**—Lets you set device properties listed by location, for example, room, floor, house, etc.
- **Device Properties**—Lets you set device-specific configuration options.

**To configure properties:**

1. Start Composer and connect to a Director.
2. Click Monitoring.
3. Select one of the following property types:

   - **Project**—Select the root node in the project tree, for example the project name (such as Franklin Smith Home) to access the project properties and modify the:
     - Project name
     - ZIP Code
     - Latitude/longitude
     - Date
     - Time (12-hour and 24-hour clocks)
     - Time zone
     - Lighting Defaults
     - Project Settings Control
     - System Security
     - Localization
• Scale (Temperature)
  For more information, see “Composer Pro properties”.

• Room—Select the room in the project tree, for example, Theater; the Properties tab is visible (default).

Room properties let you:
  • View room-specific devices
  • View media information
  • Help you troubleshoot any incorrect room connections

For more information, see “Room Properties”.

• List View—Select a room, and then select the List View tab. View and/or modify the devices in the room. For more information, see “Device Properties”.

• Device—Select the device to modify the available user options. For more information, see “Device Properties”.

Help for device properties
Device properties vary by type of device. Changes made to the properties of most devices are immediately applied to the system. Changes made to Navigators may not be noticeable until you refresh the Navigators using Composer HE’s File > Refresh Navigators command (Shift+F5).

For the most up-to-date device properties information, click the Documentation tab in the Properties window (available only on select devices) or the Help button on the proxy.
Examples

Use this chapter to see examples of how to:

- Set up a project using the Composer Views method
- Manage apps with the 4Store agent
- Use the Access agent
- Use the Advanced Lighting agent
Example: Use the Access agent

Use the Control4 Access agent view to allow or deny access or hide parts of the user interface on supported touch screens and on-screen TV interfaces. The Access agent is ideal for commercial applications including hotels, bars, or board rooms where settings need to be locked or hidden to restrict their use by unauthorized personnel. By adding this agent to a project, an access code is required to gain access to selected functions of the Status Bar or the More and Settings modules. When enabled, the Access agent settings apply to profiles created in the Identity agent and each profile can be applied to any number of touch screens and on-screen TV interfaces in the system using the UI Configuration agent.

The Access agent provides these key features:

- **User**—Select a profile and define the Access restrictions for that profile. After you apply the settings to a profile, use the UI Configuration agent to apply the profile to a user interface.
- **Current Access Code**—The programmer can establish a four-digit access code to restrict access to user interface elements globally.
- **Access Agent—Enable or Disable** the Access agent for the selected user profile.
- **Hide Digits**—Hide or show numbers on the user interface when entering the Access Code on a user interface.

**Navigation**

- **Experience Menu**—Lock the Experience Menu (C4 icon). If locked, you can only see the favorites in the Room Menu and must enter the Access Code to see the Experience Menu.
- **Return To Room**—Lock the Return to Room icon (Room icon in the top left that replaces the Experience Menu icon after you select a device). When locked, you must enter the Access Code to return to the Room Menu.
- **Back Button**—Lock the Back button in the Status bar after you select a menu. For example, with the Back button locked, if you navigate to a camera view, you must enter the Access Code to return to the Cameras Menu.
- **Room Selector**—Lock or Hide the Room Selector in the Status bar.
- **Room/All Filter**—Lock or Hide the Filter icon on menus that support filtering like Lighting and Shades. If you lock or hide the filter, you can only see items in the current room unless you change the filter to All.

**Media**

- **Sessions**—Lock or Hide the Sessions interface. With the Sessions interface locked or hidden, you must enter the Access Code to control Sessions in other rooms.
• **Media Sharing**—Lock or Hide the Media Sharing option in the Sessions interface. With Media Sharing locked, you must enter the **Access Code** to share media with another room.

**Other**

- **Settings**—Lock the Settings icon. With Settings locked, to access Settings like Wallpaper or Screensaver options, you must enter the **Access Code**.
- Edit Lighting Scenes—Lock or Hide the Edit icon on Lighting Scenes.
- Favorites—Lock or Hide the option to add an item as a Favorite.
- Intercom—Lock the Intercom icon.
- Lock Screen—Set to Unlocked, Auto, or Manual to configure a lock screen for the interface. For Auto, configure the Screen Lock Timeout below the Lock Screen option. For Manual, long-press on the C4 icon (or long-press to activate the lock screen.

**Prerequisites**

- Create a user profile in the Identify agent if you want to apply the Access agent settings to a selected group of interfaces or use the default profile.
- Figure out which Status Bar or other functionality you want to restrict or hide from unauthorized users. For example, do you want to lock the Room Selector? Keep others from getting into Settings? Hide the Favorites button?
- Establish an access code.

**To create a profile in the Identity agent:**

1. Start Composer HE and connect to a Director.
2. Click Agents.
3. Select the **Identity** agent.
4. Click **Add User**.
5. In the **Create New User** window, enter a **Username**, **Password**, and **Confirm Password**. The password must contain 8 digits, 1 capital letter, 1 number, and 1 special character.

**To enable the Access agent:**

1. Click **Agents**.
2. (First time only) Click **Add** to add the Access agent to the project.
3. Double-click on the **Access agent** to add it into the project.
4. Enter a four-digit access code on the numeric keypad.
5. Click **Set Access Code**. The new access code appears in 'Current Access Code' window.
6. Select **Enabled** in the **Access Agent** option.

To apply a user profile in the UI Configuration agent:
1. Click **Agents**.
2. Select the **UI Configuration** agent.
3. Select the **User** tab.

4. Select the user profile in **Assign user to Touch Screen** and click **Apply To ...**
5. Select the user interfaces or rooms to apply the profile to and click **OK**.
As a reminder, the Access agent enables the programmer to restrict certain features and settings from all users on touch screens and on-screen TV interfaces. Any changes to Access Codes or these settings can only be made using Composer software. If the Access Code is lost or forgotten, it can be recovered only using Composer.
Example: Use the Advanced Lighting agent

Use the Control4 Composer HE Agents and Programming views to program this agent. (For OS 2.3.0 or later, this agent supports the Panelized Lighting product line with full functionality. Older lighting products are also supported, but with limited functionality.) This agent provides more advanced features than the Lighting Scenes agent. See also “Example: Program Using the Lighting Scenes Agent” in this document.

The Advanced Lighting (Scenes) agent provides these features:
- LED tracking for Lighting Scenes
- Toggle Lighting Scenes
- Ramp and fade Lighting Scenes
- Set delays within Lighting Scenes
- Scene sequencing
- Flash lights in Lighting Scenes

To use the Advanced Lighting agent:
1. Start Composer HE and connect to a Director.
2. Click Agents.
3. (First time only) Click Add to add the Advanced Lighting agent to the project. **Note:** You must add the Advanced Lighting agent to the project before your customers can edit Lighting Scenes on a Navigator.
4. Select Advanced Lighting, and then click OK.
5. In the Agents pane, select Advanced Lighting and then click New.
6. Enter a name on the dialog that appears (for example, Party Lights).
7. Click Create. **Notice** that you have more options than if you were using the Lighting Scenes agent. **Note:** You can click the Rename button to rename a scene.
8. Adjust the scene as desired.

- **Show flash option**—Select this option to add a Flash checkmark in the list of lighting devices below. When Flash is checked, lights can flash on and off at set intervals. Use this option with the Delay option. For example, this option works well in a situation where you want to alert someone so you can set a porch light to flash in case of an emergency or to get someone’s attention. **Note:** For older lighting devices (earlier than OS 2.3.0), flashing is not supported.

- **Activate Scene**—Click this button to activate the scene immediately. **Note:** The Execute On and Execute Off buttons do not appear in the Advanced Lighting agent. Use the Activate Scene button.

- **Sync This Scene**—Click this button to synchronize this scene with other scenes. This option isn’t really needed for Panelized Lighting unless there seems to be a
problem.

- **Sync All Scenes**—Click this button to synchronize this scene with all scenes created. This option isn’t really needed for Panelized Lighting unless there seems to be a problem.

- **Colors**—This is the keypad color. Click the Active or Inactive colored boxes to select another color.

- **Tracking**—Click All Loads to track a dimmer or switch by name, tracking status, delay, rate, level %; and all loads must match their tracking condition before the scene will be considered active. Click Any Load and only a single load needs to match their tracking condition before the scene will be considered active.

- **Hold Rates (sec)**—Use the up or down arrows to select the Up hold ramp rate or Down hold ramp rate. At the keypad, press and hold for a set period of time in seconds. This action behaves the same as hold rates for dimmers.

- **Toggle Scene**—This pull-down allows you to select which scene to activate when the current scene is prompted to deactivate. This applies to all scenes except for the current one selected. Here, you can toggle scenes on or off.

Example: Create an Advanced Lighting Scene called “Dining.” Notice the number of switches and dimmers in the Advanced Lighting pane and their values.

![Advanced Lighting Scene](image)

1. Create a Dining 'Toggle' scene. Notice the difference in switches and dimmers and their values from the previous screen.
2. Now click the **Connections** view to connect the keypad bindings on a 3-Button Keypad.

When you toggle the 3-Button Keypad in the Dining room, various lights go on or off at various levels. For more information about connections, see “.”

Now go back to the **Agents** view.

- **Toggle Scene/Create Default**—Click **Create Default** to create a toggle scene as a copy of the selected scene. From the copied scene, you can rename the new scene and adjust the values on some of the dimmers or switches in that scene.
• **Current State**—Shows ‘Active’ when the conditions are met to consider the scene Active or Inactive if the conditions have not been met.

• **Add/Remove Load**—Click to add or remove specific dimmers or switches to the scene. Check the lighting loads that you want to add, and then click **OK**. This can be a single light, a single room, all lighting loads in an entire house, or any combination of these options.

9. Assign the settings for each load:

  • **Dimmer and Switch Options:**

  • **Name**—The top line is the room, and the bottom line is the name you assigned to the dimmer or switch.

  • **Tracking**—This lets you track the lights in the system. Use the **down** arrow to select one of these options.

  • **Don’t Track**—Tracking is ignored.

  • **Is Off**—Track when the dimmer or switch is off.

  • **Is On (Any Level)**—The text displays only if the light is a dimmer. Switches just indicate ‘Is On.’

  • **On At Level (%)**—Track when the dimmer is on at a specific level.

  • **At Scene Final Level**—Track at the final level of the last sequence. For example, if someone changes the level on a Navigator, this might be the final level.

  • **Delay**—Use the **up** or **down** arrows or type the delay value in seconds.

    Tip: If you have several dimmers in a long hall, and you want to set up sequencing, you can use this option with the green + buttons and increase the delay of each dimmer in a row by two seconds.

  • **Rate**—Lets you set the ramp rate, which is the speed the load ramps to for the specified lighting level. Use the **up** or **down** arrows to set the milliseconds (ms), seconds (sec), or minutes (min) of the ramp rate. Then set the amount of time the device takes to change the level.

    Example: Set the time to 1 second for both the Bedroom Dimmer and the Theater Dimmer.

  • **Level (%)**—Lets you set a target lighting level as appropriate by using the pull-down menu, for example, 50 percent for the Bedroom Dimmer and 20 percent for the Theater Dimmer. The green + gives you the ability to add ‘paths’ to a scene. Each row in the path uses single delay/rate/level settings. Use the green + to add another step, click the red x to delete a step, or you don’t need to have any steps.

    Note: Older lighting devices (prior to OS 2.3.0) only allow 0 or 1 steps.
• **Apply To**—Click this option to allow other lights to use the same scene.

• **Ignore Scene Ramp/Fade**—Check this option to have the light ignore commands to ramp or fade a scene.

• **Graph**—Shows in graphical form (red lines) the settings for each dimmer or switch. Dimmers will show ramp rates, delays, and levels as angled, horizontal, or vertical lines.

10. Now click **Programming**. To program a scene, follow the basic steps in “Programming Basics for Control4 Systems.”

Note: In the Programming view, the Advanced Lighting Scene has variables, conditionals, and loops that do not exist in the Lighting Scenes agent. This agent also has ‘read-only’ variables for the length of each scene.

Example: Note the screens below. The Events and Actions panes use different options than the Lighting Scenes agent (Activate, Deactivate, etc.).

**Event**: (Is Invoked, Becomes Active, Becomes Inactive)

• **Is invoked**—This event fires when the scene has been explicitly told to activate. If the scene is already activated, and it is told to activate again, this event will still fire.

• **Becomes Active**—This event fires when the scene transitions from the Inactive state to the Active state.

• **Becomes Inactive**—This event fires when the scene transitions from the Active state to the Inactive state.
• Actions—(Activate, Deactivate)

A programming example for use with the Advanced Lighting agent might be where, if the front door opens and it’s past 9 PM at night, all the lights turn on in the home at various levels.
Setting up media

Use this chapter to learn how to:

- Scan your network for media files
- Access media from disc changers
- Play AV from television stations
- Play audio from radio stations
- Add a switch
- Create a playlist
- Test a media connection
- Edit media information
Media types

To take full advantage of media lookup services by Gracenote, your customers must have an account at customer.control4.com and their system must be registered to the account. See Composer HE Getting Started for details.

To add and scan songs and albums for playlists, they must be available in MP3, WMA, M4A/AAC, or FLAC format on an external USB drive, eSATA drive, or network share.

To add Internet radio stations, the Internet radio driver must be bound to the controller. See "Setting up Internet radio stations" in this document.

Tip: In OS 2.4 and later, you can use the TuneIn app to stream radio, news, sports and more from Internet stations worldwide. See the TuneIn Setup Guide or TuneIn User Guide for details.

You can set up your customer's audio and video media in a Control4 system for:

- Controllers
- Disc changers
- Media players
- Dock for iPod (iPods, iPhones, etc.)
- Television broadcast channels
- Radio broadcast stations
- Internet radio
- Satellite broadcast channels or music stations
- Other external storage devices: USB flash drives and shared network drives

You can also:

- Add CDs and DVDs
- Add individual songs
- Add cover art, titles, albums, etc.
- Create playlists
- Use the auto-scan feature to scan movies or music
- Add and scan supported files from third-party media managers, for example, iTunes
- Edit media information for DVDs, CDs, etc.

To view and select the media from the Navigators, including wireless touch screens, on-screen, Control4 apps, and System Remote Control devices, you first need to add and scan the media to the Control4 controller.

For the MP3, WMA, M4A/AAC, or FLAC files stored on an external hard drive or network location that you add and scan, you can create playlists saved to the Control4 controller’s hard drive in the media database.

Note: Speaker Point does not support M4P/AAC. Play songs through Speaker Point using MP3.
Note: Internet radio supports only MP3, WMA, and MP4 streaming radio stations.

Tip: The Control4 system must be functioning correctly before performing any of the tasks mentioned in this section. For example, if a disc changer does not appear in the project tree and is not identified and connected to the system, media cannot be added to it.
Overview of media management

Media configuration and media management are controlled in the Composer (Pro, HE, and ME) software. The primary controller that runs Director always runs Media Manager and the media database (SQLite 3.1).

- **Media Database**—Migrating from pre-OS 2.0 to OS 2.0 and later requires a media database conversion and schema changes; consequently, the media databases in OS 2.0 are smaller.
- **Media Manager**—All scans are performed by the Media Manager running Director on the primary controller. Note: Composer HE configures scanning only, and does not scan the media.
- **Media Lookup Service**—This service now runs either in Composer HE or Media Manager.

**Composer New/Edit – Search**—For media metadata lookup when media has not been scanned properly. The information retrieved can be edited and written to the media database, and/or the metadata can be written to the tags.

**Media Manager**—Uses online media lookup. IMPORTANT! Controller registration is required on MyControl4 to use this service for versions later than Release 1.6.

Other Media Managers: You can use other media managers, for example, iTunes, Windows Media Player, and Media Monkey to create or manage MP3s and WMAs. You can still use Composer Pro, Composer ME and Composer HE to configure media files for a Control4 system.

Media Manager

New scans

- Scans Id3 tags that are embedded in the file.
- The title, album and artist names are extracted from the file system folder and filenames.
- The metadata lookup based on title searches comes from Gracenote.
- In OS 2.0 and later, scans are now much faster.
- Press F5 to refresh after new scans.
- Scans can be tied to events, button presses, etc.

Scans where content is in the media database

- Scans for any updated Id3 tags in the file, or you can synchronize the media database based on the configuration.
- If no metadata is in the media database, the metadata lookup is based on title searches from Gracenote.

Other Media Manager considerations

- **Media Manager** scans only one device at a time. If several devices are configured and are in the queue, they will be scanned sequentially.
- **Composer HE** does NOT need to be connected when Media Manager is performing a scan.
- Scans can be performed manually in Composer HE as an event or in an automated schedule.
• If the path becomes disconnected, the metadata will not be deleted.
• If devices are modified, the tags will update.
• If you are using a third-party Media Manager, synchronization will occur if set.

Media storage

Audio and video files can be stored on one or more of the following devices:

• **USB-attached storage**—Both audio and video can be stored on these devices, although Control4 does not recommend doing so due to poor performance.

• **Network-attached storage** (Samba-mounted)—Control4 recommends this solution for audio and video files due to better performance and backup/recovery capabilities.

As with previous releases, all media storage devices must be added and configured in the Composer Pro project. Composer HE does not automatically discover new media storage devices. The storage locations are not available in the Navigators until the device is scanned.

Media lookup service

• Control4 uses Gracenote for its lookup services.

• Media lookup is optional. See the Media view in Composer HE Getting Started to disable lookup (set to Never in scheduling).

• Media lookup requires that the controller be registered at customer.control4.com.
Setting up media auto-scan

Use the auto-scan feature in Composer HE to scan media automatically. This section applies to disc changers, media players, network-attached storage, and USB drives.

Note: Composer HE does not need to be open to scan media. If you started a scan in Composer, you can close the program while the scan finishes. Also, scheduled scans can run automatically or be started through programming.

Prerequisites

- Ensure that the video device is installed as directed in the Control4 Installation and Setup Guide for the device.
- Ensure that the Network File Storage driver is added to the room in the Composer HE project.

To schedule a regular scan of media:

1. From the Media view, select Media Scanning Options. To scan your media now (and not set up a scheduled scan), click Scan Now and skip the Scanning Schedule in Step 2.
2. In the Options pane, set the schedule as follows:
   - **Scanning Schedule**—Select one:
     - **Never**—Select if you never want to schedule an automatic scan.
     - **Every x Days or Weeks (up to 10)**—Select the frequency to scan.
     - **On the following days**—Select Sunday through Saturday.
     - **At <time>**—Use the up and down arrows to select the time. Highlight AM or PM and type the value: AM or PM.
   - **Files To Scan**—Select a device and extension.
   - **Network File Storage**—Select if you have a NAS (network attached storage) device you want to scan.
   - **USB Drive**—The manufacturer's USB drive appears here. Select if you have a USB drive you want to scan.
   - **Extensions**—Use the up and down arrows to choose which file types to add or remove. To add a file extension (if it doesn't appear in the list), use the down arrow to select the extension, select Video or Audio, and then click Add. Click Remove to remove that file type from the list.
   - **Use Online Media Lookup to improve scan results**—Check if you want the scan to access the Internet to search for missing metadata information (title, cover art, genre, tracks, or other information).

Tip: To update existing media with high-resolution cover art after updating your system to OS 2.8+, check this box and scan the media files.
• **Remove media from the database if the files no longer exist**—Check to remove database information when a media file has been deleted.

  Important: If you disconnect a USB drive with media on it and run a scan with this option selected, the media database entries will be deleted, and you may not want to delete them if you use the drive again.

• **Update media database if file tags have changed**—Check to have the database updated if the metadata changes.

• **Enable MQA**—Check to enable MQA Audio in the project. See ctrl4.co/mqa for more information.

3. Click **Apply**.

4. Click **Scan Now** to start the scan immediately or **Stop Scan** if you've started the scan and want to stop it.

### Disc changer

This section applies to a Sony CX777ES Disc Changer. The benefits of running a disc changer with bidirectional communications (RS-232), such as the Sony CX777ES, is that you can scan your DVDs/CDs stored in the disc changer to identify and index media, and automatically apply cover art and information about the media.

You can configure your system in Composer Pro to scan media on the associated disc changer either automatically or manually when the **Auto Scan** option is selected in the Monitoring Properties pane for the disc changer. The default is to scan media manually (Auto Scan: Off).

When the **Auto Scan Enabled** option is checked on the Disc Changer Properties page, the Auto Scan feature automatically detects when a disc is added to an empty slot or when a disc is removed. The Navigators are automatically updated with the change. The Auto-scan feature does not detect when a disc is replaced or swapped.

Note: If a DVD/CD is scanned and the media is not recognized, it is titled 'unknown.' You can edit the information about the DVD/CD, and manually provide this information from either Composer Pro or the Navigators. If this DVD/CD is then moved to a different slot, the system applies this same information.

**To auto-scan added media to a disc changer:**

1. Start Composer Pro and connect to a Director.

2. Click **Monitoring**.

3. In the project tree, select the device, for example, **Disc Changer** with a serial connection (RS-232) to the controller, for example, the Sony CX 777ES Disc Changer.
4. In the device's Properties pane, ensure that the **Auto Scan Enabled** option is checked.

5. Open the disc changer drive, and **add** or **remove** the DVD/CD.

6. Close the drive to begin the auto-scan. The information for the added DVD/CD is automatically made available on the Navigators. See also ",”

### Scanning media in a disc changer

The following sections describe how to add media to the media database using the options listed above.

**To scan media loaded in a disc changer to add it to the media database:**

1. Click **Monitoring**.
2. Ensure the disc changer shows in the list view.
3. Click **Media**.
4. Select **Disc Changer**.
5. In the Disc Changer pane, click **Scan > OK to Scan all.**
Note: If the following error message displays, "Your system has not been registered on MyControl4," you can click Yes to continue scanning music without registering, but the music scans based only on the current metadata stored in the music files. You will need to enter any missing information manually for each disc.

Example: If no cover art is found in the file’s metadata, then no cover art is associated with the music unless the system is registered in 4Sight, and you can go to the online media lookup (Media view > Edit > Name > Search > Select > Next) to obtain the cover art for the music.

Automatically scan media

The following steps use the Sony CX777ES Disc Changer as an example.

To auto-scan added media:

1. From the project tree, click the Sony CX 777ES Disc Changer. The device Properties pane appears for this device.
2. Ensure that the Auto Scan Enabled box is checked.

When you select the Auto Scan Enabled option from the device’s Properties page in Composer HE, an automatic scan of the disc(s) is available if you add a new disc to an empty slot, or if a disc is removed. In those cases, the disc changer automatically recognizes the change, and the Navigators automatically update the changes. The disc changer recognizes the changes in its slot when its door closes to perform the auto-scan. The Auto-scan feature does not detect when a disc is replaced or swapped.

Note: Control4 recommends that you check the Ignore Unexpected Play, Stop, or Pause option. This option should be checked if you are configuring a system with lighting, for example, when the movie starts playing, and the lights in the room dim. Normally, you can use the Play, Stop and Pause functions on the disc changer during the course of a movie being played. By checking the option, these functions are ignored by the system.

3. Open the disc changer drive’s bay, and change the existing DVD or CD.
4. Close the bay.
5. The auto-scan begins automatically when the disc changer door closes, and the information for the new DVD or CD is available in the Navigators.

Searching media in a disc changer

To search media loaded in the disc changer to add it to the media database:

1. Click Media.
2. Select the Controller in the project tree.
3. In the Disc Changer pane, click Search.
4. Type the **DVD** name in the blank box. The possible DVD titles from the Web database appear in the Search Results window. Use the **scrollbar** to find the appropriate DVD title

Example: “A Beautiful Mind”

Select the appropriate DVD title, drag it over the empty line item, and then select it again.

5. Repeat the previous steps for each of the DVDs/CDs in the disc changer you want to add to the media database.

6. Click **Finished**.

---

**Edit CD or DVD information**

**To edit a scanned DVD or CD:**

1. Select the **CD** or **DVD** to edit.
2. Click **Edit**.
3. Change the Title, Director or Artist, Album or Movie, Studio, Genre, etc. You can also change the location, locate the cover art (Find Art File), and so on.
4. Click **OK**.

---

Adding a DVD or CD

**To add a DVD or CD:**

1. Click **Media**.
2. Select **Disc Changer** in the Media pane.
3. Select the empty box for the **New DVD** and **New CD** buttons to appear.
4. Click either **New DVD** or **New CD** as appropriate. The New Movie or New Album dialog appears.

5. In the Title box, enter the DVD you want to play.

   Example: "A Beautiful Mind"

6. Click **Search**.

7. When the Search dialog appears, use the **scrollbar** to find the appropriate cover art, and select it.

8. Change the search criteria, and search again if needed. The possible matches from the web database appear in the Search Results window.

9. Click **Next**.

10. (Optional) Customize the DVD/CD information before adding it to the media database
by editing the text in the box.

11. Click **Finished**.

12. Click **OK**.
Setting up videos for a media player

Use the Media view to identify the videos that you want the media player to play.

Prerequisites

- Ensure that the media player is installed and added to the project.
- Ensure that the network-attached storage contains the videos that will play on the media player, and that the NAS is added to your project.
Setting up media for radio stations

Use the Media view to set up radio stations for a Control4 system.

To set up media for radio broadcast stations:

1. Start Composer HE and connect to a Director.
2. Click Media.
3. Select the broadcast media type (AM Radio, Dish Network, etc.).
4. Click Search.
5. In the Zip box, type the ZIP Code of where the Control4 system is located.
6. Click Search, and use the pull-down menu to select the listings. The available stations are populated in the Search Results window.
7. Check the individual boxes of stations that you want to make available in the Navigators; or click Select All, and then click OK.
The selected stations populate the media source channel list (such as the FM Radio list shown next).

8. Repeat the previous steps for each additional media source, e.g., cable, satellite, or AM radio. (Each of these services must be set up separately.)
Setting up media for television stations

Use the Media view to set up television channels for the Control4 system.

To set up media for television broadcast channels:

1. Start Composer HE and connect to a Director.
2. Click Media.
3. Select the broadcast media type (UHF/VHF, satellite, cable, etc.).
4. Click Search. When the dialog appears, type the ZIP Code for the Control4 system’s location in the box.
5. Click Search, and use the pull-down menu to select Local Broadcast Listings. The available channels are populated in the Search Results window.
6. Check the individual boxes of channels that you want to make available in the Navigators, or click Select All, and then click OK.

The selected channels populate the media source channel list (such as the UHF/VHF
channel list shown next).

7. Repeat the previous steps for each additional media source, e.g., cable, satellite, AM radio, or FM radio. (Each of these services must be set up separately.)
Setting up Internet radio stations

Use the Media view to add Internet radio stations that you can play from touch screens, Control4 apps, or on-screen Navigators.

Prerequisites

- Ensure that the controller is installed and identified as directed in the controller's installation guide.
- Ensure that the Internet radio stations you add are in MP3 or WMA format. You’ll need to create a new form for each station you add.

To configure Internet radio:

1. Start Composer HE and connect to a Director.
2. Click the Media view.
3. From the media list, click Internet Radio.
4. In the Internet Radio pane, click New.

5. Fill out the form:
   1. Name—Add the name of the station.
   2. Description—Add a description that's meaningful.
   3. Channel—Add the URL for the channel. Note: Locate the URL of the MP3/WMA stream that starts with http://... Note: Ensure that Audio Only is checked.
   4. Genre—Add a genre if appropriate.
   5. Check Audio Only for listening.
   6. Cover Art—If you'd like, you can copy the radio station art to your list. In a browser, go to the link and click Images. Click Find Art File to locate an image, copy it to your clipboard and then click Paste from Clipboard.
7. Click **OK**.

6. Go to the touch screen, Control4 app, or on-screen Navigator and select the **Listen > Station**. Note: If you have several sources, Internet Radio appears under Sources.
Importing a DVD list from a file

Use the Media view to populate DVD metadata stored on a disc changer.

**To import a DVD list:**

1. Start Composer HE and connect to a Director.
2. Click **Media** view.
3. Right-click on the Disc Changer, and select **Import DVD List from File**. Composer HE automatically populates the slots of the disc changer with the DVDs stored in each slot as listed in the file that is imported.

   The imported file must be a CSV (comma-separated value) file listing the slots and the titles of the DVDs, one per line. You can create this file using a simple text editor or spreadsheet program by exporting a spreadsheet file in a CSV formatted file. This new feature provides a simple and easy way to quickly configure all of the DVDs in any manufacturer’s disc changer.

**Example** formatting for CSV file:

- 1, Toy Story
- 2, The Incredibles
- 3, The Perfect Storm
Using external storage devices

You can access digital music from an external storage device in your Control4 system. External storage devices include USB flash drives, USB external hard drives, or a shared network storage area (for example, a computer’s hard drive).

The following applies when setting up an external storage device:

- USB flash drives or USB external hard drives must be formatted as FAT32 devices.
- Shared drives on a Windows system cannot contain a space in the directory/pathname.

Set up the external storage device or networked file storage as described in this section.

Note: When you disconnect the external drive (USB, network, etc.) from the system, the music is no longer available. Reconnecting the external drive makes the media available again.

Attach and scan external storage devices

To attach and scan external storage devices using a USB connection:

Note: External storage devices must have media stored in unprotected MP3/WMA format.

1. Power up the external storage device.
2. As appropriate, use the documentation provided with your Control4 controller to attach the external hard drive using the USB port.
3. Start Composer HE and connect to a Director.
4. Click Media.
5. In the project tree, select the external device.
6. Click Scan in the device’s pane.

You can add media from the external storage device when it is connected to the controller. However, it is recommended that you connect your external drive directly to the PC where you want to copy the media. When scanning, the media appears on the device.

Access and scan network storage devices

To access and scan network storage devices:

Note: The network location must be an open share location (no password required).

1. As appropriate, use the documentation provided with your operating system to create a shared network drive.
Example: Using Windows XP to make a local C:/ Drive directory available on the network, right-click the folder and select **Sharing and Security**. Click the **Share this folder** button.

2. Click **Monitoring**.

3. Highlight **Network File Storage** in the project tree, and configure the username, password, and workgroup (or domain) for the network file share, and then browse to its network location.

![Image](image-url)

This information varies between types. Contact your System Administrator or Control4 Technical Support if you need help with this information.

4. Click **Media**.

5. In Network File Storage, notice the options: Audio Media and Video Media.
6. To add or scan audio files, in the media list select **Audio Media**, and then click **New** or **Scan**.

Notes:

- When adding music to Network File Storage from the desktop, the music folder must reside in My Network Places so components can access the music files. A mapped network drive is not applicable in this situation.

- Audio files must be in one of the following formats to be scanned and played by the Control4 system: MP3, WMA, or FLAC. If you connect an iPod or another audio device, the Control4 system can play back the files supported on that device; but only MP3 files can be decoded.

7. To scan video files, in the media list select **Video Media**, and then click **Scan**.

Notes:

- Video files must be in one of the following formats to be scanned by the Control4 system: .avi, DVD, .iso, .m4a, mpeg, .mpg, or .wmv. These video files can only be played using a media player.

- Video playback is not supported from files stored on a USB drive, so the Video Media option is not displayed in the list under a USB drive.
Creating a playlist

Use Composer HE to create a playlist from digital media. You can create playlists from the touch screens, Control4 apps, or on-screen Navigators also. See the Control4 System User Guide for details.

To create a playlist:
1. Start Composer HE and connect to a Director.
2. Click Media.
3. In the Media view, go to the Media menu, and select New Playlist.
4. Name the playlist.
   Tip: You can rename it any time by right-clicking the playlist, selecting Rename Playlist, and then typing a new name.
5. Select the controller or other media on which the songs are stored, and ensure that you have scanned the media from the storage to make the media known to the controller.
6. Drag the list of songs to the playlist.
7. Drag every album or song you want to add to the playlist onto the playlist name.
8. After adding at least one album or song, select the playlist to view the contents.
9. (Optional) Remove songs:
   - To remove a song, right-click and select Delete.
   - To remove multiple songs, press and hold the Shift key. Select the songs, right-click anywhere in the selected list, and select Delete.
   - To remove selected songs, press and hold the Ctrl key. Select the songs to delete, and select Delete.
The playlist can now be played from or edited in the Navigators.
Testing the media connection

To test control of media through the Control4 Navigators (System Remote Control, on-screen Navigator, or any of the other Navigators or touch screens), use the steps outlined in the Control4 System User Guide.

Suggested test items:

- Play an album
- Add an album or track to the Now Playing queue
- Play a playlist created in Composer HE
- Create a playlist on a touch screen or on-screen Navigator
- Play multiple streams of music (play different music in different rooms)
- Play a movie on the television
Editing media information

Use the Media view to edit the media information for 'unknown' DVDs or CDs. You can edit the media information in the Navigators: on-screen, touch screen, or Control4 app.

Editing CD information

Use the Media view to edit CD album names, artists, genre, or cover art for a Control4 system.

To edit information about a CD:
1. Start Composer Pro and connect to a Director.
2. Click Media.
3. In the project tree, double-click the CD storage device on which you want to edit CD information; for example, CD, disc changer, or controller.
4. Select an album and click the Edit button, or double-click the album title.
5. In the Album tab, edit the Album Name, Artist, Label, Genre, or Art. Make text changes as applicable.
6. Click OK, or use the additional features outlined below.
7. Search on a Name or Artist to search the database for similar entries.

8. Select a search result. Double-click to select an album title, and click Next.

9. View or edit the information about the album: Name, Artist/Composer, Label, Genre, Year, Art, and Notes.

10. Change the information as needed, and then click Finished to save your changes.
11. Select the **Track** tab, and edit or remove tracks as needed.
12. Select the **Notes** tab, and edit as needed for future reference.

**Editing DVD information**

Use the Media view to edit DVD title, director, studio, genre, runtime, release date or rating in a Control4 system.

**Tip:** New in OS 2.0 and later, you can edit DVD and video titles on the touch screens and on-screen Navigators.

To edit information about a DVD:
1. Start Composer HE and connect to a Director.
2. Click Media.
3. In the project tree, double-click the Disc Changer or DVD.
4. Select a movie and click the Edit button, or double-click under Discs.
5. In the Movie dialog under the Movie tab, edit the DVD title, director, studio, genre, runtime, release date or rating information as needed.
6. Click OK, or use the additional features outlined below.

7. Click Search to present similar entries.

8. In the results list, double-click a DVD.

9. Edit the DVD information.

10. Replace the cover art using one of the options provided.

11. Click the Cast and Synopsis tab to edit text displays as needed.

12. Click Finished to save your changes.
Using and Programming with Agents

Use the Agents and Programming views to program agents.

When you program with agents, you typically use these general steps:

1. In Agents, define an instance of a type of agent.
2. In Programming, use the instance of the agent to program event actions.

Example: In the Agent view, you can create an instance of a Custom Button where you identify all the buttons you want to program. In Programming, you program the Custom Buttons.

Note: Agents vary greatly in functionality and flexibility.

Agent types

- **Access**—Lets you hide elements of the user interface on a Navigator and use a pin code to change the settings for the Navigator.
- **Advanced Lighting Scenes**—Lets you change the lighting state, toggle lights, ramp/fade lights, delay on/off, use scene sequencing, flash lights, and so on.
- **Announcements**—Plays a pre-recorded .WAV file, or displays a text message whenever a given event occurs. You can play an audio announcement on any audio output device with a supporting text message that displays on selected Navigators.
- **Backup**—Configure settings for automatic project backups to Control4 online services. Requires a 4Sight subscription.
- **Communication**—Replaces the Intercom agent for systems running OS 2.7 and above. Provides the ability to set up Intercom device groups on the T3 series touch screens—audio and video, and Door Stations (DS2 and DS2 Mini—audio and video) See “Using the Communication agent”.
- **Custom Buttons**—Lets you make user interface buttons for specialized devices on the Navigators. See “Using the Custom Buttons agent.”
- **Email Notification**—Lets you send an email message to your email address when specified events occur as defined in programming. See “Using the Email Notification agent.”

Notes: (1) 4Sight is required to use the Email Notification and Push Notification agents. (2) Avoid setting up email notifications for events that occur frequently (e.g., when a Motion Sensor detects motion). If the email notification trigger event occurs too often, it will cause the system to become sluggish.

- **Guest Services**—An agent used to interface a local Control4 system to a Guest Services system within a multi-dwelling or hospitality project.
- **History**—Enables a history tab in drivers built for the History agent, for example, new security drivers built for OS 2.8+. You can configure settings and view history data from the agent.
- **Identity**—Provides the ability to change the password for When >> Then automation.
**Light Properties**—Manage light properties for Control4 Centralized Lighting modules and loads.

- **Macros**—Macros agents associate programming with events.
  
  Example: You can create one macro to use in several different programming events or to use on a touch screen when creating Favorites. See “Using the Macros agent.”

- **Media Scenes**—Creates a media scene that plays music in selected rooms on your system. See “Using the Media Scenes agent.”

- **Navigation**—Add this agent to the system to enable navigation commands in the Programming view for T3 and EA On-Screen Navigators.

- **Push Notification**—Lets you define a push notification to be sent to your mobile devices as defined in programming.

- **Scheduler**—Defines conditionals of time to the system, and adds the ability to have scheduled events. See “Using the Scheduler agent.”

- **Screen Saver**—Lets you set up a Screen Saver agent so you can create various Screen Savers. See “Using the Screen Saver agent.”

- **SNMP Configuration**—Lets you set up and configure devices to monitor via SNMP. Requires knowledge of SNMP and network management. See Example: Program using the SNMP Configuration agent.

- **Timer**—Starts, stops, or repeats a timer based on a given event and action.

  Example: If a Motion Sensor in the system turns on a light when it detects motion, you can use a timer to turn off the light after 15 minutes. Alternatively, you can set a timer to repeat an action whenever the timer expires. See “Using the Timer agent.”

- **UI Configuration**—Upload custom wallpaper images and apply wallpapers from both the default set of images and custom images to multiple touch screens and on-screen navigators at once. Supported on T3 touch screens and EA controllers in OS 2.9.0. See “Using the UI Configuration agent”.

- **Variables**—Create Boolean, string, and number variables. Review “Examples: programming with variables” for information about creating Variable agents.

- **Wakeup**—Initiates a pre-specified wakeup time in the Navigators. This agent lets you play music, turn on lights, and change temperatures. See “Using the Wake/Sleep agent.”

- **Wakeup/Goodnight**—Updated version of the Wakeup agent adding the ability to control shades with a Wakeup scene.

The agent examples listed in the following sections will guide you through the programming steps for each agent type.

**Using the Announcements agent**

Use the Agents and Programming views to program this agent.

You can create announcements that:

- Display a text-message or Web page on any of the Navigators (on-screen Navigator or touch screens)
- Play an audio announcement through any audio end point or T3 touch screen
• Combine the two mentioned above

Note: The Control4 system allows up to 10 MB of files for the Announcement agent, and plays a maximum of 15 seconds per announcement. The Announcements agent supports the same audio playback file types as the EA and HC controllers support under My Music.

Example: This example demonstrates how to create a 'Dinner is Ready' announcement that is activated when the family chef (or dad) presses a custom-programmed button. When the button is pressed, the text message, 'Come to Dinner!', displays on all of the Navigators in the home, and an audio file of a dinner bell ringing plays.

Prerequisites
The following devices are added and identified (with a network address) in the project:

• Controller
  • Audio output device (television or connected speakers)
  • Navigator with a screen (touch screen or television)
  • Any device involved in the triggering event (doorbell contact, keypad, etc.)

To set up an Announcements agent:

1. Start Composer HE and connect to a Director.
2. Click Agents.
3. (First time only) Click Add to add the Announcements agent to the project.
4. Select Announcements, and then click OK to add Announcements to the agent types list in the project. The next time you want to create an announcement, just select the Announcements item in the Agents pane and click New.
5. With Announcements selected in the left pane, click New.
6. Name the new announcement, and click Create. Example: Come to Dinner!
7. Set up the Navigator text message you want to display.
1. Check the Display Navigator Text/Image Popup box.
2. Click **Edit Text/Image**.
3. Type a text message, a URL, or browse to an image (JPG, GIF, or PNG) to display.

   The text box accepts any HTML code. While certain links and scripts won’t be handled, when the announcement is triggered, for example, if you put this text in an announcement, it will show up just as if it were a web page. For example, the following HTML text will display the latest snapshot of a web page:

   ```html
   <html><body><img src="http://tbn0.google.com/images?q=tbn:1uOhCnlc3zbQgM:http://www.inkycircus.com/jargon/images/mountain.jpg" alt="pumpkin"><a href="http://www.w3schools.com/">Visit W3Schools!</a></body></html>
   ```

   Note: A static image file (JPG, GIF, or PNG) only has to be added to your project once because it is copied to the controller. When added, it is available in the Text Message drop-down menu for use in any additional announcements created.

4. Select the **time** you want the text message to display using the **Close after** drop-down menu (supported display times are from five seconds to 10 minutes).
5. Click **Add/Remove** and check the Navigators that will display the message. Click **OK**.

8. **Audio file**—Add an audio file, and set up the audio file to be played.

   1. Check the **Play Audio File** box.
   2. (One time per audio file) Click **Add** and browse to the audio file to add it to the drop-down menu.

   Note: An audio file only has to be added to your project one time because it is copied to the controller. When added, it is available in the Audio File drop-down menu for use in any additional announcements created.

   3. Select the audio file from the drop-down menu.
   4. Click **Add/Remove**, and check the **rooms** where the audio file will play. Click **OK**.
5. Click Add/Remove and check the T3 touch screens where the audio file will play. Click OK.

6. Set the volume of the audio play for each room and touch screen.

   Note: The volume for an announcement only can be set on devices with discrete volume control.

9. Click Programming.

10. Verify that the new Announcements agent displays in the Actions list (bottom of list).

11. Program the announcement to play or display with a triggering event.

   Example: Program a button-press event (left pane) to trigger the Announcements agent to run 'Come to Dinner!' (right pane).

Using the Communication agent

The Communication agent lets you configure the 5" or 7" In-Wall Touch Screens (supports audio intercom only), the 7" Portable Touch Screen with Camera, the Door Station, the 7" In-Wall Touch Screen with Camera, or the 7" In-wall, 10" In-Wall, and 7" Tabletop T3 Touch Screens (supports audio and video intercom) so that the Control4 system acknowledges the Intercom system and can communicate with it.

The Control4 Intercom app requires that the Communication agent is added into the system.

Note: The Control4 Intercom app is currently in a beta testing state.

Important: See Communication Agent Wizard and Migration Process on the Knowledgebase before using this agent to see if additional steps are required to add and use the Communication agent.
Note: This agent also lets you configure the intercom to allow third-party devices (External Devices) for multi-dwelling units (MDUs). This functionality requires additional training and hardware not covered in this document.

With the Communication agent, you can send calls to multiple touch screens, monitor a room, and other controls.

Examples:

- If you have an elderly parent living in their own home, you can create a macro and assign it to a keypad button. If your family member is in stress, they simply press the keypad button to notify you that something is wrong.
- Create a “Good Night” setting where all touch screens in the house can be set to “Do Not Disturb” when it’s time to go to sleep.
- Monitor your kids’ rooms after they’ve gone to bed to ensure that they’re going to sleep when they should.
- Receive calls from the door station to your Control4 Intercom app.
- Call from the Control4 Intercom app to the touch screen to speak to your kids at home.

Notes: (1) Broadcasting does not work in a room that’s being monitored if that room is in Monitor Mode. When in Monitor Mode, you will not want the person in that room to be disturbed, for example, a sleeping child. (2) Before you use Intercom with touch screens connected over Wi-Fi, make sure your Wi-Fi router is set to allow multicasting. Some routers do not allow multicasting.

Prerequisites

- Controller
- 7” In-Wall Touch Screens
- Communication agent (see below)

Note: Use of the Control4 Intercom app requires an active 4Sight license.

To set up the Communication agent:

1. Click the Agents view.
2. In the Agents pane, select Communication. If the Communication has not been added already, click Add, highlight Communication in the list, and click OK.
Add new Intercom group

An Intercom group is a set of Intercom-supported touch screens identified by a specific group name. This saves time when you want to send a call to a group of people.

To add an Intercom group:

2. Name the Intercom group, and click Add. Example: “John’s Group.”
3. Add the devices to the new group (see “Local Devices Tab” below).

Local Devices tab

Group properties:

You can add devices to an existing group of 5" or 7" In-Wall Touch Screens, 7" In-Wall Touch Screen with Camera, 7" Portable Touch Screen with Camera, Door Station, or 7" In-Wall, 10" In-Wall, and 7" Tabletop T3 Touch Screens. This lets the caller from one touch screen send out a call to the group of devices.

To add or remove devices in a group:

- Add: Select the device in the Local Devices tab, and then click Add. Click OK.
- Remove: Select the device in the right box of the Local Devices tab, and then click Remove. Click OK.

Device Properties:

To change device properties for the touch screens in the Intercom Group:

1. Use the Local Devices tab to change the settings for all supported touch screens in the Intercom Group.
   - Manual Answer Timeout (seconds)—Use the up or down arrow keys or enter how much time is allowed to answer an incoming call.
• You can set the intercom device order by selecting the device and clicking the **Move Down** or **Move Up** buttons.

2. Click **Apply Changes** when you're finished.

*External Devices tab*

The External Devices tab can be used to add external devices that can communicate with the intercom system, for example in an MDU solution. Mobile devices using the Control4 Intercom app also show up as an external device. The Control4 Intercom app is still in a beta state. This functionality requires additional training and hardware not covered in this document.

*Using the Custom Buttons agent*

Use the Control4 Composer Pro Custom Buttons agent to create up to four custom menus to display on the Navigators (including touch screens, Control4 apps, and on-screen). Custom Buttons Menus can be accessed from the Room Menu in Navigators or added as a favorite to the Room Screen.

Example: If you have a heated driveway or some other specialty device, you can set up a screen with custom buttons to operate the heated driveway from the Navigators.

![Custom Buttons image]

**To set up the Custom Buttons agent:**

1. Start Composer Pro and connect to a Director.
2. Click **Agents**.

3. (First time only) Click **Add** to add the Timer agent to the project.

   Custom button menus can be defined for a single room or for all the rooms in the project.

   **To set up a Custom Buttons menu for a single room:**
   1. Select the **room** in the **Rooms** pane on the left side of Composer.
   2. Click **Add...**, and enter the **Menu Name** and **Button 1-6** names as desired.
   3. Click **OK**.

   **To set up a Custom Buttons menu for all rooms:**
   1. Select **All Rooms** in the **Rooms** pane on the left side of Composer.
   2. Click **Add...**, and enter the **Menu Name** and **Button 1-6** names as desired.
   3. Click **OK**.

   **Guidelines**
   - You can access each screen on the Navigators from the Control4 main menu or for a room from four available tabs. Example: The heated driveway screen is accessed from a custom tab on the main menu. You can configure the tab to be viewed system-wide on all screens, or to view in one room only.
   - The Navigators allow up to four tabs per room to access custom screens with custom buttons. Each screen can provide up to six custom buttons for a total of 24 custom buttons. The four tabs in each room can be allocated as either room or as global tabs.
   - On the Navigators, you can set up a room or global tabs. The example shows the creation of custom tabs that appear in the Front Room and access a custom screen.

   **Note:** If you want to create a Custom tab to appear globally, check the Global box next to the Screen Name. Because only four screens are available for each room, if a Global button is added and another room already has four screens, the Global button replaces the first screen in that room.
Prerequisites
The following devices are added and identified (with a network address) in the project:

- Controller
- Electronic Gate (In the Control & Audio Video Connections tab, ensure that the Electronic Gate is connected to controller relay Port 4.)

To set up a Custom Buttons agent:
1. Start Composer HE and connect to a Director.
2. Click Agents.
3. (First time only) Click Add to add the Custom Buttons agent to the project.
4. When the dialog appears, from the list, select Custom Buttons.
5. Click OK.
6. Select the Custom Buttons agent.
7. From the list that appears in the left pane, select the room for the custom button; for example, select Family.

8. When the Custom Buttons interface appears, in the Screen 1 area, click Add. Note: In the Navigator, Screen 1 appears in the top left corner; Screen 2 appears in the lower left corner, Screen 3 appears in the top right corner, and Screen 4 appears in the lower right corner.
9. Enter the name of the buttons to appear on the Navigator screen.
10. Enter the relevant information for the device.

   The Screen Name is the name that appears on the access tab to enter the custom screen. The buttons are the names that appear on the custom buttons.

   Example: For the Garage Door, enter the following:
• Screen Name: **Garage Door**

• Button 1: **Toggle**

11. Click OK.

12. Click the **Programming** view to program your Custom Buttons.

13. In the Device Events pane, scroll down to the agents and select the **Custom Buttons** agent.

14. In the Custom Buttons Events pane, ensure that **Family-Garage Door** is selected under the Event Screen next to Toggle, and then select the **Press** radio button. When custom button ‘Toggle’ on screen ‘Garage Door’ in Family is pressed, it appears at the top of the Script pane.

15. In the Actions pane, select **Garage Door**.

16. From the Command tab, select the **Toggle the Garage Door** radio button. The action command appears in the Actions pane.

17. Drag the **green arrow** to the Script pane.

18. Select **File > Refresh Navigators**.
Using the Email Notification agent

IMPORTANT! An active 4Sight Internet Service subscription is required for Email Notification to work. See Composer HE Getting Started or the Control4 System User Guide.

Use the Control4 Composer HE Email Notification agent to have an email sent to an email address automatically when specific events occur as defined in programming.

Example: If you want to know when the basement door opens, you can set up an Email Notification agent to send an email to your email application's Inbox when the Basement door opens.

- The Email Notification is a Control4 service. To use Email Notification agent, remote access is required to facilitate a secure connection between the controller and the Control4 service.
- The Email Notification agent uses templates to enhance usability. You can use a template to define a To, Subject, or Body for use when creating instances of the Email Notification agent. See "Connecting to a Director using Remote Access" in Composer HE Getting Started.
- Use the Programming view to define the individual instance that triggers an email and completes the definition.

Example: A security threat to the house notified you of broken windows, doors opening, and motion detected in Away mode. In the template, you define Subject: Security Alert and To: fsmith@myemail.com. In the Programming view, you might define the zone. Examples of other incidents to use E-mail Notification include: Basement Door Opened, Front Gate Opened, Water Sensor detection, Carbon Monoxide Sensor detection, Motion Sensor detection, Sprinklers On/Off, etc.

Tip: When setting up an E-mail Notification agent, note the frequency that an event can happen; because if it is too frequent, it can slow down the system. For example, if an email is sent when a Motion Sensor detects motion, the frequent email messages could cause sluggishness.

Prerequisites
The following example devices are added and identified (with a network address) in the project:

- Controller
- Door Contact Sensor

To set up an Email Notification:

1. Start Composer HE and connect to a Director.
2. Click Agents.
3. (First time only) In the Agents view, click Add to add the Email Notification agent to the project.
4. When the dialog appears, select **Email Notification**.

5. Click **OK**.

6. Select **Email Notification**, and click **Add** in the pane that follows. The New Template Name dialog appears.

Tip: Control4 now includes Control4 system and user-defined variables in the templates created using this agent. To use this function, you can create or modify email templates using Composer HE > Agents > E-Mail Notification, and then use the **Add Variable** option.

7. Enter a name on the dialog that appears, for example, "Security Alert."

8. Click **Create**.

9. In Email Notification Template Name, select **Security Alert** for the Composer HE email screen to appear.

10. Fill out the information for the email you want sent to you when an event occurs.

Example:

   ```
   To: fsmith@myemail.com
   Subject: Security Alert
   Body: The security of the Franklin Smith House may have been compromised.
   ```

11. Do the following as needed:

    1. Click **Send Email** to test and see if you receive and email to your email address.

    2. Click **Add Variable** if you’ve created a variable agent. Scroll down the list to locate the variable, and then click **OK**.

    3. Click **Save** to exit and go to the Programming view to set up the programming.

    4. Click **Reset** to clear the To, Subject, and Body of the email to start again.

12. With the Agent template created, you can create one instance of the Security Alert for each security zone (or object). When you’ve saved the template, click **Programming**.

13. In Programming under Theater, select **Door Contact Sensor**.

14. In Door Contact Sensor Events, select **When Door Contact Sensor opens**.
15. In the Actions pane, scroll down and select **Email Notification**.
16. Make any changes to the email as necessary.
17. Drag the **green arrow** to the **Script** pane.
18. In the File menu, click **Refresh**.
19. Test the Email Notification agent by going to the door and opening it. An email is sent to your Inbox with the Security Alert as a subject.

**Using the Light Properties agent**

Use the **Agents and Monitoring** views to add and configure dimmable, non-dimmable, and 0-10V lights for Panelized Lighting devices.

Use this agent to make it easy to set up load and wattage information in the Panelized Lighting Properties pages for a project.

**To use the Light Properties agent:**

1. Start Composer HE and connect to a Director.
2. Click **Agents**.
3. (First time only) Click **Add** to add the Light Properties agent to the project.
4. Select **Light Properties**, and then click **OK**.

   In the Light Properties pane, change the columns for each light in the Panelized Lighting system.

Note: Ensure that the Panelized Lighting module is added and identified to the system. After you do, the name of the device will display in this agent’s Light Properties pane. See the Panelized Lighting Quick Start Guide for details.

These options are editable.

- **Name**—The name of the module you identified in the system.
- **Load Number**—Assign a load number for each module in the system.
- **Watts**—Assign the wattage for each module in the system.

**Using the Macros agent**

Use the **Agents and Programming** views to program this agent. Macros agents are routines that associate programming with events.

Examples: You can create and name a macro to use in several different programming events.

The macro can be called from a particular program in the **Programming Actions** pane or you can create a custom button on your touch screens or on-screen Navigator to call a Macro.

You can create Macros:

- To use in various programmed events
- To use in Custom pages
- To use from custom buttons in the Navigators

**Prerequisites**

The following devices are added and identified (with a network address) in the project:
• Controller
• Light Switch
• Navigator with a screen (touch screen, Control4 app, TV screen, etc.)
• Any device involved in the triggering event (doorbell contact, keypad, etc.)

To set up the Macros agent:
1. Start Composer HE and connect to a Director.
2. Click Agents.
3. (First time only) Click Add to add the Macros agent to the project.
4. Select Macros, and then click OK.

To create a new Macro:
1. Select Macros in the Agents pane, and click New.
2. Name the new macro, for example, Bob, and then click Create.

To add commands to the macro's programming script:
In this example script, you will select the Family Room Switch which is on, and then turn off everything in the Living Room.
1. Click the Programming view.
2. In the Device Events pane, scroll down to Macros and select Bob. "When Screen Saver On is executed" appears in the Script pane.
3. In the Device Actions pane, select Family Room and the Wall Lights.
4. Under Light, select On.
5. Drag the green arrow 'Turn on the Family > Wall Lights' to the Script pane.
7. Drag the green arrow 'Turn off the Family > Wall Lights' to the Script pane.
8. You can add the Macros agent to many programs that you create if you want to perform similar tasks, or you can program the agent for a specific device. For example, you can assign this agent to a button on a keypad to run the program when executed.

Note: A unique Macro cannot be edited or copied; only created or deleted. If you want to create a new Macro based on another one, you must create a new one.

Using the Media Scenes agent

Use the Media Scenes agent to allow simpler multi-zone audio control. Media Scenes link source, volume, and room-off commands. With Media Scenes, you can configure one or more rooms in a system to play the same music at the same volume.

Example: A Media Scene for the entire house can include all the rooms in the Control4 system. Another Media Scene can include only the Master Bedroom and Bath. You can create any number of Media Scenes containing any number of rooms.

Guidelines

- To successfully activate a Media Scene (with the rooms being controlled simultaneously), activate the Media Scenes agent before starting any music playback.
- Media scenes are persistent; when activated, a Media Scene remains active until deactivated or until the controller is powered down. If a Media Scene is deactivated while music is playing, the music continues to play in the associated rooms, but the rooms are no longer controlled in unison. Therefore, music can be stopped in one room while it continues to play in another room.
- You can set up a Media Scene one time, and activate it when desired. Then play the music.

To create a Media Scenes agent:

1. Start Composer HE and connect to a Director.
2. (First time only) In the Agents view, click Add to add the Media Scenes agent to the project.
3. On the dialog that appears, click Media Scenes, and then click OK.
4. In the Agents pane, select Media Scenes, and click Add.
5. Enter a name for your new Media Scene. Example: Party Music.
6. In the *Agents* pane, select **Party Music**, and then click **Add Room** in the Media Scenes pane.

7. In the dialog box is a list of rooms in your system. Check the **rooms** where you want to play your **Party Music**, and then click **OK**. Example: **Theater** and **Family**.

Tips: To remove a room from a scene, click **Remove Room**. To create another Media Scene, return to Step 1.

Tip: You can add all rooms on a floor by clicking, for example, **Main**. This automatically selects all other rooms in that category. You can also include all rooms in your entire system in the Media Scene by clicking **House**.
The rooms you selected appear in the new Media scene 'Party Music.'

8. To activate the scene, click **Activate Scene** at the top of the screen.
9. To deactivate, click the **Deactivate Scene** button.
10. You can program a button for your Media Scene. Do this by creating a new Custom Button.
    1. In the Agents view, click **Custom Buttons**, and then below, click a **room**. In the Custom Buttons pane, click **Add**.
    2. In the **Add Screen** dialog that appears, enter the name of the Custom Button, and then click **OK**.
       Example: Click **Theater** and call the Screen name **Media Scene**. Name Button 1: **On/Off** and click **OK**.
       The custom button name appears in the pane.
11. Click the Programming View.
12. In the Device Events pane, scroll down and click **Custom Buttons**. In the pane below, Custom Button Events, select the screen you want to program, and then select the **Press** radio button.
       Example: Select the screen **Kitchen - Media Scene**, and select the **Press** radio button.
13. In the Actions pane, select **Kitchen**.
14. In the **Kitchen Actions** pane under Conditionals, press the **Media Scene Active** button which also selects True.
15. Drag the blue question mark to the **Script** pane.
16. In the Actions pane, scroll down and select **Media Scenes**.
17. In the **Media Scenes Actions** pane under Commands, press the **Deactivate** button, and then select **Party Music**.
18. Drag the **green arrow** on top of the blue question mark in the **Script** pane.
19. In the Actions pane, scroll up and select **Kitchen**. In the Kitchen Actions pane and in Conditionals, press the **Media Scene Active** button, and then the **False** button.
20. Drag the **blue question** mark to the **Script** pane.
21. In the Actions pane, scroll down and select **Media Scenes**. In the Media Scenes Actions pane and in Commands, press the **Activate** button, and then select **Party Music**.
22. Drag the **green arrow** icon on top of the blue question mark in the **Script** pane.
The Script pane now reads, "When custom button 'On/Off' on screen 'Media Scene' in Kitchen is pressed...Activate scene 'Party Music.'

23. To execute the scene, click **Execute**.

Using the Color agent
The Control4 Color agent enables the creation and editing of color and tunable white lighting presets. Presets allow for quick selection of a specific color (chromaticity) or tunable white (CCT) on bulbs and lighting strips that support color and/or tunable white. Presets only contain information about the color or CCT value. Brightness is not included with the preset definition. Brightness does affect the perceived color. Brightness can be set manually using the user interface and can also be set programatically using Advanced Lighting Scenes, Brightness Presets, and custom programming.

Minimum required OS version: OS 3.3.0

Quick Configuration
The Control4 Color agent is automatically added to any project installed on or updated to OS 3.3.0. You should not attempt to delete this agent. If you do, it will be added back into the project when the controller is restarted.

The Color agent includes a selection of default presets for various color selections and tunable white selections. Users may also create their own presets using the customer application. You may add system-wide presets as well. All presets can be edited and deleted. You can also change the order which will be used to display these preset selections. Note that individual lights may not be able to display all chromacity or CCT levels. The Color agent doesn't attempt to enforce this. But, when the Control4 user interface is used to set the color/temperature for the device, it will only show the available presets. In other words, the available presets will be limited based on the device's defined capabilities.
Preset

There are three categories of presets:

**Default**—These are the default presets provided on initial installation of the Color agent.

**Dealer**—These are the presets created by the Control4 Installer using the Color agent.

**Customer**—These are the presets created by the user through the Control4 application.

Add Preset

**Name**—Name each Preset. Names must be unique.

**Category**—The category field is read-only. All presets created by the Installer are in the Dealer category.

**Preset Type**—Color presets are defined by chromaticity and stored either using xy values or hue & saturation values. Color Temperature presets are defined by a color correlated temperature (CCT) value in Kelvins.

**Definition**—You may use the color wheel or the entry fields to specify the desired color/temperature.

**Hue and Saturation**—Chromaticity is specified using hue (0-359 degrees) and saturation (1-100%).

**xy Chromaticity**—Chromaticity is specified using the xy scale. This gives you the broadest selection of colors.

**RGB**—Color may be specified as an RGB value. The RGB specification combines both chromaticity and brightness. When you provide RGB values, Control4 will convert the chromaticity to xy.

**Test Light**—You may select one or more lights. The selected light(s) will follow the color / temperature selections so that you can visually verify the color while you are creating or editing the preset.
Edit Preset

Preset Order
You can easily change the order of the presets by dragging a preset higher or lower on the preset list.

Import/Export Presets
Exporting the preset list allows you to save the preset definition to an xml data file. This can be very helpful for restoring the presets to a known good configuration. As with other areas of Composer Pro, the Color agent doesn't have an 'Undo' function. If you make changes, and aren't happy with them, you will save a lot of time by restoring a known good configuration. If a preset with the same name is imported, it will overwrite the preset in the project. Exporting and Importing presets can also be helpful if you want to provide a standard base set of presets in all of your customer installations.

Advanced Properties

**Log Settings**

**Log Level**—This property allows to filter which message types display in the Lua Output window. Options 0 — 5 correspond to Fatal through Trace levels, increasing in level of verbosity.

**Log Mode**—Activates logging of diagnostic information. The log level is set in the above property. Options include Off, Print (to the window), Log (to the Director Log), and Print and Log (both). Default is Off.

**General Information**

**Device ID**—Displays agent device ID.

**Agent Version**—Displays current agent/driver version.
**OS Version Status**—Displays whether current OS version fulfills min requirements for Color agent.

**Actions**
This section lists and defines the Actions that the agent provides and are available through ComposerPro. These Actions are primarily for advanced troubleshooting. You should not need to use them for normal configuration.

**List Presets**—Prints all defined color presets in table format to the Lua output window.

**Add Preset HS**—Adds color preset in the HS color format. Parameters are:
- **NAME**—Preset name (mandatory field)
- **CATEGORY**—Preset category differentiated by who created the preset.
- **HUE**—Hue component of HSV/HSB/HSL color space (range [0.0, 360.0])
- **SATURATION**—Saturation component of HSV/HSB/HSL color space (range [0.0, 100.0])

**Add Preset XY**—Adds color preset in the xy color format. Parameters are:
- **NAME**—Preset name (mandatory field)
- **CATEGORY**—Preset category differentiated by who created the preset.
- **COLOR_X**—x component of xyY color space (range [0.0, 1.0])
- **COLOR_Y**—y component of xyY color space (range [0.0, 1.0])

**Add Preset RGB**—Adds color preset in the RGB color format. Parameters are:
- **NAME**—Preset name (mandatory field)
- **CATEGORY**—Preset category differentiated by who created the preset.
- **RGB**—RGB color information.

**Add Preset CCT**—Adds color correlated temperature preset. Parameters are:
- **NAME**—Preset name (mandatory field)
- **CATEGORY**—Preset category differentiated by who created the preset.
- **COLOR_TEMPERATURE**—Color temperature in Kelvins (range [1000.0, 20000.0])

**Edit Preset Name**—Changes name of the preset with the given ID. Parameters are:
- **ID**—ID of the preset that is being modified.
- **NAME**—New preset name.
- **CATEGORY**—Category from which the preset is being edited.

**Edit Preset HS**—Changes HS color information of the preset with the given ID. Parameters are:
- **ID**—ID of the preset that is being modified.
- **HUE**—Hue component of HSV/HSB/HSL color space (range [0.0, 360.0]).
**SATURATION** — Saturation component of HSV/HSB/HSL color space (range [0.0, 100.0]).

**CATEGORY** — Category from which the preset is being edited.

**Edit Preset XY** — Changes xyY color information of the preset with the given ID. Parameters are:
- **ID** — ID of the preset that is being modified.
- **COLOR_X** — x component of xyY color space (range [0.0, 1.0])
- **COLOR_Y** — y component of xyY color space (range [0.0, 1.0])

**CATEGORY** — Category from which the preset is being edited.

**Edit Preset HS** — Changes RGB color information of the preset with the given ID. Parameters are:
- **ID** — ID of the preset that is being modified.
- **RGB** — RGB color information.

**CATEGORY** — Category from which the preset is being edited.

**Edit Preset CCT** — Changes color correlated temperature of the preset with the given ID. Parameters are:
- **ID** — ID of the preset that is being modified.
- **COLOR_TEMPERATURE** — Color temperature in Kelvins (range [1000.0, 20000.0])

**CATEGORY** — Category from which the preset is being edited.

**Delete Preset** — Deletes preset with the given ID. Parameters are:
- **ID** — ID of the preset that is being deleted.

**CATEGORY** — Category from which the preset is being deleted.

**Reorder Presets by IDs** — Changes the order in which presets are displayed. Provided argument is a comma-separated list of IDs which represents their new order. If the list is partial, only mentioned presets will change their positions, while the other presets will retain their current positions.

- **IDS** — Comma-separated list of preset IDs that represent their new order relative to each other.

**Reorder Presets by Names** — Changes the order in which presets are displayed. Provided argument is a comma-separated list of preset names which represents their new order. If the list is partial, only mentioned presets will change their positions, while the other presets will retain their current positions.

- **NAMES** — Comma-separated list of preset names that represent their new order relative to each other.

**Using the Media Sessions agent**

Use the Media Sessions agent to view and have limited control over active audio sessions in the project. Media Sessions agent cannot be used to provide any programming assistance, but can be use to control volume and mute settings for active zones.
Example: A media session was creating using the Control4 app. You can use the Media Session agent to control volume and mute in any of the rooms in the media session.

Configuring the Master Volume Slider

The Media Sessions agent can help avoid potentially damaging high volume levels when using the Master Volume Slider in the Sessions page of the user interfaces by configuring an upper threshold for the Master Volume Slider. Volume won't ramp above the upper threshold until all rooms are at the threshold to avoid a single room ramping above the level when the Master Volume Slider in a user interface.

In the Properties tab of the Media Sessions agent, use the arrows or enter a volume for the Session Master Volume Slider upper threshold.

Using the MultiDisplay Manager agent

Use the MultiDisplay Manager agent to control multiple displays in a commercial, retail, hospitality, or residential project. You can control multiple displays and audio sources from a single interface, a Control4 touchscreen or Control4 app on Android or iPad.
To set up a video wall to be controlled by the MultiDisplay Manager agent:

1. Add your televisions (displays) to the desired room in the project.

2. On the Connections tab after selecting the room where the TVs reside, make sure your video and audio bindings are done. You must have one of the TVs assigned as a Video Endpoint. The MultiDisplay Manager is setup by using the Video Endpoint and Additional Video Endpoint bindings. Connect your first TV to the Video Endpoint and your other TVs using the Additional Video Endpoints. The Additional Video Endpoint only shows up one at a time. As soon as the as you bind the first Additional Video Endpoint, the next one will appear. Due to a new one appearing, you will always have one unbound Additional Video Endpoint. Once the bindings are made you are ready to create a MultiDisplay Manager. If you do not have all your video and audio end points setup and configured there is no point moving on to the video wall agent until you do because these will be required during the setup.

3. Add the MultiDisplay Manager agent to the project within Composer. Go to Agents > Add and select the MultiDisplay Manager agent.
4. After the agent has been added, click on Add Wall and select the Audio Zone (room) where the video wall is to reside.

5. After the Audio Zone (room where the MultiDisplay Manager resides) has been selected, click on the button to finish the setup. Within the details of the configuration, you will need to provide a Wall Name, select an Audio Zone, and select a default Audio Source (optional).
6. Within the second section of the MultiDisplay Manager, you will need to choose the number of columns and rows for your video wall layout. The max size a video wall can be is 3 rows by 6 columns due to the size limit on the navigators. Once done press the **Get Started** button.

![Layout](image)

**Note:** When you press get started you will see the TVs in a layout. The up, down, left, right buttons are currently not functional and will be coming in a future release of the agent. These are not needed for testing of the MultiDisplay Manager and just allow for slight visual adjustments of the TVs on the screen.

7. After saving the layout section, the Sources and End-Points section will be populated with drop down sections for selecting video endpoints and their default sources. Set your **Video Endpoint**, **Default Source** and if desired, the **Default Channel** for each television. Press **Save** to retain the configuration.

![Sources And End-Points](image)
8. After your wall is configured you will need to make sure that it is visible. Go to the room level where this should be visible. Make sure you are on the **System Design** tab. On the **Properties** page go to the **Navigator** tab and select **MultiDisplay Manager** in the Submenu Filters section. If they are hidden, click on the modify button, select the wall you want to show and press the Show button to make them visible.

You should now have a MultiDisplay Manager icon within the Watch section on your touch screen. You can favorite that to the main screen if desired by doing a long press on the icon.

**Note:** The MultiDisplay Manager only works on tablets and touch screens. It will not work on mobile phones or remotes due to the amount of space needed to show everything on the screen.

**Using the Scheduler agent**

Use the Agents and Programming views to program this agent. The Scheduler agent lets you schedule time on the Control4 system to trigger specific events to occur. You can program a specific one-time event or multiple events to re-occur daily, weekly, monthly, yearly, etc.

**Example:** Schedule an event to play dad’s favorite song at 7:30 AM on his birthday.

**Prerequisites**
The following devices are added and identified (with a network address) in the project:

- Controller
- Keypad

**To set up the Scheduler agent:**

1. Start Composer HE and connect to a Director.
2. Click **Agents**.
3. (First time only) In the **Agents** pane, click **Add** to add the Scheduler agent to the project.
4. Select **Scheduler** in the Agents list, and click **OK**.
5. In the *Agents* pane, select **Scheduler**. The Scheduler panes appear.

![Scheduler pane](image)

6. In the **Scheduler** pane, click **Add**.

7. In the **New Event** dialog, enter the relevant information for this Scheduler instance:

1. In **Name:** type **Dads Birthday**.

2. In **Time,** add the following:
   - Select the **Time** radio button.
   - Highlight the hour: **07,** minutes: **30,** and **AM.** Use the drop-down menu to select each time separately, or
   - Select **Sunrise/Sunset,** and select **Sunrise** from the drop-down menu.

3. In Randomize time by +/−, keep the default of 15 minutes. This executes the Scheduler either 15 minutes before or 15 minutes after the actual time you assigned. This is useful when you go on vacation and you want your lights to go on at different times so outsiders think someone is home.

4. In **Start Date,** select one of the following:
   - Select the **Start** on radio button. Use the drop-down menu and select today’s date.
   - Select the **Start** on the radio button to select an exact day, month, and year. Use the drop-down menus to make your selections.

5. Select **Repeats.**
   - Select **Yearly.**

Example: You want dad's favorite song to play at 7:30 AM. This dialog lets you schedule one-time events and recurring events.
Select Stop on, and use the drop-down menu to select a month and year to stop this agent.

6. Click OK. The event is now added to the list of events.

7. To delete an event, select the event in the list, and click Delete.

8. Click Programming.

9. In the Device Events pane, select the Scheduler object at the bottom of the list.

10. In Scheduler Events, click Dads Birthday event. The Script pane shows Dads Birthday event.

11. Select the device actions to initiate in the Actions panes.

12. Drag the actions to the Script pane. These scripted actions execute when the Dad’s Birthday event executes.

13. You can use the Scheduler agent in programming also to add conditionals or loops to your scripts.


1. In the Actions pane, scroll down and select the Scheduler agent.

2. Click the Conditionals tab, select Time, and Within 5 minute(s) Before Sunset.

3. Drag the blue question mark to the Script pane.

4. In the project tree, select the light.

5. In the Commands tab, select turn the room on, and drag the green arrow on top of the blue question mark in the Script pane.

Results: When the top button on the 3-Button Keypad is pressed, if it is within five minutes before sunrise, the light comes on. The Scheduler agent lets you define one-time events and recurring events.

Using the Screen Saver agent

Use the Agents view to set up the Screen Saver agent.

Prerequisites

Ensure that the devices you will use to set up a screen saver and store your photos (for example, a network-attached storage device) are attached to the Control4 system are attached to the primary controller. If you use a USB device, ensure that it is formatted to FAT 32.

To set up the Screen Saver agent:

1. Start Composer HE and connect to a Director.

2. Click Agents.

3. (First time only) Click Add to add the Screen Saver agent to the project.

4. Select Screen Saver, and then click OK. The next time you want to create a Screen Saver, click the Screen Saver item in the Agents pane, and then click New.
5. From the drop-down menu, select the File Storage Location.

6. Click the Media view.

7. Click Screen Saver in the Media pane.

8. Click Add to scan and add new photos to the Screen Saver pane from the device you selected in the Network Storage Location box.

9. To set up a custom screen saver on the Navigators, see also:
   - “Setting up the photo screen saver”
   - “Setting up a custom screen saver”
   - Control4 System User Guide

Using the Timer agent

Use the Agents and Programming views to program this agent. The Timer agent lets you start, stop, or repeat a timer based on a given event and action.

Example: A Motion Sensor turns on a light when it detects motion; use a timer to turn off the light after 15 minutes. Alternatively, you can set a timer to repeat an action whenever the timer expires, such as a Bathroom fan that restarts each time the Bathroom light turns on.

Prerequisites

The following devices are added and identified (with a network address) in the project:

- Controller
- Any device involved in the triggering event (for example, a Motion Sensor)
To set up the Timer agent:

1. Start Composer HE and connect to a Director.
2. Click **Agents**.
   
   ![Timer agent configuration](image)

3. (First time only) Click **Add** to add the Timer agent to the project.
4. Select **Timer**, and then click **New**.
5. Type the name of the new timer (for example, Bathroom Fan), and click **Create**.
6. In Interval, use the drop-down menu to set the timer in **seconds**, **minutes**, or **hours** (hh:mm:ss), and click **OK**.
7. Click **Start** to start the timer.
8. Click **Programming**.
9. Select the **Timer Action** in the Actions pane, and ensure the new timer options display in the Commands tab (Start, Stop, Reset, and Change).
10. Start, Stop, Restart, Reset, Resume, or Change the timer as needed.

The following table outlines how the timer behaves depending on the state of the timer when a command...
is executed.

<table>
<thead>
<tr>
<th>Command executed is...</th>
<th>Timer is...</th>
<th>Then event(s) triggered</th>
<th>Effect on Timer</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Start</strong></td>
<td>Running</td>
<td>Reset</td>
<td>Restarts timer</td>
</tr>
<tr>
<td></td>
<td>Stopped</td>
<td>Start</td>
<td>Starts timer</td>
</tr>
<tr>
<td></td>
<td>Paused</td>
<td>Start</td>
<td>Restarts timer</td>
</tr>
<tr>
<td><strong>Stop</strong></td>
<td>Running</td>
<td>Stop</td>
<td>Stops timer</td>
</tr>
<tr>
<td></td>
<td>Stopped</td>
<td>none</td>
<td>none</td>
</tr>
<tr>
<td></td>
<td>Paused</td>
<td>Stop</td>
<td>Stops timer</td>
</tr>
<tr>
<td><strong>Restart</strong></td>
<td>Running</td>
<td>Stop, Reset, Start</td>
<td>Restarts timer</td>
</tr>
<tr>
<td></td>
<td>Stopped</td>
<td>Reset, Start</td>
<td>Restarts timer</td>
</tr>
<tr>
<td></td>
<td>Paused</td>
<td>Stop, Reset, Start</td>
<td>Restarts timer</td>
</tr>
<tr>
<td><strong>Reset</strong></td>
<td>Running</td>
<td>Reset</td>
<td>Restarts timer</td>
</tr>
<tr>
<td></td>
<td>Stopped</td>
<td>Reset, Start</td>
<td>Restarts timer</td>
</tr>
<tr>
<td></td>
<td>Paused</td>
<td>Reset</td>
<td>Reset timer value</td>
</tr>
<tr>
<td><strong>Pause</strong></td>
<td>Running</td>
<td>Pause</td>
<td>Pauses timer</td>
</tr>
<tr>
<td></td>
<td>Not running</td>
<td>none</td>
<td>none</td>
</tr>
<tr>
<td></td>
<td>Paused</td>
<td>none</td>
<td>none</td>
</tr>
<tr>
<td><strong>Resume</strong></td>
<td>Running</td>
<td>none</td>
<td>none</td>
</tr>
<tr>
<td></td>
<td>Stopped</td>
<td>none</td>
<td>none</td>
</tr>
<tr>
<td></td>
<td>Paused</td>
<td>Resume</td>
<td>Resumes timer</td>
</tr>
</tbody>
</table>
11. Program to connect the timer to an event and action, and choose to **Start**, **Restart**, or **Stop** the timer.

See the example programming screens that follow. Notice how the timer is first used as an action, and then as an event.

**Event screen:**

![Event screen image]

**Action screen:**

![Action screen image]
Using the UI Configuration agent

Use the UI Configuration agent to manage wallpaper settings and upload wallpapers, to manage screen saver settings for T3 touch screens and EA On-Screen Navigators, to configure the return to home setting for T3 touch screens and EA On-Screen Navigators, and to add favorites for all navigators in the project.

To configure wallpaper with the UI Configuration agent:

1. In the Agents view, select the UI Configuration agent, then click on the Wallpaper tab.
2. To configure the wallpaper in a single room, select the desired room in the Location pane.
3. Select from the default images listed, or click Add Dealer Image to add a custom image. Wallpaper images should be JPG files in a 16:9 format with a resolution of 1920 pixels wide by 1080 pixels high for best results. Images with different resolutions may be scaled or trimmed to fit and may produce undesirable results. Up to 10 dealer images can be added and configured to any room.

4. Click Apply to set the wallpaper to the room or click Apply To ... to select the rooms to be configured with the wallpaper.

The homeowner can also add a custom image (up to one for each room) using the Control4 app. For information on how to add images with the Control4 app, see the Control4 System User Guide (ctrl4.co/userguide). After a custom wallpaper image has been configured, you can use the UI Configuration agent to configure rooms to use the image.

1. To configure the custom wallpaper in a single room, select the desired room in the Location pane. Select the image from the images listed and click Apply to set the wallpaper to the room or click Apply To ... to select the rooms to be configured with the wallpaper.

2. To clear the custom wallpaper image, select the custom image and click Clear Customer Image. You can also choose to include or not include the Control4 logo on any wallpaper images. Click the box next to Include Control4 Logo to include the Control4 logo, and then continue the process of configuring a wallpaper image.

**To configure screen saver settings with the UI Configuration agent:**

1. In the Agents view, select the UI Configuration agent, then click on the Screen Saver tab.

2. Choose the screen saver mode. Available options include:
   - None
   - Blank
3. Depending on your chosen screen saver mode, configure any additional options that appear.

4. Configure the Begin After option. The value selected is the period of time the touch screen will wait after detecting inactivity until it turns on the screen saver.

5. Check the box next to Brightness Control to add a brightness control icon to the screen saver.

6. Check the box next to Animate Text to apply a small movement to the text to avoid screen burn-in.

7. Click Apply To … to select the navigators to be configured with the screen saver settings.

To configure return to home settings with the UI Configuration agent:

1. In the Agents view, select the UI Configuration agent, then click on the Screen Saver tab.

2. Configure when the Navigator will return to the home screen by choosing the time in the Return to Home After: menu.
To configure favorites with the UI Configuration agent:

1. In the Agents view, select the UI Configuration agent, then click on the Favorites tab.

2. To add favorites to all Room Screen, click the box next to the favorites you want to add in the Add Favorites pane.

3. Click Add, and then click OK to add the selected favorites to all applicable Room Screens.

To clear all configured favorites and reset to the default favorites, click Clear Favorites.

Using the Variables agent

Use the Agents view to set up the Variables agent. Ensure that the devices you want to use for variables are added and identified to the system.

These sections provide information about how to create the type of variable that you want to use in programming.

- "Example: Using room variables"
- "Example: Using a custom number variable in an agent"
- "Example: Using a custom string variable in an agent"
- "Example: Using custom Boolean variables in an agent"

Using the Wake/Sleep agent

Use the Agents view to program this agent. The Wake/Sleep agent lets you set wake times, sleep timers, lighting, music, and so on.
Note: Wake times set in Composer HE synchronize with the user interfaces. Likewise, wake times changed on the interfaces will synchronize with Composer.

Example: At a user-specified time, start playing music in the Master, open the blinds, and ramp the light on over two minutes.

Prerequisites
The following devices are added and identified (with a network address) in the project:

- Controller
- Digital Audio (ensure that you can play music in the project)
- Bedroom Dimmer
- Blinds

To configure the Wake/Sleep agent:
1. Start Composer HE and connect to a Director.
2. Click Monitoring.
3. Make sure the rooms and devices show in the List view.
4. Click Agents.
5. (First time only) Click Add... to add the agent to the project.
6. Select Wake/Sleep, and then click OK.
8. In the *Wake/Sleep Rooms* pane, click **Add...**.

9. Select the room to enable the Wake/Sleep scene in and click **OK**.

10. Configure the Wake/Sleep scene for the room:
• **Time**—Select the default Wake time by selecting the time in the *Wake Time* field. Select the default Sleep timer length by selecting it in the *Sleep Timer* field. These times can be adjusted by the user in the Wake and Sleep sections on a T3 touch screen or the Control4 app.

• **Lights**—Select if Lights are visible in the Wake and Sleep sections on a T3 touch screen or the Control4 app by selecting *Visible*. Select which lights to control with the Wake and Sleep scenes by clicking on *Light Selection* or click *All*. Configure how fast lights turn on with the Wake scene by entering the desired rate into the **Ramp Rate** field. Enable lights in the current Wake and Sleep scenes for the room by selecting *Enabled*.

• **Media**—Select if Media is visible in the Wake and Sleep sections on a T3 touch screen or the Control4 app by selecting *Visible*. Select the default Media Source by clicking on *Source* (example: Pandora) and select the *Station* or select *Use TV as the only media source* and click on *Channel* to select a TV channel. Enable media in the current Wake and Sleep scenes for the room by selecting *Enabled*.

• **Curtains**—Select if curtains are visible in the Wake and Sleep sections on a T3 touch screen or the Control4 app by selecting *Visible*. Select which curtains to control with the Wake and Sleep scenes by clicking on *Curtain Selection* or click *All*. Enable curtains in the current Wake and Sleep scenes for the room by selecting *Enabled*.

• **Active Days**—Select the default days for the Wake scene to be active.

11. Click *Save Changes* to sync the changes to the Wake and Sleep scenes for the room:

---

Note: Users can schedule the wake times for the Wake scenes, enable or disable items from the Wake scenes, and choose from the lights or curtains in the Wake scene from their T3 touch screens or Control4 app. See the product documentation or the *Control4 System User Guide* for more information about how to schedule the wake time.

**Note:** Users can select the behavior of the Sleep scene (for example: decide whether to turn off media, turn off lights, and close blinds) in the Options menu in the Sleep scene from their T3 touch screens or Control4 app.
Programming

Use the Composer HE Programming view to program the Control4 system. This section assumes that you have a general understanding about how to use Composer HE to add and identify devices, and that you are now familiar with the Composer HE interface. If not, read “Basics” sections or refer to Composer HE Getting Started.

Use this chapter to learn:

- Programming basics
- Programming with commands
- Programming with conditionals
- Programming using rooms
- Programming using variables
- Programming with agents
- And more
Programming basics

Use the Programming view to program events and other actions that affect Control4 system devices.

Tip: A useful tool for helping you keep track of your programming scripts is called Programming Detective which is part of the Detective Suite, in Tools > Detective Suite. See the Composer HE Getting Started guide for details.

To get to the Programming view:

1. Start Composer HE and connect to a Director.
2. Click Programming. In the Programming view, you can perform basic programming tasks.

Event-driven programming

Programming is based on events. When an event is triggered, other actions can take place.

Example: If you program to lower the projector screen in the Theater by pressing a keypad button. You can program the receiver, DVD player, and projector to power up and start playing a DVD also. Programming the system is where the true value of Composer HE becomes a reality.

To program the system using Composer HE, you drag and drop Events and Actions that you create for corresponding devices to a programming Script pane. The sections below show these panes.

Events (Programming pane)

Select an event (left side of the window):
Actions (Actions pane)
Select the action(s) (right side of the window):
Script (Script pane)
After you select the Event, Drag the Actions commands to the Script pane (middle pane):

The next table describes events, actions, and the script.
<table>
<thead>
<tr>
<th>Programming Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Events</td>
<td>All programming begins with events. An event is a “when” statement. An event is the trigger report that something happened that results in an automation. Events happen instantaneously. On a keypad, pushing a button is one event. Actions all occur under Events. Examples of events include:</td>
</tr>
<tr>
<td></td>
<td>• When the door opens</td>
</tr>
<tr>
<td></td>
<td>• When it is 7:00 AM</td>
</tr>
<tr>
<td></td>
<td>• When it is sunrise</td>
</tr>
<tr>
<td>Actions</td>
<td>After the event identifies to the system that something occurred, it sends actions. The following are the methods that are used by the system to define actions:</td>
</tr>
<tr>
<td></td>
<td>• Commands. The Commands tab displays all available commands for a selected item in the Action Device Tree. A command is a “do” statement. Commands are actions the Director tells the device to do. Examples of commands include:</td>
</tr>
<tr>
<td></td>
<td>Light: on, off</td>
</tr>
<tr>
<td></td>
<td>Blu-ray player: play, stop, pause</td>
</tr>
<tr>
<td></td>
<td>Security device: arm, disarm</td>
</tr>
<tr>
<td></td>
<td>TV device: Power on/off, change channel</td>
</tr>
<tr>
<td></td>
<td>• Conditionals. The Conditionals tab displays all available conditionals for a selected item in the Action Device tree. A conditional is an “if” statement. An “if” statement asks a true/false question to the device. Examples of conditionals include:</td>
</tr>
<tr>
<td></td>
<td>If door is open</td>
</tr>
<tr>
<td></td>
<td>If after 5 PM</td>
</tr>
<tr>
<td></td>
<td>If light is greater than 50 percent</td>
</tr>
</tbody>
</table>
• Loops. The Loops tab displays all available loops for a selected item in the Action Device tree. A loop is another type of conditional. A conditional loop is a “while” statement. It is something that is ongoing. Examples of conditional loops:

While the sprinklers are on
While the motion detector detects movement
While a doorbell switch is being pressed

Warning: Using loops (WHILE statements) can potentially overwhelm the controller’s CPU. Use loops sparingly.

• Delays. A delay stalls a program from running to ensure actions that occur at the right time.

Script
The linking of events and actions is defined in the script.

Tip: To configure or program devices, you can use properties, agents and variables also. These are considered advanced configuration and programming tasks. See “Using and Programming with Agents” or “Examples: programming with variables.”

Programming elements

Basic programming consists of two parts:
1. Identify a device’s events to trigger actions.
2. Define a device’s actions to trigger when an event fires.

The following steps introduce the basic programming flow and script creation:

1. Select the device—Bathroom Fan—in the Device Events pane and select the event—When the Bathroom Fan is turned on. Notice that it appears in the Script pane.
2. Define the device's actions--Under Timer, select the **Bathroom Fan** timer and select the **Start Timer** action--in the **Actions** pane.

3. Drag the actions to the script (Script pane).

4. To test the programming command, in the **Script** pane, click **Execute**.

---

**Note**: Programming can make use of agents also, where you can include pre-programmed system functionality, such as scheduling, delays, or setting up Lighting Scenes. Example: To program around sunrise and sunset, use the Scheduler agent.

See "Using and Programming with Agents" for more information about using agents in programming.

See the next section or Composer HE Getting Started for example programs you can create.
Programming with commands

A Command for a Control4 system is a “do” statement. Commands are actions that tell a device what to do.

Example: The example in this section shows you how to program a keypad button to turn on the sprinkler system. This example assumes the keypad and sprinkler system are already set up.

To program a keypad button to toggle sprinklers on and off:

1. Start Composer HE and connect to a Director.
2. Click Programming.
3. In the Device Events pane project tree, select the keypad.
4. In the keypad Events pane, select the button that you want to program—Zone 1. This automatically identifies the Press event for programming the button on the keypad. The event appears at the top of the Script pane.

5. In the Actions pane, select the device—Sprinkler Zone 1.
6. In the device’s Actions tab, select Toggle the Sprinkler Zone 1. The command you chose is displayed in the Sprinkler System Actions pane with a green arrow.

Note: The title of this pane varies depending on the device you select.
7. Click the **green arrow**, and drag it to the **Script** pane (center pane).

8. To test, click **Execute** in the **Script** pane to turn on the sprinklers.

9. Click **Execute** again to turn off the sprinklers.

   **Results:** The top button of the keypad now toggles the sprinklers on and off.
Programming with conditionals

A conditional is an 'If' statement in Composer HE that asks a true or false question to the device.

- A 'Break' command used in an 'If' statement should jump to the first statement after the 'If'. See "Programming with Delay, Stop and Break Commands" for details. Note: A 'Break' command in an 'If' statement won't behave as a 'Stop' command, but will move to the next level in the script.
- A break not in a 'While' or 'If' statement should behave like a 'Stop' command (jumps to the first statement after the function).

Example: The example in this section shows how to use conditionals in programming. If a light is off when the doorbell is pressed, the light is programmed to turn on. Conditionals also use When statements (events). When the doorbell is pressed, if the light is off, program the light to turn on.

To program a conditional that turns on the light when the doorbell is pressed and the light is off:

1. Make sure that the doorbell and light switch are configured in the project.
2. Click Programming.
3. In the Device Events pane project tree, select the Doorbell.
4. Select the When the Doorbell is pressed event. The event appears at the top of the Script pane.

5. In the Device Actions pane, select the Front Door Light. Notice that the light switch actions that can be programmed for this device appear in the Light Switch Actions pane below the Device Actions project tree.
6. Click the Conditionals tab, and select Is Off. Composer HE displays the conditional you chose in the Front Door Light Actions pane: ? If <room> -> Front Door Light is off.
7. Drag the **blue question mark** icon to the *Script* pane.

![Diagram of the Script pane with a blue question mark icon being dragged to the Script pane]

8. Click the **Commands** tab, and select **On**.

9. Drag the **green arrow** to the **blue question mark** in the *Script* pane to make it a child under the "If" statement (nest the command under the "If" statement).

   **Tip:** If you drag the action to the text, or you drag the action under the text to the open space, it places the action as an equal above the conditional. If you drag the action to the question mark, it becomes a subset of the conditional. Notice the direction of the arrow to place the action as a peer or a subset under the statement.

![Diagram of the Script pane with an arrow pointing to a blue question mark, indicating a subset under the "If" statement]

10. Click **Execute**. With the Front Door Light off, press the doorbell; the light should come on.
Programming with Delay, Stop, Break, Or, And, and Else commands

When programming in Composer, you have the following Programming Controls available to create advanced programming:

- **Delay**—Lets you delay an action from taking place.
- **Stop**—Lets you stop the programming script.
- **Break**—Lets you break out of a 'While' or loop or 'If' statement when a specified condition is met and returns to the programming outside of the loop.
- **Or**—Lets you group conditionals together with an 'or' logical grouping. If any of the conditionals is true, the programming continues.
- **And**—Lets you group conditionals together with an 'and' logical grouping. If all of the conditionals are true, the programming continues.
- **Else**—Lets you program an alternate set of programming for a conditional. If the conditional succeeds, the programming continues under the 'if' statement. If the conditional fails, the programming continues under the 'else' statement.

**Delay command**

To use the Delay command during programming, see this example using a Motorized Screen and a Blu-ray player:

1. Start Composer HE and connect to a Director.
2. Click **Programming**.
3. Select the **Motorized Screen** in the project tree.
4. Select the event **When the Motorized Screen is put down**. Notice the string that appears in the **Script** pane.

5. To use the Delay command, in the **Programming Controls** section in the top of the **Script** pane, enter 5 next to **Delay**.
6. Drag the **green arrow** Delay command to the *Script* pane.

9. In the *Device Actions* pane, find and select the **blu-ray player**.

10. Click the **Commands** tab, and click **Power > On**.

11. Drag the **green arrow** 'Turn on the <room>'s <blu-ray player>' to the *Script* pane.

**Stop command**

This example uses a Stop command to not close the garage door if the garage light is on. If the light is off, the garage door closes.
To use the Stop command during programming, see this example using a keypad, a garage door, and a dimmer:

1. In the keypad Events pane, select the **Garage Door button** and select the **Pressed** event for the Garage keypad button. ‘When <room>- > <keypad name> Garage button is pushed’ appears at the top of the Script pane.

2. In the **Garage Light Actions** pane, click the **Conditionals** tab, and then click **Is On**.

3. Click the **blue question mark** next to ‘If the <room>- > Garage Light is on,’ and drag it to the Script pane.

4. In **Programming Controls**, and click the **Stop** command and drag it into the Script pane.

5. Drag the **green arrow** ‘Stop’ over the **blue question mark** in the Script pane to nest it below "If <room>- > Garage Light is on".

6. In the **Device Actions** pane, select the **Garage Door**.

7. Click the **Commands** tab, and select **Close the <room>- > Garage Door**.
8. Drag the green arrow ‘Close the <room>->Garage Door’ below the Stop command.

Break command

Here are some rules about using the Break command (see example script below).

- A break in a 'While' loop jumps to the first statement after the While statement.
- A break in an 'If' statement (nested in a 'While' statement) jumps to the first statement after the 'If.'
- A break not in a 'While' or an 'If' statement should behave like a Stop command (jumps to the first statement after the function).

Note the 'Break' command in the statement below. If the 'While' statement above the 'Break' command (in an 'If' statement) is met (True), then the program continues to the next 'While' statement. Otherwise it skips to the next command (green arrow) statements at the bottom of the script.

See “Programming with a While statement” or “Programming with conditionals” for details.
Else command

You can use an Else command to create alternate programming to an If conditional. This example will program a button to open the blinds if it’s day time and close the blinds if it’s night time.

**To program the blinds with an Else command:**

1. Start Composer HE and connect to a Director.
2. Click **Programming**.
3. In the *Device Events* pane project tree, select the *keypad*.
4. In the *keypad Events* pane, select the button that you want to program—*Blinds* This automatically identifies the Press event for programming the button on the keypad. The event appears at the top of the *Script* pane.

5. In *Device Actions*, select Scheduler and click on *Conditionals*.
6. Click Time and click **Day time**.
7. Drag the blue question 'If time is day time' conditional to the *Script* pane.
8. Select the Master Blinds in *Device Actions*, click on Open, and drag the 'Set the blind target level on <room>->Master Blinds to Open' command to nest it below the conditional.
9. In Programming Controls, click on Else and drag the Else icon on top of the conditional in the Script pane. The mouse icon changes to indicate you can place the Else command below the If command (and link them logically).

10. Select the **Master Blinds** in *Device Actions*, click on **Close**, and drag the 'Set the blind target level on <room>->Master Blinds to Close' command to nest it below the Else conditional.

See "[Programming with a While statement](#)" or "[Programming with conditionals](#)" for details.

**And command**

You can use an And command to create additional conditionals to an If conditional. Both the If conditional and the other conditional(s) must be true or programming won’t continue.
Example: The example in this section shows how to use conditionals and an And command in programming. If a light is off when the doorbell is pressed and it's night time, the light is programmed to turn on.

To program a conditional with an And command:

1. Follow the example in "Programming with conditionals". These next steps start after that example.

<continued from the steps in "Programming with conditionals">

11. To add an And command, in Programming Controls, click And and drag it on top of the conditional in the Script window. The Expression Builder opens to help you build your complex conditional statement.

12. In the Device Actions pane project tree, select the Scheduler.

13. Click Time and Night time.

14. Drag the conditional 'If time is night time' to the Script pane below the AND symbol.

15. Click Finish to close the Expression Builder. The complex condition now reads 'If <room>->Front Door Light is off AND If time is night time'.
When the doorbell is pressed, the Front Door Light will turn on *if the light is off AND if it is night time.*

**Or command**

You can use an Or command to allow multiple conditionals to activate programming. If any conditional grouped with an Or command is true, the programming continues.

---

**Example:** The example in this section shows how to use conditionals and an Or command in programming. If a light is off when the doorbell is pressed and it's night time, the light is programmed to turn on.

**To program a conditional with an Or command:**

1. Follow the example in "Programming with conditionals". These next steps start after that example.

   *continued from the steps in "Programming with conditionals"*

11. To add an And command, in *Programming Controls*, click **Or** and drag it on top of the conditional in the *Script* window. The *Expression Builder* opens to help you build your complex conditional statement.

---

12. In the *Device Actions* pane project tree, select the **Scheduler**.

13. Click **Time** and **Night time**.
14. Drag the conditional 'if time is night time' to the Script pane below the OR symbol.

15. Click Finish to close the Expression Builder. The complex condition now reads 'if <room>->Front Door Light is off OR if time is night time'.

When the doorbell is pressed, the Front Door Light will turn on if the light is off OR if it is night time.

Programming with a While statement

A ‘While’ statement runs continuously in a loop until the evaluation is shown to be False (Boolean value). ‘While’ statements can be repeating ‘if’ statements also.
Caution: When programming with WHILE statements, the script **must** incorporate delays, or the script will run so fast that it will consume all available CPU resources and decrease system performance.

This example shows how to program a system to keep the air conditioning off while a window is open.

**To program a While statement, follow this example:**

1. Make sure the thermostat and window contact sensor are configured in Composer.
2. Click **Programming**.
3. In the project tree, select **Kitchen Window** Contact Sensor to trigger an event.
4. Select the **When the Kitchen Window opens** event. The event appears at the top of the **Script** pane.

5. In the Device Actions pane, select **Kitchen Window** Contact Sensor and click on **Loops**.
6. Select the **the Kitchen Window is open** loop.
7. Click the loop icon next to ‘**While the <room>->Kitchen Window is open**’ and drag it into the **Script** pane.
8. In **Programming Controls**, enter **5 seconds** next to **Delay** and drag the Delay green arrow below the while loop in the **Script** pane to nest the delay below the while statement.
9. In Device Actions, select the **thermostat** and click on **Commands**.
10. Select **Off** in the **Set HVAC Mode** to selection.
11. Click on the green arrow next to ‘**Set the system mode on <room>->Control4 Thermostat to Off**’ and drag
the green arrow below the while statement to nest it below the delay.
Programming using digital audio and rooms

You can program a Control4 system using the Digital Audio and Room objects in Composer HE. You can use digital audio events when a session starts or stops. A session is when a song or playlist begins and ends. A list of songs can be compiled into a playlist. You can compile the list by songwriter, album, song type, or any combination. Room events include turning the room off and on, when media sessions begin and end, etc.

Program a button to play media or a playlist

Use the Control4 Composer HE Programming view to program a button on a keypad to play an album or playlist.

Example: The example in this section uses a 6-Button Keypad for the Theater room. When you press Button 1, music or a movie plays in the Theater room.

Prerequisites

- Ensure that a 2, 3, or 6-Button Keypad is installed as directed in the Control4 2, 3, or 6 Button Keypad Installation Guide.
- Ensure that your project has an audio end point, such as Speaker Point, added and identified on the network.

To program a button on a 6-Button Keypad to play music:

1. Start Composer HE and connect to a Director.
2. Click Programming.
4. In the 6-Button Keypad Events pane, press Button 1, and select the Press radio button.
5. In the Device Actions pane, select the Theater room.
6. Click the Commands tab, and press the Select Media radio button.
7. In the new window, select the media type to play, such as Playlist.
8. Select the movie, playlist, etc.
9. Click OK.
10. In the Actions pane, drag the green arrow to the Script pane.
11. Click **Execute** in the Script pane.

---

**Program a button to turn up the volume**

Use the Programming view to let you use a keypad button to turn up the volume in a room.

**Example:** The example in this section uses a 6-Button Keypad for the Theater room. When you press Button 2 the volume increases in the Theater room.

**Prerequisites**

- Ensure that a 2, 3, or 6-Button Keypad is installed as directed in the Control4 2, 3, or 6 Button Keypad Installation Guide.
- Ensure that your project has an audio end point, such as a Speaker Point, added and identified on the network.

**To program a button to turn up the volume:**

1. Start Composer HE and connect to a Director.
2. Click **Programming**.
4. In the 6-Button Keypad Events pane, press **Button 2**, and then select the **Press** radio button.
5. In the Device Actions pane, select the **Receiver**.
6. Click the **Commands** tab. In Sound, select **Volume > Start > Up**.
7. Drag the **green arrow** in the Receiver Actions pane to the Script pane.
8. Click **Execute**.
Program a button to add a room to another room’s music session

Use the Programming view to use a keypad button to play music in additional rooms.

Example: The example in this section uses a 6-Button Keypad for the Theater room. When you press Button 3, music starts playing in the Bedroom as well as the Theater room.

Prerequisites

- Ensure that a 2, 3, or 6-Button Keypad is installed as directed in the Control4 2, 3, or 6 Button Keypad Installation Guide.
- Ensure that your project has an audio end point, such as Speaker Point, added and identified on the network.

To program a button to add another room’s music session:

1. Start Composer HE and connect to a Director.
2. Click Programming.
4. In the 6-Button Keypad Events pane, press Button 3, and then select the Press radio button.
5. In the Device Actions pane, select Digital Media.
6. Click the Commands tab.
7. Use the pull-down menu to select the Theater room as the Selected Room. Select the Add Rooms radio button.
8. Check the box next to Bedroom to indicate that this is the room that is going to join the music session.
9. Drag the green arrow in the Digital Audio Actions pane to the Script pane.
10. Click Execute.

Set the default for a room’s music volume

Use the Monitoring view to set the default music or media volume for a room.

Example: The example in this section uses the Theater room. When you set the default, the volume stays at a certain level for the Theater room until you change it. You can change the volume for every room that uses music or media.

Prerequisites

- Ensure that the controller is added and identified on the network.
- Ensure that your project has an audio end point, such as Speaker Point, added and identified on the network.
To set the default volume for a room:
1. Start Composer HE and connect to a Director.
2. Click Monitoring.
3. In the project tree, click a room.
4. In the Properties pane, click the Miscellaneous tab.
5. In the Miscellaneous tab, check the **Enable Default Volume** box. Adjust the Audio Volume and Video Volume as desired for the room. The default volumes are enabled immediately. Repeat these steps for each room in the Control4 system.
Examples: programming with variables

Use the Programming view to program the Control4 system using configuration, properties, variables, delays and agents.

Variables provide other programming options not available using commands, conditionals or loops.

There are three types of variables you can use:

- **Room Variables**—Provide you with additional programming options not available in the Room object programming. Use Room object programming as a preference to room variables whenever possible. See “Example: Using room variables.”
- **Custom Variables**—Let you define additional programming options using:
  - **Boolean**—Provides a True/False option. For example, the light is on or off. If the light is on, it is True; if the light is off, it is False.
  - **Device**—Provides a list of device options.
  - **Number**—Provides a value option. For example, the light level is 70 percent.
  - **String**—Provides the option to enter a string.

To program using a custom variable, in the Agent view select **Variable** and click **New** to set up a new variable.

Example: Use one keypad button to toggle between turning on the Theater Dimmer and the Theater Switch.

- **Container Variables**—Provides the ability to connect two or more devices together by using the device variables. A variable is a representation of information about the controlled devices, for example, a power state or current level of the device. It works much like a Media Scenes agent (see "Using and Programming with Agents" for details). Container variables are available in the Agent view by selecting Variables.

Note: Container variables are provided only for backward capability in Release 1.3 and later. Issues with various implementations have been found. The use of Container variables for future implementations is not recommended. Where possible, replace existing implementations with alternate programming.

The sections below provide examples you can follow when you use variables.

Example: Using room variables

Control4 room variables provide greater flexibility in programming, letting you program using events and actions at the room level.

Note: Most of the functions in Room Variables are available by selecting the Room object which is the recommended method for programming the room. Whenever possible, use the Room object rather than Room Variables.
To use room variables:

1. Start Composer HE and connect to a Director.
2. Click Programming. In this view listed under every room in the project tree is a Room Variables object.
3. Click to expand the Room Variables options. Room variables are available as events and actions.

![Room Variables screenshot](image)

The room variables are described in the following table:
<table>
<thead>
<tr>
<th>Events/Actions</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CURRENT_SELECTED_DEVICE</td>
<td>Lets you do programming when any device changes in the room.</td>
</tr>
<tr>
<td>CURRENT_MEDIA</td>
<td>Lets you do programming when any media changes in the room.</td>
</tr>
<tr>
<td>POWER_STATE</td>
<td>Lets you do programming when any device’s power state changes from True to False in the room (read only). A device in the room is required to detect the power state.</td>
</tr>
<tr>
<td>CURRENT_VOLUME</td>
<td>Lets you do programming when the volume of the currently selected audio path changes in the room (requires discrete volume). Use conditional programming.</td>
</tr>
<tr>
<td>HAS DISCRETE_VOLUME</td>
<td>Lets you do programming when any devices changes in the room (requires discrete volume). Use command programming.</td>
</tr>
<tr>
<td>HAS_DISCRETE_MUTE</td>
<td>Lets you do programming when Mute state is known (MUTE_ON or MUTE_OFF).</td>
</tr>
<tr>
<td>IS_MUTED</td>
<td>Lets you do programming when in Mute state (MUTE_ON).</td>
</tr>
<tr>
<td>IN_NAVIGATION</td>
<td>Lets you do programming when On-screen is available.</td>
</tr>
<tr>
<td>USE_DEFAULT_VOLUMES</td>
<td>Lets you do programming any time a selection changes to reset the default volume. For example, when changing from viewing a DVD to listening to music, the volume is reset to the default discrete set volume.</td>
</tr>
<tr>
<td>DEFAULT_AUDIO_VOLUME</td>
<td>Lets you program the default Audio volume.</td>
</tr>
</tbody>
</table>
### Events/Actions

<table>
<thead>
<tr>
<th>Description</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DEFAULT_VIDEO_VOLUME</td>
<td>Lets you program the default Video Audio volume.</td>
</tr>
<tr>
<td>VOLUME_IS_LINKED</td>
<td>Lets you set programming not to affect already linked volume.</td>
</tr>
<tr>
<td>MUTE_IS_LINKED</td>
<td>Lets you set programming not to affect already linked mute state.</td>
</tr>
<tr>
<td>ROOMOFF_IS_LINKED</td>
<td>Lets you set programming not to affect already linked room off state.</td>
</tr>
<tr>
<td>SELECTIONS_LINKED</td>
<td>Lets you set programming not to affect already linked selections.</td>
</tr>
<tr>
<td>ROOM_HIDDEN</td>
<td>Lets you set programming to hide rooms from appearing on the navigation device.</td>
</tr>
<tr>
<td>MEDIA_SCENE_ACTIVE</td>
<td>Lets you set programming to set a media scene as active.</td>
</tr>
</tbody>
</table>

### Variable handling

In programming, variables are easier to define than conditional loops.

Variable handling enhancements:

- **Preserve user-defined variables**—Preserves the user-defined variable values (for example, the current dimmer light level) across a normal system restart. It may not preserve them if the system shuts down abnormally.

- **Program a system startup event**—Initializes variables or performs other programming at system startup with a system startup event (in Programming, select the root of the project, and then select the event When the project is loaded).

- **Define one variable to equal another**—Defines one variable to equal another variable. This can be used to save and restore variable values.

  **Example:** The level of a light or the volume of music in a room.

  After this value is saved to the variable, you can restore the system variable to the value stored in the user variable. The system can then compare the two variables and determine if it needs to reset one of them.

- **Create the event "When a System reboots"**—Sends an email notification to the Control4 dealer that a customer’s system rebooted, helping the dealer monitor the system’s performance.
Example: Using custom Boolean variables in an agent

Use the Programming view to create custom variables in an agent using a Boolean value.

In this example, when someone is at the door:

- Program to activate the Media Scene ‘Someone is at the door,’ and turn on the porch light.
- Program to play a song in the Bedroom and the Theater.
- When the Motion Sensor stops sensing motion at the door, program to turn the music and porch light off.

Prerequisites

The following devices are added and identified in the project:

- Controller
- Porch Light Switch
- Bedroom music
- Theater music
- Motion Sensor

**To program using a custom Boolean variable in an agent:**

1. Start Composer HE and connect to a Director.
2. Click **Monitoring**.
3. Make sure the connections are correct.
   
   Note: Ensure that the contact sensor shows in the list view.

4. Ensure that the controller and Porch Light have a network address.

Create a new variable

5. Click **Agents**.
6. Select **Variable**. The Variables view appears.
7. Click **New**.
8. On the dialog that appears, do the following:
   1. Click **New Variable**.
   2. In the drop-down menu, select **Boolean**.
3. Name the Variable Power State and click OK. The default value is false.

Create a media scene ‘Someone is at the door’
9. Select Media Scenes, and click New.
10. Name the Media Scene Someone is at the door. Click OK.

Add the bedroom and theater room
11. Click Add Room, and add the Theater and the Bedroom (see above).
12. Set the volume in the Bedroom to 50, and the volume in the Theater to 75.

13. Click Programming.

14. In the project tree and the Device Events pane, click to expand Variables, and select Power State.

15. In the project tree and in the Device Actions pane, click to expand Variables, and select Power State.

   Add the conditionals and commands

16. Follow the previous programming steps to create a script with Conditionals.

17. Click the Conditionals tab.

18. In the Conditionals tab, click Is False, and drag the blue question mark to the Script pane.
19. Click the **Commands** tab.

20. In the Commands tab, click **Set to True**, and drag the green arrow on top of the blue question mark in the Script pane to make it the first subset item of the first conditional.

21. In the Device Actions pane, select **Light Switch**.

22. Click the **Commands** tab.

23. In the Commands tab, click **On**, and drag the green arrow on top of the blue question mark in the Script pane to make it the second subset item of the first conditional.

24. In the project tree and in the Device Actions pane, select **Media Scenes**.

25. Click the **Commands** tab.
26. Click **Activate** in the Commands tab, and drag the **green arrow** on top of the **blue question mark** in the Script pane to make it **third** subset item of the **first** conditional.

27. In the project tree and in the Device Actions pane under Variables, select **Power State**.

28. Click the **Conditionals** tab.

29. In the Conditionals tab, click **Is True**, and drag the **blue question mark** to the Script pane.

30. Click the **Commands** tab.

31. In the Commands tab, click **Set to False**, and drag the **green arrow** on top of the **blue question mark** in the Script pane to make it the **first** subset item of the **second** conditional.

32. In the project tree and in the Device Actions pane, select **Light Switch**.

33. Click the **Commands** tab.

34. In the Commands tab, click **Off**, and drag the **green arrow** on top of the **blue question mark** in the Script pane to make it the **second** subset item of the **second** conditional.

35. In the project tree and in the Device Actions pane, select **Media Scenes**.

36. In the Commands tab, click **Deactivate**, and drag the **green arrow** on top of the **blue question mark** in the Script pane to make it the **third** subset item of the **second** conditional.

37. In the project tree and in the Device Events pane, select **Media Scenes** and select the event **Someone is at the Door**.

38. In the project tree and in the Device Actions pane, select the **Bedroom** object. (Repeat the next four steps for the Theater.)

39. Click the **Commands** tab.

40. In the Commands tab, click **Select Media**.
41. In the dialogue that appears, select the album and song that you want to play when Someone is at the Door executes. In this example, Rhapsody’s ‘50s Hits’ is used. Click OK.

42. Drag the green arrow to the Script pane.

43. Repeat steps 37-41 for the Theater.

44. In the project tree and in the Device Events pane, select Motion Sensor under Front, and select the event When the Motion Sensor senses motion.

Add the Boolean Values

45. In the project tree and in the Device Actions pane, click to expand Variables, and select Power State.

46. In the Conditionals tab, click Is False, and drag the blue question mark to the Script pane (this is the third conditional).

47. In the Commands tab, click Set to True, and drag the green arrow on top of the blue question mark to make it the first subset of the third conditional.

48. In the project tree and in the Device Events pane, select the event When the Motion Sensor stops sensing motion.

49. In the project tree and in the Device Actions pane, click to expand Variables, and select Power State.

50. In the Conditionals tab, click Is True, and drag the blue question mark to the Script pane.

51. In the Commands tab, click Set to False, and drag the green arrow on top of the blue question mark to make it the second subset of the third conditional.

52. Click Execute.

Results: The porch light turns on and plays a song in the bedroom and theater whenever the motion sensor senses motion at the front door.
Example: Using a custom number variable in an agent

Use the Programming view to create custom variables in an agent using a numeric value.

In this example, program one keypad button to toggle between turning on the Theater Dimmer and the Theater Switch.

Prerequisites

The following devices are added and identified in the project:

- Controller
- Dimmer (Theater)
- Light Switch (Theater)
- 6-Button Keypad

To program using a custom variable agent number:

1. Start Composer HE and connect to a Director.
2. Click Monitoring. Make sure the project has the correct devices and rooms.

Add a new variable

3. Click Agents.
4. Select Variables. The Variable Agents view appears.
5. Click New.
6. On the dialog that appears, do the following:
   1. Select New Variable.
   2. Name the variable Keypad releases.
   3. Use the Variable Type pull-down and select Number.
4. Click **OK**.

7. In the Variables pane, select the variable **Keypad_releases**. The available variables for your devices appear in the right pane.

8. Enter the value as **0** (zero).

Create an event
9. Click **Programming**.

10. In the project tree and in the Device Events pane, select **6 Button Keypad**.

11. Click **Button 1** on the **6 Button Keypad**.

12. Select **Press** for the event. The event appears at the top of the Script pane.

Create the actions
13. In the Actions pane, scroll down to view the agents.

14. Click to expand **Variables**.

15. Select **Keypad_releases**.

16. In the Commands tab, select the following to add 1 to the present value:
   1. Select the radio button by the plus (+) sign.
   2. Ensure the plus sign is selected.
   3. Select **1** (one).

   The action appears in the Actions pane.

17. Drag the **green arrow** icon to the **Script** pane.

Create the conditionals
18. Click the **Conditionals** tab.

   1. Select the **is** radio button option.
   2. Select the equals (\(=\)) sign.
3. Select 1 (one).

19. Drag the **blue question mark** below the previous command in the **Script** pane. This places the conditional Action parallel to the previous Action command.

20. In the Actions pane, select **Theater Dimmer**.

21. In the Command tab, select **On**. The action command appears in the Actions pane.

22. Drag the **green arrow** to the **blue question mark** in the **Script** pane to make it a subset of this conditional item.

23. In the Actions pane, scroll down to Variables and select **Keypad_presses**.

24. Click the **Conditional** tab.
   1. Select the **Is** radio button option.
   2. Select equals (=) sign.
   3. Select 2 (two).

25. Drag the **blue question mark** to the blank space under the previous Action command. This places the conditional Action parallel to the previous Action conditional.

26. In the Actions pane, select **Light Switch**.

27. In the Command tab, select **On**. The action command appears in the Actions pane.

28. Drag the **green arrow** to the **blue question mark** in the **Script** pane to make it a subset of the conditional item.

29. In the Actions pane, scroll down to the agents.

30. In the Variable agent, select the **Keypad_presses** variable.

31. In the Commands tab, select the following:
   1. Select the **Set to Value** radio button.
   2. Set the value to 0 (zero). The Action command appears in the Actions pane.
33. Drag the green arrow icon to the blue question mark icon in the Script pane to make it a second subset of the conditional.

34. Click Execute.

Results: Press Button 1 on the 6-Button Keypad to toggle between turning on the Theater dimmer and the light switch.

Example: Using a custom string variable in an agent

Use the Programming view to create custom variables in an agent using a numeric value. The steps in this section are for more advanced users of Composer HE.

In this example, program Button 4 on a Keypad to toggle through four playlists.

Note: This procedure is relatively complicated to create. Review the steps first to understand how the conditionals work.

Prerequisites
The following items are added and identified in the project:
- Controller
- 6-Button Keypad
- 4 Playlists: Mom’s Favorites, Dad’s Favorites, Choral Music, and Kid’s Music

To program using a custom variable agent string:

1. Start Composer HE and connect to a Director.
2. Click Monitoring. Make sure the project has the correct devices and rooms.
3. Make sure the devices are online.

Note: In the Monitoring view, ensure that the controller and the 6-Button Keypad show online.

Add a new variable
1. Click Agents.
2. Select Variables. The Variables agent list appears.
3. Click New.
4. On the dialog that appears, do the following:
3. Select New Variable, and name the variable My Playlists.
4. In Variable Type, use the pull-down menu to select String, and click OK.

Set up a 'Mom's Favorites' playlist in the theater
1. Click Programming.
2. In Programming select the 6 Button Keypad in the Theater from the Device Events pane.
3. In 6-Button Keypad Events, click Button 4 on the Keypad.
4. In the Device Actions pane, scroll down and click to expand Variables.
5. Select My Playlists.
6. In the My Playlists Actions pane, click the Conditionals tab, and enter the name of a playlist; for example, Mom’s Favorites.
7. Drag the first blue question mark to the Script pane.

8. In Device Actions, select the Theater room object.
9. In Theater Actions, select Select Media.
10. In the window that pops up, select Playlists, Mom’s Favorites, and then click OK.
11. Drag the green arrow icon on top of the first blue question mark in the Script pane to make it the first subset of the first conditional.

13. In the Commands tab under My Playlists, enter the name of the next playlist that you’d like to play; for example, Dad’s Favorites.
14. Drag the green arrow on top of the first blue question mark to the Script pane to make it a second subset of the first conditional.

The next time the button on the keypad is pressed, the value of the variable will be Dad’s Favorites, and will then cue that playlist in the Theater.

15. In Device Actions, scroll up and select the 6 Button Keypad in the Theater.


17. Under Color Settings select LED On.

18. Click the square of color to select the color you want Button 4’s LED to be when Mom’s Favorites plays. Select the color in the menu that pops up (in this example: green), and click OK.
19. Drag the green arrow on top of the first blue question mark in the Script pane to make it a third subset of the first conditional.

20. In Device Actions, scroll down and select Programming Control.

21. In the Programming Control Actions, select the Stop radio button.

22. Drag the green arrow on top of the first blue question mark in the Script pane to make it a fourth subset of the first conditional.

Note: It is important to add a Stop command here so that when the conditional is fulfilled, the programming will not continue. Because of the way this programming is set up when it’s finished, without the stop, the button on the Keypad will always select the
last playlist in the script.

Set up a ‘Dad’s Favorites’ playlist
1. In Device Actions, select My Playlists again.
2. In the Conditionals tab, next to ‘Is’ enter Dad’s Favorites in the text box.
3. Drag the second blue question mark to the Script pane.
4. In Device Actions, select the Theater.
5. In Theater Actions, select Select Media.
6. In the window that pops up, select Playlists, Dad’s Favorites, and then click OK.
7. Drag the green arrow on top of the second blue question mark in the Script pane to make it the first subset of the second conditional.

Set up a ‘Kid’s Room’ playlist
1. In Device Actions, select My Playlists.
2. In the Commands tab under My Playlist Actions, enter the name of the next playlist that you’d like to play; for example, Kid’s Music.
3. Drag the green arrow on top of the second blue question mark in the Script pane to make it a second subset of the second conditional.
4. In Device Actions, select the 6 Button Keypad in the Theater.
5. In 6 Button Keypad Actions, click on Button 4. Click the square of color to select the color you want Button 4’s LED to be when Kid’s Music plays. Select the color in the menu that pops up (in this example: purple), and click OK.
6. Drag the green arrow on top of the second blue question mark in the Script pane to make it a third subset of the second conditional.
8. In the Programming Control Actions pane, select Stop.
9. Drag the green arrow on top of the second blue question mark to make it a fourth subset of the second conditional.

10. In Device Actions, select My Playlists again.

11. In the Conditions tab, enter Kid's Music.

12. Drag the blue question mark to the Script pane to make it the third conditional.

13. In Device Actions, select the Theater room object.


15. In the window that pops up, select Playlists, Kid's Music, and then click OK.

16. Drag the green arrow on top of the third blue question mark in the Script pane to make it the first subset of the third conditional.

**Set up a ‘Choral Music’ playlist**

1. In Device Actions, select My Playlists.

2. In the Commands tab under My Playlists, enter the name of the next playlist that you'd like to play; for example, Choral Music.

3. Drag the green arrow on top of the third blue question mark to make it a second subset item of the third conditional.

4. In Device Actions, select the 6 Button Keypad in the Theater.

5. In 6 Button Keypad Actions, click on Button 4. Click the square of color to select the color you want button 4's LED to be when Kid's Music plays. Select the color in the menu that pops up (in this example: red), and click OK.

6. Drag the green arrow on top of the third blue question mark in the Script pane to make it the third subset of the third conditional.


8. In the Programming Control Actions, select the Stop radio button.

9. Drag the green arrow on top of the third blue question mark in the Script pane to make it a fourth subset of the third conditional.

10. In Device Actions, select My Playlists again.

11. In the Conditions tab, enter Choral Music.

12. Drag the fourth blue question mark to the Script pane.

13. In Device Actions, select the Theater room object.

14. In Theater Actions, select the Select Media radio button.

15. In the window that pops up, select Playlists, Choral Music, and then click OK.

16. Drag the green arrow on top of the fourth blue question mark in the Script pane to make it the first subset of the fourth conditional.

17. In Device Actions, select My Playlists.

18. In the Commands tab under My Playlists, enter the name of the next playlist that you'd like to play; for example, Mom's Favorites.

19. Drag the green arrow on top of the fourth blue question mark in the Script pane to make it a second subset of the fourth conditional.

20. In Device Actions, select the 6 Button Keypad in the Theater.

22. Click the square of color to select the color you want Button 4’s LED to be when Choral Music plays. Select the color in the menu that pops up (in this example: yellow), and click OK.

23. Drag the green arrow on top of the fourth blue question mark to make it a third subset of the fourth conditional.


25. In the Programming Control Actions, select the Stop radio button.

26. Drag the green arrow on top of the fourth blue question mark to make it a fourth subset of the fourth conditional.

27. In Device Actions, select the Theater room.

28. In Theater Actions, select Media.

29. In the window that pops up, select Playlists, Mom’s Favorites, and then click OK.

   Note: You do this is because the first time the button on the Keypad is pushed, the string variable does not have a value, and nothing happens. This last command is created when none of the conditionals are fulfilled, something will play; each time the button is pushed thereafter, a conditional is fulfilled.

30. Drag the green arrow below the previous Stop command in the Script pane. It is not a subset of the previous conditionals, but a command on its own.


32. In the Commands tab under My Playlists, enter the name of the next playlist that you’d like to play; for example, Dad’s Favorites.

33. Drag the green arrow below the previous command in the Script pane.

34. In Device Actions, select the 6 Button Keypad in the Theater.

35. In 6 Button Keypad Actions, click on Button 4. Click the square of color to select the color you want Button 4’s LED to be when Mom’s Favorites plays. Select the color in the menu that pops up (in this example: green), and click OK.

36. Drag the green arrow below the previous command in the Script pane. You do not need a stop at this point, because the programming automatically stops at the end of the script.

   Results: Press Button 4 on a 6-Button Keypad repeatedly to toggle through four playlists.
Other programming tasks

Other special programming functions can be accessed by right-clicking on an item in the Script pane.

<table>
<thead>
<tr>
<th>Function</th>
<th>Keyboard Shortcuts</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move Up</td>
<td>Ctrl+U</td>
</tr>
<tr>
<td>Move Down</td>
<td>Ctrl+D</td>
</tr>
<tr>
<td>Disable Event</td>
<td>Ctrl+E</td>
</tr>
<tr>
<td>Disable Item</td>
<td>Ctrl+I</td>
</tr>
<tr>
<td>Insert Comment</td>
<td>Ctrl+M</td>
</tr>
<tr>
<td>Copy All</td>
<td>Ctrl+C</td>
</tr>
<tr>
<td>Copy Selected</td>
<td></td>
</tr>
<tr>
<td>Paste</td>
<td>Ctrl+V</td>
</tr>
<tr>
<td>Find and Replace</td>
<td>Ctrl+R</td>
</tr>
<tr>
<td>Delete</td>
<td>Del</td>
</tr>
<tr>
<td>Delete All</td>
<td></td>
</tr>
<tr>
<td>Change to Customer</td>
<td></td>
</tr>
</tbody>
</table>

- **Move Up/Down**—Lets you move a script item up or down in the script, changing the order that the commands execute.
- **Disable/Enable Event**—Lets you disable the event and the entire programming script without having to delete the script. If the event is disabled, the text is grayed out and the only menu item is Enable Event.
- **Disable/Enable Item**—Lets you disable a single item in the script. Other items execute normally. If the item is disabled, the line of text is grayed out and the line's icon has a red x on it.
- **Insert Comment**—Lets you insert a comment into the script. See also Using Programming Comments.
- **Copy All**—Lets you copy an entire script.
- **Copy Selected**—Lets you copy selected items in a script.
- **Paste**—Lets you paste copied items into the current script.
- **Find and Replace**—Lets you find and replace elements within the script item with similar items. See Using Find and Replace.
- **Delete**—Lets you delete the selected script items. You can also delete items by pressing the Delete key.
- **Delete All**—Lets you delete the entire script.
- **Change to Customer**—Lets you change programming items to be accessible or locked out from When >> Then programming by the customer. By default, programming entered with Composer cannot be modified by the customer in When >> Then. Select **Change to Customer** to allow the customer to modify the programming in When >> Then.
- **Change to Dealer**—If the customer has entered programming in When >> Then and you want to lock out that programming from being modified in When >> Then, select **Change to Dealer** to lock the programming to Composer only.

**Note:** Selecting **Change to Dealer** does not lock out programming from Composer HE
Using Programming Comments

The Comments programming feature lets you add comments inline with your programming to document your programming. This is useful when using advanced programming, using variables, and when multiple technicians may need to work on the project.

Example: You have a variable that is changed by a button press. You can add a comment in the code to know where the variable is being changed from.

To add a comment in programming:

1. Click Programming and select the event in the Device Events pane.
2. In Programming Controls in the Script pane, enter the comment in the field next to Comment.
3. Click on Comment and drag the comment below into the Script pane. Place it anywhere in the programming script. A comment does not affect the programming.

Using Find and Replace

The Find and Replace programming feature lets you find one device already programmed and replace it with another.

Example: You want a button on your Configurable Keypad to turn on all the outside dimmers in your Control4 system. Currently, the button is programmed to turn on all the lights in your garage. Use the Find and Replace programming option to replace the lights with outdoor lights in your programming.
To program using the Find and Replace feature:

1. Start Composer HE and connect to a Director.
2. Click Programming.
3. In the Script pane, right-click and select Find and Replace. A Find and Replace dialog appears.
4. Replace the programming device object with the one you want.
   
   Find: Family > Left Dimmer
   Replace with: Theater > Theater Dimmer
5. Click **Replace**. The statement in the Script pane changes to the replacement script.

6. Repeat for each line in the Script pane.

   Find: **Family > Middle Dimmer**
   Replace with: **Bedroom > Bedroom Dimmer**

   Find: **Family > Right Dimmer**
   Replace with: **Front > Front Dimmer**

When you complete this process, the script reflects that you have changed all the lights in your Control4 system to dimmers.

### Using Copy and Paste

The copy and paste programming feature lets you copy the programming you configure from one device and paste it to another device. By creating the same command, loop, or conditional for a device, you can copy it for use in another programming script.

Example: You want all of the lights in the Control4 system to turn on by pressing **Button 1** on the 6-button keypad. When you press **Button 4**, you want to turn all the lights on in the system except in the **Bedroom**. In this example, you can copy the first set of actions into the second set and not include the Master Bedroom.
To program the 6-button keypad:

1. Start Composer HE and connect to a Director.
2. Click Monitoring.
3. Ensure that you have the following devices added and connected to the Control4 system:
   - Controller
   - Bedroom Dimmer
   - 6-Button Keypad
4. Click Programming.
5. Select 6-Button Keypad in the project tree of the Device Events pane.
6. In 6-Button Keypad Events, push Button 1, and select the Press radio button.
7. In the Device Actions pane, scroll down and select Dimmer.
8. In the Dimmer Actions pane, click the Commands tab, and click the On radio button.
10. Repeat Steps 1 through 9 for all the lights in your system. This includes the Light Switch and Dimmer in the Theater and the Dimmer in the Bedroom.
11. Move to the Script pane, right-click, then select Copy from the options. This
automatically copies all arrow statements in the pane.

12. Click **Button 4** in the 6-Button Keypad Events pane, and then select the **Press** radio button.

13. Right-click in the Script pane, and select **Paste**. The programming of the lights shows up in the Script pane for Button 4.

You have completed Copy and Paste Programming. Now you can edit the Button 4 Script as needed.

Example: You can remove the Bedroom Dimmer from the Button 4 Script, so when you push Button 1 all the lights in the system come on; and when you push Button 4, all the lights come on except for the dimmer in the bedroom.

Tip: This feature is very useful when programming complex loops and conditionals.
Customizing Navigators

Use this chapter to learn how to:

- Set up screen savers
- Hide and view device availability
Overview

Use the Control4® system Navigator interface on your Navigator to make adjustments to the Navigator you’re using.

Tip: You or your customer can customize pages in the touch screens, Control4 apps, or on-screen Navigators also. See the Control4 System User Guide for information.

Setting up screen savers

Setting up the photo screen saver

Use the Agent and Media views to set up a photo Screen Saver agent to view photos from the touch screens, Control4 apps, or on-screen Navigators. In OS 2.1 and later, you can use a single photo to display on all of your Navigators. If you change the interval on one Navigator, it will change all of them.

Prerequisites

Have one of the following storage types available before you copy the photos. You will need to set up one or more of them later when you add your photos.

Note: In some cases, the Control4 system may take a few minutes to recognize the device.

- **Controller**—If the controller has no storage, add and connect a device that contains storage for your photos; for example a USB drive or Network File Share (see Step 6 in the next section).
- **USB Drive**—Ensure that the USB drive is attached to the controller. When you insert the USB drive, it will appear in the project tree in the same room as the controller.
- **Network File Share**—Ensure that the Network File Share object is added to the project tree and connected (see the steps to do this later in this procedure). Ensure that you have access to the Network File Share, that you have a valid Username, Password, and Workgroup, and that you can identify the network location (you will need to add the path).

To display photos as screen savers on the Navigators:

1. Start Composer Pro and connect to a Director.
2. Click **Agents**.
3. (First time only.) From the Agents view > Agents pane, click **Add** to add the agent to the project.
4. From the Available Agents dialog, select the **Screen Saver** agent, and click **OK**.

    Note: If Screen Saver already appears in the Agents pane, it has already been added. Go to the next step. If not, see “Example: Program Using the Screen Saver Agent.”
5. In the Agents pane, select **Screen Saver**.
6. From the storage location list, use the drop-down menu to select the location where you will save your photos for use on the Navigators (controller, CBM Flash Disk: USB drive, or Network File Storage, etc.).
Notes:

- If the storage option that you want does not appear in the list, disconnect from Director and reconnect.

- At any given time, only one storage location can be set as the photo Screen Saver source.

- **CBM Flash Disk** (USB drive)—If you inserted the USB drive in the controller earlier, the CBM Flash Disk option appears in the list.

- **Network File Storage**—If you select Network File Storage, specify where the Control4 system needs to go to copy the files. Click Monitoring and select the Network File Storage icon in the project tree (you will have to add it from the Items pane). In the Properties pane, type the **Username**, **Password**, and **Workgroup**, and then browse to the network location. Click **Connect**.

7. Click the **Media** view, and select **Screen Saver**.

8. Click **Configure** in the Screen Saver pane, set the location to copy the files to (for display in the Navigators), and click **OK**.

Note: If you didn’t select a storage location in Step 6, an error message appears. Click **OK**, and then click **Configure** to set the location.

9. In the Screen Saver pane, click **Add**. In the My Pictures dialog, browse to the photos you want to copy to the storage location, select them, and click **Open**. The files will be copied to the storage location you specified in Step 8, and a folder may be created for you using the Control4 name (**Example**: Control4 pictures).

Note: When media is added (copied) to the storage device, it is pre-scaled to the resolution for all of the Navigators. Control4 preserves the aspect ratio of the original image, and boxes the extra space with bars for any given screen size.
10. In Composer Pro, click **Tools > Refresh the Navigators** to display the copied photos.

11. To activate the Screen Saver in each Navigator (on-screen, touch screen, or Control4 app), do the following:
   1. Go to Info > Config > Screen Saver (on the system remote control) or More > Settings > Screen Saver.
   2. Enable the **Custom** option, and then select the **Photo Screen Saver** option along with any other screen saver option you want to include. For photos only, check the **Photo** option. See "**Setting up a custom screen saver**" to display the photos on the Navigator or see the **Control4 System User Guide**.

### Setting up a custom screen saver

Use the Control4 Navigator to create a custom screen saver to view on touch screens, Control4 apps, or on-screen Navigators.

---

**Note:** This task must be completed on a Navigator. Either the Installer or homeowner can set this up. The Custom Screen Saver option lets users mix and match available screen saver options, including the option to use stored photos.

**Prerequisites**

Before setting up a custom screen saver, photos must be available for viewing from the Navigator. See "**Setting up the photo screen saver.**"

---

**To set up a custom screen saver:**

1. From the main menu on an on-screen Navigator, Control4 app, or touch screen press **More > Settings > Screen Saver** or **Info > Config > Screen Saver** on a system remote control.
2. In Screen Saver, press the drop-down arrow, and press **Custom**.
3. In **Turn on**, press the drop-down arrow, and press an option to enable the screen saver.
4. Press **Settings**.
5. Press to select one or more of the following options:
   - Media
   - Time
   - Date
   - Temp
   - Photo
   - Shuffle
6. Press **Done**.
7. **(Optional)** Press **Preview** to test the settings.

To set up a custom screen saver in the touch screens, Control4 apps, or on-screen Navigators for OS 2.0 and later, see the **Control4 System User Guide** for details.
Programming the screen saver sleep mode

Use the Programming view to schedule a Screen Saver mode change, for example, a ‘Go To Bed’ mode during sleep hours.

1. In Programming, select Navigator actions.
2. Create a Scheduled Event (such as ‘Go To Bed’). See *Using and Programming with Agents* for details.
3. Add the following script:

   “Set the screen saver mode on the [graphical navigator device] to Blank.”
   “Turn the screen saver on after [time interval] on the [graphical navigator device].”

Changing the time on a Navigator screen saver

Use the Control4 Composer HE Monitoring view to change screen saver date, time or time zone.

To change the time on a Navigator screen saver:

1. Start Composer HE and connect to a Director.
2. Click Monitoring.
3. In Monitoring, click the Properties tab.
4. Use the Date & Time drop-down boxes to modify the time and date.

   **Date**—To change the Date (month, date, or year), click the drop-down arrow for a calendar to appear. Click the left or right arrows to select the month, and then select the day.

   **Time**—To change Time (hour, minute, second), click the up or down arrows to the appropriate time in hours, minutes, or seconds.
Tip: An easy way to change the hour, minute, or second is to highlight the hour, minute, or second number, and then type the new number over the old one.

**Time zone**—To change the Time Zone, at the Timezone box, click **Edit**. Select the time zone from the drop-down menu, and click **OK**.

**Hiding device availability**

Use the Monitoring view to hide a device from view in a Navigator. In OS 2.3.0 or later, you may find the Access agent useful for device availability. See “Using and Programming with Agents” for details.

Example: Set availability so that the touch screen in the Bedroom cannot control music in the Theater.

**Prerequisites**

Ensure that the following devices are added and identified to the network:

- Controller
- Digital audio
- Navigator

**To hide a device so others cannot see it:**

1. Start Composer HE and connect to a Director.
2. Click **Monitoring**.
3. In Monitoring and in the project tree, select **Bedroom**.
4. Go to the **Navigator** tab in the Properties tab.
5. Select **Music** in the Menu box, and then click **Modify**.
6. Select **Digital Audio** in the Theater, click **Hide**, and then click **OK**.

### Viewing device availability in navigators

Use the Monitoring view to change the order of devices to view. This task is useful if you have a lot of media devices, and some are used more frequently than others.

Example: Change the order of a Tuner to appear in a Navigator before the Receiver.

Tips: (1) In OS 2.2 and later, you can use **Shift+Click** or **Ctrl+Click** to add or remove devices. (2) In OS 2.3.0 or later, you may find the Access agent useful for device availability. See “Using and Programming with Agents” for details.

**Prerequisites**

Ensure that the following devices are added and identified to the network:

- Controller
- Digital audio
- Navigator

**To enable a device to be viewed in a specific order in a Navigator:**

1. Start Composer HE and connect to a Director.
2. Click **Monitoring**.
3. In Monitoring, select **Theater**.
4. Go to the **Navigator** tab in the Properties tab.
5. Select **Radio** under Menu, and then click **Modify**.
6. Click **Tuner**, and then click **Move Up**.
7. Click **OK**.
Troubleshooting

Use this chapter to learn how to:

- Follow general guidelines for troubleshooting
- Troubleshoot controllers
- Troubleshoot a Director connection
- Troubleshoot media
- Troubleshoot devices
- Troubleshoot the upgrade process
Guidelines for troubleshooting

This section outlines general troubleshooting guidelines to check first if you are having problems with a Control4® system.

The following table lists the main areas typically found to resolve some issues on the Control4 system.
### Guideline | Where to go
---|---
Check room connections | Composer Pro automatically sets room connections when you set up a system. These settings are default settings, and may not necessarily match your physical connection. Ensure that the room connections are set to match your specific system.

**Check Control/AV connections** | The Control and AV connections identify the physical connections to the system. When these are defined, the system is completely automated and programmable. However, if one of the connections is not correctly identified, it can cause the system not to run properly. Ensure that the control and AV connections match the physical configuration.

Check network connections | If a device is not using a control connection to communicate to the Control4 controller, it uses a network connection: a type of connection that uses a network address such as TCP/IP (Ethernet), Zigbee, Zigbee Pro and Wi-Fi.

1. Ensure that devices show online in the *Monitoring* view.
2. If devices are offline, contact your Control4 Dealer for assistance.

Ensure Navigators are connected to Director | From any of the Navigators, press **Info > Director** (for releases prior to 2.0) or **More > Settings > Network** (OS 2.0 or later) to ensure that you are connected to the Control4 controller’s network address.

For more information, see "[Customizing Navigators](#)."

Ensure music is added and scanned | In Composer HE, ensure that your music is available (added to the controller) and is scanned into the system.

1. Make sure the stored or broadcast media is added or
2. Check the Room Properties page to see if the media was added.
3. Ensure that Navigators were refreshed after scanning media.
4. If the controller reboots, re-scan the media.

For more information, see:

“Setting up media for television stations”
“Setting up media for radio stations”
“Using external storage devices”
“Configure an audio or AV switch”
“Creating a playlist”
“Editing media information”

Refresh Navigators

Whenever you update the system, scan music, or update devices or device information, from the File menu, select Refresh Navigators.
# Troubleshooting controllers

The following table lists troubleshooting problems on Control4 system controllers.

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible problems and solutions</th>
</tr>
</thead>
</table>
| The controller has N/A for IP address        | 1. The controller has no network connection. Plug in your Ethernet cable. After a few moments, the addresses should appear.  
2. The power cable is not plugged in. Plug in your power cable.  
3. No DHCP on the network. Ensure that DHCP is operational. |
| The controller has a blank front display     | 1. Either your cables are unplugged, or they are not connected. If both are connected, unplug them and connect the Ethernet cable before connecting the power cord.  
2. The controller is not connected to a cable/modem/switch/ using DHCP.  
3. Ensure that the Reset button is not jammed behind the plastic cover (older controllers only). |
| The controller doesn't come back up after a power outage | To receive a notification of the controller going down and coming back up, set up an Email Notification agent to alert you when the project is loaded and the controller comes back up. When you create the alert, place the alert on the project (Device Events top level). See "Using the Email Notification agent." |

## Rebooting the Control4 system

At one time or another you may have configured the Control4 system incorrectly, or the connection to the network is not behaving the way it should. In this case, you can reboot or reset the system. You don't have to do anything in Composer HE other than check that the device you reboot is on the network.

**To reboot a controller:**

1. Disconnect the power cord from the controller.  
2. Plug the power cord back into the controller.  
3. Verify that the controller comes back on the network in Composer HE.
Reseting the Control4 system

Refer to your controller's installation guide for reset and factory restore instructions.
Troubleshooting a Director connection

The following table lists troubleshooting problems connecting to a Director.

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible problems and solutions</th>
</tr>
</thead>
</table>
| **Cannot see the Network Address of Director in the Director’s dialog** | 1. Click **Refresh** several times to see if the network address appears.  
2. If not, select **Add** and enter the name and network address. |
## Troubleshooting media

The following table lists troubleshooting problems with Control4 system media.

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible problems and solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>DVDs not showing up in the disc changer</td>
<td>Ensure that you have a serial disc changer. Only bi-directionally-controlled serial disc changers can scan media.</td>
</tr>
</tbody>
</table>

If you have a serial disc changer, see the following:

1. Ensure that music is added and scanned

If music is not running, see the following:

1. Ensure that a room is appearing on the Navigator. If not, click the room and change the room to one that can play music.
2. Ensure that music is added and scanned. See:
3. Refresh the Navigators.
Troubleshooting device control

The following table lists some control problems on Control4 system devices.

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible problems and solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Device is not Controllable from a Navigator</td>
<td>If the device, such as a dimmer, is not controllable from the Device Control window (double-click the device from the project tree); no connection exists.</td>
</tr>
<tr>
<td></td>
<td>Contact your Control4 Dealer for assistance in connecting devices.</td>
</tr>
</tbody>
</table>
Troubleshooting dimmers, switches, and keypads

The following table lists troubleshooting problems with Control4 system dimmers, switches, and keypads.

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible problems and solutions</th>
</tr>
</thead>
</table>
| Dimmers, switches, or keypads are not behaving correctly | 1. **Reboot.** Try rebooting the device by tapping the top button 15 times. On the 6-Button Keypad, this is the top left button. This action reboots the device, but does not clear programming associated with the device.  
2. **Reset.**  
a. Tap the top button 5 times.  
b. Tap the bottom button 5 times.  
c. Tap the top button again 5 times. If you are using the 6-Button Keypad, this is the top left and bottom left button. This clears all your network connections. |

Diagnosing trouble spots

Use the System Diagnostics tool in Composer HE to view, monitor, and troubleshoot a Control4 system.

System Diagnostics tool

The Control4 system includes many devices running embedded operating systems communicating over a wired or wireless network. During installation, configuration, and troubleshooting, the ability to look at the overall status of the components becomes very useful.

The System Diagnostics tool lets you gather system information to help you determine if any issues encountered are configuration problems, performance issues, or potential defects.

System Diagnostics uses

Possible uses of the System Diagnostic tool include:

- Viewing controller performance information:
- CPU usage
- CPU usage history
- Memory usage
- Memory usage history
- Processes running
• Viewing controller networking information:
  • Network type
  • Connection status
  • MAC address
  • IP address
  • Subnet mask
  • Gateway
  • DHCP status
  • DNS server information
• View system information
  • Viewing system information:
    • Detailed lower-level information about the devices listed
  • Viewing logging information:
    • When troubleshooting a problem that is reproducible, use the System Diagnostics tool to capture logged information while reproducing the problem to email to Control4 Technical Support.
    • When troubleshooting a problem that is not reproducible, connect the controller, enable logging, and allow the logging to continue running for a specified period of time to capture the problem. The logs are then captured and emailed to Control4 Technical Support.

Use the Control4 Composer HE System Diagnostics tool to view, monitor, and troubleshoot a Control4 system. The diagnostics information is organized into four tabs:
  • Controller Performance
  • Controller Networking
  • System Info
  • Logging

To access the System Diagnostics tool:
1. Start Composer HE and connect to a Director.
2. On the menu bar, click Tools menu, then click System Diagnostics. The tool is available over a LAN connection using remote access.
3. Use the tool to diagnose problems on your own, or capture and send information to Control4 Technical Support.

Viewing controller performance information

Use the System Diagnostics tool (Tools menu > System Diagnostics) to view controller performance.
The Controller Performance tab contains information regarding CPU and memory utilization for the Primary Controller of the project. Asynchronous messages from the Director regarding its current state are also displayed.

**To view controller performance information, including CPU and memory usage:**

1. Start Composer HE and connect to a Director.
2. From the Tools menu, select **System Diagnostics**. The Controller Performance tab is viewable by default.
3. View information displayed on the Controller Performance tab:
   - **CPU Usage**—Shows a graphical form of current CPU usage and CPU usage history for the primary controller, which is the Control4 controller used to control the system if multiple controllers exist on a system.
   - **Memory Usage**—Shows in graphical form the current memory usage and memory history for the primary controller.
   - **CPU and Memory Usage by Component**—Shows percentages of CPU and memory use per component.

4. Refresh the screen or update the speed. To do this, from the View menu you can:
   - **Refresh Now**—Restart the real-time display of CPU and Memory usage.
   - **Update Speed**—Change the speed to High, Normal, Low, or Paused.
5. View the Directory messages by clicking the **History** button.

**Using the controller networking information**

Use the System Diagnostics tool (Tools menu > System Diagnostics) to use controller networking information.

View the information, including:
- Network type
- Connection status
To use controller networking information:

1. Start Composer HE and connect to a Director.

2. From the Tools menu, select **System Diagnostics**, and then click the **Controller Networking** tab.

3. Ensure that the network information shown is reflective of your network.

4. To test your Internet connection, click the **Test Internet Connection** button. The screen displays the current status of networking services, including the CD & DVD Lookup Service, Media Web Service, and Updates Web Service.

   This screen shows that the example services failed.
5. Click **Close** to exit the dialog box.

**Using system information**

Use the System Diagnostics tool (Tools menu > System Diagnostics) to use system information.

View System Info current configuration settings, state of the primary controller and any other Control4 device in the Control4 system's current project. The information displayed is a summary of several commands.

**To use system information:**

1. Start Composer HE and connect to a Director.
2. From the Tools menu, select **System Diagnostics**, and then the **System Info** tab.
3. Select a **device** or sub-category (expanding the list as needed) in the left pane to display the system configuration information in the right pane.

4. To save the displayed information to a file, click **Save to File** and specify the location and name for the file.

**Logging diagnostics information**

Use the System Diagnostics tool (Tools menu > System Diagnostics) to use the logging feature and log files.

View Logging to configure, start, stop, and schedule diagnostic logging of the Control4 system.

- **Capturing Information While Reproducing a Problem**—When troubleshooting a problem that is reproducible, use the System Diagnostics tool to capture logged information while reproducing the problem to email to Control4 Technical Support.

- **Enabling Logging for Debugging**—When troubleshooting a problem that is not reproducible, connect to the controller, enable logging, and allow the logging to continue running for a specified period of time to capture the problem. The logs are then captured and emailed to Control4 Technical Support.

- **Zigbee and I/O Communications**—These items are available for logging in System Diagnostics.

- **DirectorState.corrupt**—If for any reason Director is unable to load a project file, it is saved to DirectorState.corrupt prior to loading a clean project file (Tools > System Diagnostics > Logging).
To use system logging:

1. Start Composer HE and connect to a Director.
2. From the Tools menu, select **System Diagnostics**, and then click the **Logging** tab.

![System Diagnostics Window]

3. To enable logging, select the logging categories and click **Start Tail**
4. The results are displayed.

![System Diagnostics Window with logging enabled]

5. (Optional) To save the log, but continue logging the results, click **Clear Output**. The logging feature remains enabled, but a Save As dialog box lets you specify the location and name of the text version of the log.
6. (Optional) To save the log and disable the logging process, click **Stop Logging**. The logging feature is disabled, but a Save As dialog box lets you specify the location and name of the text version of the log.

7. To view the controller Log, click **Open Controller Log**.
Glossary

4

4Sight: An Internet service that provides a connection to the home automation system any time and from any place worldwide.

A


action: An activity that occurs when an event prompts it to do so.

agent: In Control4 programming, agents provide the ability to perform complex programming by using functional modules. There are various types of agents; for example, Announcements, Email Notifications, Scheduler, Lighting Scenes, Wakeup, etc.

Anywhere Access: Lets users access and control their Control4 systems remotely using a mobile device or tablet anywhere in the world.

AV: Audio Video

B

Boolean: The computer logic used to determine if a statement is ‘True’ or ‘False.’

button-link binding: The LED colors used based on the device; the Installer can set these colors independently from the device to which the colors are bound.

C

CD: (Compact Disc) - An optical disc that stores digital data. This format is compatible with Control4 products.

client: A software or hardware device that communicates to a server for feedback from the server via an application for the user.

Command: A ‘do’ statement; actions the Director communicates to a device.

Composer: The Control4 software used to design and define a Control4 home automation system.

Composer Pro: Composer is used to set up and configure Control4 devices to communicate with each other in a home automation system.

conditional: An ‘if’ statement that asks a true/false questions which are acted upon in Composer programming.

configuration worksheet: Used in Composer software training to design and configure a project in Composer.

connection: Binding or linking devices together in Composer so they can communicate with each other.

contact: Contacts are generally used to monitor the status of something (door, window, water sensor, etc.) and can be hooked up through a security panel or directly using a Control4 controller or Contact/Relay Extender. Contacts connected to a Control4 controller or contact/relay extender can be configured either as NC (normally closed) or NO (normally open).

Control4 App: A Control4 graphical Navigator that runs on mobile devices or a PC or tablet.

Control4 system: A home automation system designed and developed by Control4.

controller: The main device that makes home automation possible. There may be multiple controllers within a Control4 system. The controller that runs Director is referred to as the primary controller.

cover art: An illustration of the cover of a DVD or CD album that displays in the Graphical or on-screen Navigators when playing music or watching videos.
CSV: comma-separated value. Can be used when adding media to a Control4 system.

D

Detective Suite: A set of tools that perform diagnostics tests on the Control4 devices.
device: A component that requires a device driver; code that is used to allow the Control4 system to work with that device.
device driver: Every device in the Control4 system needs a corresponding device driver to control the device.
DHCP: DHCP (Dynamic Host Configuration Protocol) - A protocol used between a network client and a DHCP server (usually a router or access point) that dynamically assigns IP addresses from a pre-defined list to clients on a network.
Director: Each Control4 controller (such as a Home Controller HC-500) ships with pre-installed Director software (Linux based) embedded in the device. The Director communicates with Control4 products and third-party products to enable home automation and interaction of individual devices. Director runs the Control4 devices. Composer Pro is the software used to connect to and program a system Director that resides on a controller.
DriverWorks: The DriverWorks SDK is used to create two-way drivers for audio video (AV) and non-AV devices.
DVD: (Digital Versatile Disc) - A media format for video and data storage.

E

end point: The end point is the final point (device) on the defined path over which audio and/or video content is routed to a room. An example of this would be a TV or Receiver.
Ethernet: Uses Ethernet category 5 (CAT5 or CAT5e) wiring to transfer data. Ethernet uses a star network topology that allows multiple points to communicate to a single point. The Speaker Point® and Mini Touch Screens use Ethernet to communicate to the Control4 controller.
event: An action; used to trigger Composer programming when programming Control4 devices.

F

forward-phase dimming (also known as leading edge dimming): A type of phase-cut dimming in which the load is dimmed by cutting off the leading edge of each electrical cycle. This type of dimming must be used with magnetic transformers (magnetic low-voltage loads) and works well for many other load types including incandescent and cold cathode. It should not be used with electronic transformers (electronic low-voltage loads) unless the transformer specifications specifically state that Forward Phase dimming is allowed.
file format: A format used by applications to store/read files.
FLAC: Supported by Control4 for software release 1.8, this is a free, open source, lossless audio codec format that supports tagging, cover art and fast seeking. Audio is compressed with no loss in quality.
full duplex: The simultaneous transfer of data in both directions. For example, on a 5” or 7” In-Wall Touch Screen the caller can send out a call and the receiver on the other end of the call can answer via his or her 5” or 7” In-Wall Touch Screen and then respond.

G

gateway: (router)- Provides a means of communicating between two separate networks.
**home network:** A network installed in the customer’s home that provides an Ethernet or wireless connection so that Control4 devices can communicate with each other.

**home automation system:** The Control4 system: a line of home automation products that communicate with each other over Ethernet, Wi-Fi, or Zigbee for a total home automation experience.

**intercom:** A two-way audio and/or video communication among supported Control4 touch screens.

**IR:** A device controlled using a wireless remote control device. Commands are sent via pulses of infrared light to the device.

**keypad managed:** On a keypad, the LED state is controlled by the buttons on the keypad.

**keypad unmanaged:** On a keypad, the LED state of the buttons is controlled through programming rather than from the keypad buttons.

**LCD:** (Liquid Crystal Display) - A display used with some Control4 interfaces.

**LCD Navigator:** An LCD device used to control lighting, music, videos, etc., on an LCD screen.

**List Navigator:** A system remote control device uses a Navigator that lists the options.

**Live Connection:** A term used in Composer Pro to indicate an actual connection to the network.

**loop:** A type of conditional in programming; a ‘while’ statement; for example, “while the sprinklers are on...”

**Media Manager:** Media information is stored in the Media Manager database, which will permit users to view the media information from the Navigators.

**MP3:** A music format that makes streaming audio available.

**MP4:** An audio and video format. Can also store images and subtitles.

**Navigator:** A Control4 Navigator used with the Control4 system to control lights, music, videos, etc. Navigator is software that the customer interacts with using a universal remote control, on-screen Navigator, touch screen, or LCD Screen.

**on-screen device:** Allows you to select the controller (Media Controller or Home Theater Controller) in the room that controls the source for the on-screen display.

**playlist:** A list of songs compiled in a list. The list can be compiled by songwriter, album, song type, or any combination.

**Power Over Ethernet (POE):** Network cabling that provides Ethernet connectivity and device power over a single cable for Control4 devices.

**programming:** A machine-readable artificial language used to express computations that can be performed by a device.
**project tree:** A tree view in Composer where the project is layered by the larger branches (Home, Office, etc.) and then the lower branches (floor, rooms, etc.), and finally to the leaf level (drivers).

R

**ramp rate:** The rate that a dimmer ramps up its voltage.

**relay:** An electrical switch that opens and closes. A relay is controlled by another electrical circuit.

**remote access:** The ability to access a device from a remote location.

**Remote Director:** Connects you to the home network while working in Composer from a remote location.

**retrofit:** The ability to set up a home automation system in an existing structure or home. Compare this with new building construction.

**reverse-phase dimming (also known as) trailing edge dimming:** A type of phase-cut dimming in which the load is dimmed by cutting off the trailing edge of each electrical cycle. This type of dimming must be used with electronic transformers (electronic low-voltage loads), and works well for many other load types including incandescent; some types of dimmable fluorescent and compact fluorescent; and some LED power supplies. It should never be used with magnetic transformers (magnetic low-voltage loads).

**RJ-45 jack:** An eight-pin jack used to connect CAT5e network cables to devices through Ethernet signals.

**router:** See gateway. Functions similar to an AP but with additional functionality for controlling the network; for example, coordinating traffic between different networks.

S

**SDDP (Simple Device Discovery Protocol):** A protocol developed by Control4 to allow devices to be easily added to a control system. It has the ability to leverage other protocols and work on almost any physical layer. SDDP offers four primary functions:

- Enable devices to use Dynamic Host Configuration Protocol (DHCP) while still being able to identify them uniquely.
- Enable Director to discover devices residing within the Control4 system.
- Enable Director to identify devices residing within the Control4 system.
- Enable automatic installation of drivers for discovered devices.

**serial-controlled device:** Serial-controlled devices with an RS-232 interface and control protocol often have a higher level of controllability than IR-controlled devices. Examples of serial-controlled devices are projectors, multi-disc DVD changers, etc.

**switch:** An extension of a router that adds more Ethernet ports to support additional devices or clients on the local network.

**system event:** An action that causes another action; for example, if a projector turns on, it enables the other devices in the system that work with the projector.

**system remote:** System remote control

**system remote control:** A Control4 system remote control is a universal solution that replaces system remote control devices from other manufacturers, and includes programmable buttons. This system remote control can access on-screen (graphical) Navigators.

T

**touch screen:** A touch screen is a home automation system Navigator that controls the home’s lighting, music, videos, and other devices on the home automation system.

U
UI (user interface): The preferred term is Navigator. The Control4 interface used with Control4 devices to control home automation, such as touch screens, Control4 apps, or on-screen Navigators.

universal remote: Universal remote control. A third-party remote control that can be programmed to replace other remotes in the home so that only one remote is needed, replacing all others. Control4 system remote control devices are a type of universal remote control.

USB (Universal Serial Bus): A format used with USB sticks that plug in to a USB port on Control4 devices.

Virtual Connection: A term used in Composer Pro to indicate a connection outside the network.

Virtual Director: A connection to a virtual controller only (a PC is the Director host rather than the controller). Projects created or edited here are benign until the saved project is loaded onto a controller.

WAP: Wireless Access Protocol. The protocol used to enable wireless access of Control4 devices.

Wi-Fi: Uses bi-directional wireless technology to transfer data. Wi-Fi (wireless fidelity) devices “connect” to each other by transmitting and receiving signals on a specific frequency of the radio band using a wireless access point. This technology uses the star network topology. Wi-Fi uses high bandwidth 802.11.

wired network: Uses Ethernet Category 5 (CAT5) wiring to send and receive data between devices connected to a network.

wireless access point: A router extension with an antenna that communicates with Wi-Fi devices and clients in the home. A wireless hub that connects to the wired network, and distributes the wireless signal.

wireless switch: Uses the Zigbee. UL listed dimmer. Single or multi-gang. Has an air gap to cut power.

WLAN: Wireless local area network.

WMA (Windows Media Audio): Audio data compression technology developed at Microsoft; an audio file format that competes with MP3.

Z

Zigbee: A wireless network that uses bi-directional wireless mesh network technology to transfer messages from one device to another. Unlike a star network topology where devices can only send messages to each other by sending them first to a single central device (which then delivers the message to the recipient device), a mesh network topology allows the devices to forward messages from one device to another, thereby extending the effective range of the network. Uses low bandwidth 802.15.4. 250 devices are allowed per controller but Control4 recommends 125.

Zigbee Pro: The 1.1 version of Zigbee that provides improvements in standardization by: allowing more interoperability with other Control4 devices, support for home automation profiles, and improves the scalability of multiple Zigbee access points.

Zserver: A Zigbee server that contains software which runs on a Control4 HC-class controller.
Index

1

10-digit registration code 71

4

4Sight
   setup 71

A

AAC 37
Account Services, Tools menu 49
Action, programming, example 41
Actions pane
   programming 165
Actual playlist options 38
Advanced Lighting agent 122
Agent
   Access 81
   Advanced Lighting 85
   Announcements 123
   Custom Buttons 129
   E-Mail Notification 133
   Light Properties 135
   Macro 135
   Media Scenes 137, 144-145
   Scheduler 149
   Screen Saver 151
   Timer 152
   Variables 159
   Wakeup 159
Agents
   options 40
   pane 40
   program 122
view 18, 39
AM/FM/XM 37
And command 180
Announcement agent 122
Audio end point 32
  devices 32
Audio Video, Room Properties 77
Audio volume 32

B
Back up Composer 17
Back up, media information 54
Backup 44, 53
  project 51
Backup As 44, 54
Backup to Cloud 43
Basic tasks 50
Boolean variable 190
Break command 175, 178
Broadcast media types 37

C
Cable TV 37
CBM Flash Disk
  and Photo Screen Saver 219
CD 36-37
  add 101
  edit 118
CD information
  edit 100
Change localization options 77
Change project date, time 77
Change project name 77
Change project settings 77
Change ZIP Code 77
Clear Media List  38, 45
Clear Project  51
Cloud Management  43
Command tab  42
Commands
  programming  171
  using Delay, Stop, Break  175
Communication agent
  External Devices  129
  program with  126
Communication options, installation  12
Composer
  back up  17
  exit program  17
  same version as Director  66
  startup screen  16
  views  18
Composer HE  36
  interface  15
Composer HE, main view  76
Composer ME  36
Composer Pro
  activation  11
  basic tasks  74
  defined  8
Conditional
  program  173
Conditionals tab  42
Configuration information
  load  52
Connect to Director  44, 61
Contact connection  8
Container variables  190
Control4 apps  240
Control4 System  8
controller 8
digital audio 36
playlists 37
registration 10
Controller
troubleshoot 228
controller networking 235
Controller performance
view 234
CPU Usage 235
Create script
programming 169
Custom Buttons agent 122
Custom variables 190

D
Dealer information 35
Delay command 175
Delete playlist 45
Device Actions pane 42
Device connection status, Tools menu 45
Device Control window 23
Device controls 75
Device driver 8
Device Events pane 41
Device properties 78
Device Properties 33, 77
  example 79
Devices
  change order in Navigator 223
  hide 222
  install 74, 91
  troubleshoot 232
  view 223
DHCP 11
DHCP status 47
Digital audio 36
Dimmer
  troubleshoot 233
Director 8
  connect to 61
  Director on local network 63
  live connection 9
  load configuration 52
  on local network 16
  remote connection 9
  same version as Composer 66
  troubleshoot 230
  virtual connection 9
Directors dialog 16
DIRECTV 37
disc changer
  add media 98
  auto-scan media 99
  search media 99
Disc changer 36-37
Disconnect from Director option 44
Dish Network 37
DNS server information 47
Document scope 8
Driver
  Sort button 45
DVD 36
  add 101
  edit 120
DVD changer 36
DVD information
  edit 100
DVD player 37
E

E-mail Notification agent 122
Else command 179
Endpoints 31
Ethernet connection 12
Event, programming, example 41
Events pane
  programming 164
Exit Composer 51
Export media list 38, 45
Export playlist 38, 45
Expression Builder 181-182
External storage device
  using 112

F

File management options 43
File menu 42, 53
filter 22
FLAC 37
FM 37

G

Gateway 13, 47

H

Hard disk space 10
Hardware, install 12
Help menu 42
Help options 50
Home network requirements 10

I

Import DVD list from file 45
Loop 178
Loops tab 42

M

MAC address 47
Macro agent 123
Media
  Auto-scan 96
  Disc Changer 97
  edit 118
  radio station 105
  set up 92
  storage 95
  television station 107
  test connection 117
  troubleshoot 231
media database 94
Media database 36, 45
Media Lookup Service 94
media management 94
Media Manager 36
Media menu 42, 44
Media Monkey 36
Media pane 36
media player
  set up videos 104
Media Scenes agent 123
Media types 36
Media view 18, 36
Media, select from Navigators 36
Memory usage 235
Menu options 42
Monitor system status 75
Monitoring
  pane 19, 36
view 18
Monitoring view 75
Movies, can't play 31
MP3 37
MP4 37
MQA 97
my.control4.com 11

Navigator
    set up Photo Screen Saver 218
Navigator tab 32
Navigator, Room Properties 77
Network address 13
Network connection 9
Network requirements 10
New playlist 45
New Playlist 38
New Project icon 20
NTP 26
Number variable 190

Or command 182
Overview of 8

Password 77
Photo Screen Saver
    setup 218
Physical connection 9
Playlist
    create 115
Playlist, types 37
Power sources, and installation 12
Programming
   add a room to play music 188
   agents 122
   basics 164
   button to play music 186
   button to turn up volume 187
   commands 171
   Conditionals 173
   Copy and Paste 214
   digital audio 186
   elements of 169
   Find and Replace 212
   rooms 186
   set default music volume 188
Programming and Communication agent 126
Programming view 18, 40
Programming, actions and events 41
Project configuration information 43
Project configuration, back up 54
Project properties 25, 77-78
Project settings 27
project tree
   filter 22
   search 22
   sync 22
Project tree 9
Project, back up 53
Project, clear 51
Properties pane 19, 23, 75-76, 78
Push Settings from Project 27

Reboot Control4 system 228
Reboot controller 228
Refresh Navigators 44
Refresh option  44
Register Composer  13
Register system  10
Related documents  8
Relay connection  8
Remote Access  10
   add account  65
   requirements  64
   setup  63
Remote connection to Director  64
Remote Director  16
   connect to  65
Remove items from project tree  51
Rename playlist  45
RJ-45 jack  13
Room properties  78
Room Properties  77
Room Properties pane  31
Room variables  190
Router  11, 13

S

Same version, Composer and Director  66
Scan media
   from network  112
   new  94
Scan songs  92
Scheduler agent  123
Scheduler agent, example  40
Screen saver  37
Screen Saver
   change time  221
   program  221
   set up custom  220
Screen Saver agent  123
Script pane 42
  programming 166
search 22
Serial 8
SNMP Configuration agent 123
Songs 38
Songs, options 37
SSL 77
Start Composer Pro 16
Stop command 175-176
Storage devices, external 37
String variable 190
Switch 13
  troubleshoot 233
csync 22
System Compatibility Check 67
System design 9
System Design
  view, create project 9
system diagnostics 233
System Diagnostics
  Controller Networking tab 47
  Controller Performance History button 47
  Controller Performance tab 46
  Logging tab 49
  System Info tab 48
  Test Internet Connection button 47
System information 237
System Owner information 35
System registration 10
System security 27
System setup 9

Tag media files 45
TCP/IP 8, 10
Third-party devices, install 12
Timer agent 123
Timezone 26
Tools menu 42, 45
Troubleshooting
guidelines 225

U

UHF/VHF 37
USB drive 37
    and Photo Screen Saver 219
User interface 8

V

Variable
    handling 193
    room example 190
    room, variable options 191
    using Boolean 194
    using custom variable agent number 200
    using custom variable agent string 203
Variables
    use in programming 190
Variables agent 123
Video end point 32
Video resolution 10

W

Wakeup agent 123
WAP 11
While statement 178, 183
Windows 7 8
Windows Media Player 36
Windows Vista 8
Windows XP  9
Wireless Access Protocol  11
WMA  37